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Welcome Welcome

Welcome
This help provides in-depth information on how to use the SignalVu™ Vector Signal Analysis Software.
This online help is also available in a PDF format for printing.

NOTE. Most of the screen illustrations in this document are taken from the vector signal analysis software
version that runs on the RSA6100A Real-time Spectrum Analyzers. These instruments support additional
hardware-based functionality and buttons, such as Trig, that are not present in the SignalVu™ application.
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About Tektronix Spectrum Analyzers Product Description

Product Description
SignalVu™ vector signal analysis software helps you easily validate wideband designs and characterize
wideband spectral events. By combining the signal analysis engine of the RSA6100A real-time spectrum
analyzer with that of the industry’s widest bandwidth digital oscilloscopes, designers can now evaluate
complex signals up to 20 GHz without the need of an external down converter. You get the functionality of
a vector signal analyzer, a spectrum analyzer and the powerful trigger capabilities of a digital oscilloscope,
all in a single package. Whether your design validation needs include wideband radar, high data rate
satellite links or frequency hopping communications, SignalVu vector signal analysis software can speed
your time-to-insight by showing you time variant behavior of these wideband signals.

Key Features
Tightly integrated software and hardware control allows you to easily switch between SignalVu and
oscilloscope user interfaces to optimize triggers and other acquisition parameters. Key features of
SignalVu include:

Direct observation of microwave signals to 20 GHz without an external down converter

All signals up to the analog bandwidth of oscilloscope are captured in memory

Customizable oscilloscope acquisition parameters for effective use of capture memory

Four channel acquisitions help you correlate independent RF events

Apply custom math and filtering to acquisition channels

Extensive time-correlated, multi-domain displays connect problems in time, frequency, phase and
amplitude for quicker understanding of cause and effect when troubleshooting

Power measurements and signal statistics help you characterize components and systems: ACLR,
Multi-Carrier ACLR, Power vs. Time, CCDF, OBW/EBW, and Spur Search

Advanced Signal Analysis Suite (Opt. SVP) provides automated pulse measurements including rise
time, pulse width and pulse-to-pulse phase provide deep insight into pulse train behavior

General Purpose Digital Modulation Analysis (Opt. SVM) provides vector signal analyzer
functionality

Tektronix OpenChoice® enables easy transfer to a variety of analysis programs such as Excel and
Matlab

Product Software
Occasionally new versions of software for your instrument may become available at our Web site. Visit
www.tektronix.com/software for information.
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About Tektronix Spectrum Analyzers > Options Options

Options
To view a listing of the software options installed in your software, select Help > About Your Tektronix
Vector Signal Analysis Software.

Options can be added to your instrument. For the latest information on available option upgrades, see
the Tektronix Web site.
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About Tektronix Spectrum Analyzers > Documentation
and Support

Documentation

Documentation
In addition to the online help, the following documents are available:

SignalVu Reference (Tektronix part number 077-0224-XX). This document provides a brief overview
of the SignalVu software. It identifies elements of the SignalVu screen, elements of different displays
and includes a menu tree. The Reference Manual is provided as a printable PDF file.

SignalVu Programmer Manual (077-0223-XX). This document provides supplementary information
about the remote commands for the SignalVu software. The Programmer Manual is provided as a
printable PDF file. For detailed descriptions of the remote commands, see the RSA6100A Series
Real-Time Spectrum Analyzers Programmer Manual (077-0249-XX) and the DPO7000, DPO70000
and DSA70000 Series Digital Oscilloscopes Programmer Manual (077-0010-XX).

SignalVu Printable Help Document (PDF) (077-0225-XX). A PDF file version of the online help
that can easily be printed.

The SignalVu documentation PDFs are located on the Optional Applications Software for Windows-Based
Oscilloscopes DVD.

The most recent versions of the product documentation, in PDF format, can be downloaded from
www.tektronix.com/manuals. You can find the manuals by searching on the product name.
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Orientation Connecting Signals and Selecting the Analysis
Channel

Connecting Signals and Selecting the Analysis Channel
SignalVu analyzes signals acquired by the oscilloscope. For information on the oscilloscope input signal
capabilities and how to trigger on a signal, see the oscilloscope online help. Note that SignalVu does
not control triggering on the oscilloscope; you will need to use the oscilloscope triggering functions to
achieve a stable, triggered signal on the oscilloscope.

The SignalVu software analyzes one channel at a time, so you need to specify which oscilloscope input
channel will be analyzed.

To specify which oscilloscope channel is analyzed:

1. Select Settings > Acquire to display the Acquire control panel.

2. Select the channel you want to analyze using the Channel drop-down list.

3. Use the oscilloscope functions to achieve a stable, triggered signal.

Touch-Screen Actions
You can use the touch screen to change marker settings and how waveforms are displayed by using the
Touch-screen Actions menu.

To use the Touch-screen Actions menu, touch the display in a graph area and hold for one second, then
remove your finger. You can also use a mouse to display the Touch-screen Action menu by clicking
the right mouse button.
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Orientation Touch-Screen Actions

Icon Menu Description
Select Selects markers and adjusts their position.

Span Zoom Zooms the graph area about the selected point. Touch the graph
display at a point of interest and drag to increase or decrease the
span about the point of interest. Span Zoom adjusts the span
control and can affect the acquisition bandwidth.

CF Pan Adjusts the Center Frequency according to horizontal movement.

Zoom Adjusts horizontal and vertical scale of the graph. The first
direction with enough movement becomes the primary scale of
adjustment. Adjustment in the secondary direction does not occur
until a threshold of 30 pixels of movement is crossed.
Dragging to the left or down zooms out and displays a smaller
waveform (increases the scale value). Dragging to the right or up
zooms in and displays a larger waveform (decreases the scale
value).

Pan Adjusts horizontal and vertical position of the waveform. The first
direction with enough movement becomes the primary direction of
movement. Movement in the secondary direction does not occur
until a threshold of 30 pixels of movement is crossed.

- Reset Scale Returns the horizontal and vertical scale and position settings
to their default values.

- Marker to peak Moves the selected marker to the highest peak. If no marker is
turned on, this control automatically adds a marker.

- Next Peak Moves the selected marker to the next peak. Choices are Next
left, Next right, Next lower (absolute), and Next higher (absolute).

- Add marker Defines a new marker located at the horizontal center of the graph.
- Delete marker Removes the last added marker.
- All markers off Removes all markers.
xxx

Touch-Screen Menu for Spurious Display
The Touch-screen actions menu in the Spurious display has some minor changes compared to the standard
version used in other displays.
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Orientation Touch-Screen Actions

Icon Menu Description
- Single-range Changes the current multi-range display to a single range display.

The displayed range is the range in which you display the
touchscreen-actions menu. Selecting Single-range from the menu
is equivalent to selecting Single on the Settings > Parameters tab.

- Multi-range Changes the current single-range display to a multi-range display.
Selecting Multi-range from the menu is equivalent to selecting
Multi on the Settings > Parameters tab.

- Marker -> Sel Spur Moves the selected marker to the selected spur.
xxx

SignalVu Markers Menu
The SignalVu Markers menu appears when you right-click (or touch and hold) on a marker. The SignalVu
Markers menu enables you to assign a marker to a different trace, synchronize markers with oscilloscope,
cursors and pan the trace to place the marker at the measurement frequency.
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Orientation Elements of the Display

Icon Menu Description
- Pan to marker Adjusts horizontal position of the waveform to locate the selected

marker at the measurement frequency.
- Assign to trace Assigns the selected marker to Trace 1, Trace 2, Trace 3 or the

Math trace. A trace must be enabled to assign a marker to it.
- Sync scope C1 Synchronizes the position of Cursor 1 with the location of the

selected marker. Turns on cursors if necessary.
- Sync scope C2 Synchronizes the position of Cursor 2 with the location of the

selected marker. Turns on cursors if necessary.
xxx

Elements of the Display
The main areas of the application window are shown in the following figure.

Specific elements of the display are shown in the following figure.
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Orientation Elements of the Display
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Orientation Elements of the Display

Ref
number

Setting Description

1 Displays Opens the Select Displays dialog box so that you can select measurement
displays.

2 Markers Opens or closes the Marker toolbar at the bottom of the window.
3 Settings Opens the Settings control panel for the selected display. Each display has

its own control panel.
4 Acquire Opens the Acquire control panel so that you can define the acquisition settings.
5 Analysis Opens the Analysis control panel so that you can define the analysis settings

such as frequency, analysis time, and units.
6 Center Frequency Displays the Center Frequency. To change the value, click the text and enter the

frequency with a keyboard. For fine adjustments, you can use the mouse wheel.
7 Reference Level Displays the reference level. To change the value, click the text and enter a

number using a keyboard, or use a mouse scroll wheel.
8 Replay Runs a new measurement cycle on the existing acquisition data record using

any new settings.
9 Run Starts and stops data acquisitions. When the instrument is acquiring data, the

button label has green lettering. When stopped, the label has black lettering.
You can specify the run conditions in the Run menu. For example, if you
select Single Sequence in the Run menu, when you click the Run button,
the instrument will run a single measurement cycle and stop. If you select
Continuous, the instrument will run continuously until you stop the acquisitions.

10 Check mark indicator The check mark indicator in the upper, left-hand corner of the display indicates
the display for which the acquisition hardware is optimized.

xxx
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Operating Your Instrument Restoring Default Settings

Restoring Default Settings
To restore the instrument to its factory default settings:

Select File > Preset to return the analyzer to its default settings.

Preset resets all settings and clears all acquisition data. Settings and acquisition data that have not been
saved will be lost.

Application Presets
Menu Bar: File > Application Presets

SignalVu includes a set of configuration files that are tailored to specific applications. These configuration
files, referred to as Application Presets, open selected displays and load settings that are optimized to
address specific application requirements. You can add to the default application presets by creating your
own application presets. See Creating Application Presets (see page 14). You access the application
presets through the Application Presets menu item.

To load an application preset:

1. Select File > Application Presets. This opens the Applications Presets dialog window.

2. Select the application preset that suits your needs.

3. Click OK to recall the application preset.

Application Preset Description
Modulation Analysis The Modulation Analysis setup application preset provides you with the most common

displays used during modulation analysis.
Pulse Analysis The Pulse Analysis application preset provides you with the most common displays

used during pulse analysis, and makes changes to the default parameters to settings
better optimized for pulsed signal analysis. Option SVP is required to use the pulse
measurements applications preset.

Time-Frequency Analysis The Time-Frequency preset configures the instrument with settings suited to analyzing
signal behavior over time.

xxx

Modulation Analysis
The Modulation Analysis application preset opens the following displays:

Signal Quality: Shows a summary of modulation quality measurements (EVM, rho, Magnitude
Error, Phase Error, and others).

Constellation: Shows the I and Q information of the signal analyzed in an I vs. Q format.

Symbol Table: Shows the demodulated symbols of the signal.
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Operating Your Instrument Application Presets

To use the Modulation Analysis preset:

1. Select File > Application Presets >Modulation Analysis. Click OK.

2. Set the measurement frequency.

3. Set the reference level so that the peak of your signal is about 10 dB below the top of the spectrum
display.

4. Set the modulation parameters for your signal. This includes the Modulation Type, Symbol Rate,
Measurement Filter, Reference Filter and Filter Parameter. All of these settings are accessed by
pressing the Settings button.

For most modulated signals, the Modulation Analysis application preset should present a stable display of
modulation quality. Additional displays can be added by using the Displays button, and other settings can
be modified to better align with your signal requirements.

Pulse Analysis
The Pulse Analysis application preset opens the following displays:

Time Overview: Shows amplitude vs. time over the analysis period.

Pulse Trace: Shows the trace of the selected pulse and a readout of the selected measurement from
the pulse table.

Pulse Measurement Table: This shows a full report for the user-selected pulse measurements.

You can make a selected pulse and measurement appear in the Pulse Trace display by highlighting it in the
Pulse Measurement Table. Key pulse-related parameters that are set by the Pulse Analysis application
preset are:

Measurement Filter: No Filter.

Measurement Bandwidth: This is set to the maximum real-time bandwidth of the instrument. Note:
The label on the “Measurement Bandwidth” setting is just “Bandwidth”. Like the main instrument
Preset command and the other application presets, the Pulse Analysis application preset also sets
most other instrument controls to default values.

Analysis Period: This is set to 2 ms to ensure a good probability of catching several pulses for
typical signals.

To use the Pulse Analysis preset:

1. Select File > Application Presets > Pulse Analysis. Click OK.

2. Set the Center Frequency control to the carrier frequency of your pulsed signal.

3. Set the Reference Level to place the peak of the pulse signal approximately 0-10 dB down from
the top of the Time Overview display.
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Operating Your Instrument Application Presets

You may need to trigger on the signal to get a more stable display. This is set up with the oscilloscope’s
controls. A rising-edge trigger works well for many pulsed signals.

4. Set the Analysis Period to cover the number of pulses in your signal that you want to analyze. To do
this, click in the data entry field of the Time Overview window and set the analysis length as needed.

Time-Frequency Analysis
The Time-Frequency Analysis application preset opens the following displays:

Time Overview: Shows a time-domain view of the analysis time ‘window’.

Spectrogram: Shows a three-dimensional view of the signal where the X-axis represents frequency,
the Y-axis represents time, and color represents amplitude.

Frequency vs. Time: This display’s graph plots changes in frequency over time and allows you to
make marker measurements of settling times, frequency hops, and other frequency transients.

Spectrum: Shows a spectrum view of the signal. The only trace showing in the Spectrum graph
after selecting the Time-Frequency Analysis preset is the Spectrogram trace. This is the trace from
the Spectrogram display that is selected by the active marker. Stop acquisitions with the Run button
because its easier to work with stable results. In the Spectrogram display, move a marker up or down
to see the spectrum trace at various points in time.

The analysis period is set to 5 ms.

To use the Time-Frequency application preset:

1. Select File > Application Presets > Time-Frequency Analysis. Click OK.

2. When the preset’s displays and settings have all been recalled and acquisitions are running, adjust the
center frequency and span to capture the signal of interest.

3. Set the Reference Level to place the peak of the signal approximately 0-10 dB down from the top of
the Spectrum graph.

4. If the signal is transient in nature, you might need to set a trigger to capture it. You will need to use the
oscilloscope triggering functions to capture the signal.

When the signal has been captured, the spectrogram shows an overview of frequency and amplitude
changes over time. To see frequency transients in greater detail, use the Frequency vs. Time display.

The Time-Frequency Analysis preset sets the analysis period to 5 ms. The Spectrum Span is 40 MHz. The
RBW automatically selected for this Span is 300 kHz. For a 300 kHz RBW, the amount of data needed
for a single spectrum transform is 7.46 μs. A 5 ms Analysis Length yields 671 individual spectrum
transforms, each one forming one trace for the Spectrogram to display as horizontal colored lines. This
preset scales the Spectrogram time axis (vertical axis) to -2, which means that the Spectrogram has done
two levels of time compression, resulting in one visible line for each four transforms. This results in 167
lines in the Spectrogram for each acquisition, each covering 29.84 μs.
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Operating Your Instrument Setting Options

Creating Application Presets
You can add your own application presets to the list that appears in the Application Presets dialog box.
Create a Setup file and save a copy of it to C:\SignalVu Files\Application Presets. The name you give
the file will be shown in the Application Presets list along with the sets provided by Tektronix. For
instructions on how to save a Setup file, see Saving Data (see page 233).

If the Tektronix application presets files are accidentally deleted, you can restore them by reinstalling the
SignalVu software. The software installation process will not remove user files you have placed in the
Application Presets directory.

Setting Options
Menu Bar: Tools > Options

There are several settings you can change that are not related to measurement functions. The Option
settings control panel is used to change these settings.

Settings tab Description
Save and Export Use this tab to specify whether or not save files are named automatically and what

information is saved in acquisition data files.
GPIB Do not use this tab to set the GPIB address for the instrument. Use the Utilities > GPIB

Configuration control window in the TekScope application to set the instrument GPIB
address.

Security Selecting the Hide Sensitive readouts check box causes the instrument to replace
measurement readouts with a string of asterisks.

Colors Use this tab to select different color schemes for the measurement graphs.
xxx

14 SignalVu™ Vector Signal Analysis Software Printable Online Help



Operating Your Instrument Setting Options

Save and Export
The Save and Export tab allows you to specify whether or not files are saved with an automatically
generated name, and how much data is saved in an acquisition data file.

All Files — The Automatically increment filename/number function can automatically name saved
files by appending a number to a base file name. Use this tab to enable/disable automatic naming of
files. For example, if Automatically Increment Filename Number is disabled, when you select Save
from the File menu, you will have to enter a name for the file.

Acquisition data files — This setting specifies whether saved data files include the entire acquisition
record or only the data for the analysis length (a subset of the acquisition record).

TIQ acquisition data files — Specifies which data records to save. You can choose from the following:

Current acquisition: Saves the current acquisition.

Current frame: If Fast Frame is enabled, saves only the current frame. The current frame is the
one most recently analyzed.

Selected frames: If Fast Frame is enabled, saves the specified frames.

All in history: Saves all acquisition records in the history.

Colors
The Color scheme setting provides three color schemes for the measurement graphs. The color scheme
setting does not change the overall instrument application or Windows color scheme.

Thunderstorm — This scheme displays graphs in shades of blue. This provides a less vibrant color
scheme than the default setting.

Blizzard — This scheme displays graphs with a white background to save ink when printing.

Classic — The default setting. This scheme displays the graph area with a black background.
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Using the Measurement Displays Selecting Displays

Selecting Displays
Menu Bar: Setup > Displays

Application Toolbar: Displays

Use the Select Displays dialog to choose the displays that appear on the screen.

To select displays:

1. Press the Displays button or select Setup > Displays.

2. Select one of the choices under Folders. The folder chosen determines the choices available in
Available displays.

3. Double-click the desired display in the Available displays box or select the desired display and
click Add.

4. Click OK.

Interactions Between Displays
Different displays can require different settings, for example acquisition bandwidth, analysis length, or
resolution bandwidth, to achieve optimum results. The instrument automatically adjusts some settings
to optimize them for the selected display. The check mark indicator in the upper, left-hand corner of the
display indicates the display for which the acquisition hardware is optimized. Depending on instrument
settings, some displays might stop displaying results if they are not the selected display.
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Taking Measurements > Measurements Available Measurements

Available Measurements
The automatic measurements available include RF power measurements, analog modulation
measurements, digital modulation measurements, and pulse measurements.

Power Measurements

Measurement Description
Channel Power The total RF power in the selected channel (located in the ACPR display).
Adjacent Channel Power Ratio Measure of the signal power leaking from the main channel into adjacent channels.
Multi-Carrier Power Ratio The ratio of the signal power in the reference channel or group of channels to the power

in adjacent channels.
Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted

signal (located in the CCDF display).
CCDF The Complementary Cumulative Distribution Function (CCDF). CCDF shows how much

time a signal spends at or above a given power level relative to the average power of
a measured signal.

xxx
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Taking Measurements > Measurements Available Measurements

Modulation Measurements

Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK
Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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Taking Measurements > Measurements Available Measurements

Measurements for OQPSK and SOQPSK modulation types
Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Offset EVM Offset EVM is like EVM except for a difference in the time alignment of the I and Q
samples. For EVM, I and Q samples are collected at the same time, for every symbol
decision point (twice the symbol rate for offset modulations). For Offset EVM, the I and Q
symbol decision points are time-aligned before collecting the I and Q samples. In this
case, one I and one Q sample is collected for each symbol (half as many samples as the
same number of symbols for (non-offset) EVM.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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Taking Measurements > Measurements Available Measurements

Measurements for nFSK modulation types
Measurement Description
Peak FSK err Peak value of the frequency deviation error at the symbol point.
RMS FSK Err RMS value of the frequency deviation error at the symbol point.
Peak Mag Err The Peak magnitude difference between the measured signal and the reference signal

magnitude.
RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal

magnitude.
Freq Error The frequency difference between the measured carrier frequency of the signal and the

user-selected center frequency of the instrument.
Freq Deviation Frequency distance from the center frequency at the symbol point.
Symbol Rate Error This compares the user-entered symbol rate to the instrument calculated symbol rate of

the analyzed signal.
Symbol Rate When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and

the instrument calculates the error between the user entered value and the instrument
calculated value.

xxx

Measurements for C4FM modulation type
Measurement Description
RMS Error Magnitude RMS value of the frequency deviation error at the symbol point.
Carrier Frequency Error Frequency difference between averaged signal frequency and the center frequency.
Deviation Frequency distance from the center frequency at the symbol point.
Length Number of symbols in the analysis area.
xxx

Pulse Measurements

Measurement Description
Average ON Power The average power transmitted during pulse on.
Peak Power Maximum power during pulse on.
Average Transmitted Power The average power transmitted, including both the time the pulse is on and the time

it is off, and all transition times.
Pulse Width The time from the rising edge to the falling edge at the –3 dB / –6 dB level (50%) of the

user selected 100% level. Level is user selectable for Volts or Watts.
Rise Time The time required for a signal to rise from 10% to 90% (or 20% to 80%) of the user

selected 100% level.
Fall Time The time required for a signal to fall from 90% to 10% (or 80% to 20%) of the user

selected 100% level.
Repetition Interval The time from a pulse rising edge to the next pulse rising edge.
Repetition Rate The inverse of repetition interval.
Duty Factor (%) The ratio of the width to the pulse period, expressed as a percentage.
Duty Factor (Ratio) The ratio of the pulse width to the pulse period.
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Taking Measurements > Measurements Available Measurements

Measurement Description
Ripple Ripple is the peak-to-peak ripple on the pulse top. It does not include any preshoot,

overshoot, or undershoot. By default, the first 25% and the last 25% of the pulse top is
excluded from this measurement to eliminate distortions caused by these portions of
the pulse.
If the Amplitude units selected in the Amplitude panel (affects all amplitude measurements
for the analyzer) are linear, the Ripple results will be in %Volts. For log units, the Ripple
results will be in %Watts. The default for the general Units control is dBm, so the Ripple
results default is %Watts.
See also Ripple (see page 280).

Ripple dB The Ripple measurement expressed in dB.
Droop Droop is the power difference between the beginning and the end of the pulse On time. A

straight-line best fit is used to represent the top of the pulse. The result is a percentage
referenced to the Average ON Power.

Droop dB The Droop measurement expressed in dB.
Overshoot The amount by which the signal exceeds the 100% level on the pulse rising edge. Units

are %Watts or %Volts.
Overshoot dB The Overshoot measurement expressed in dB.
Pulse-Pulse Phase Difference The phase difference between the selected pulse and the first pulse in the analysis

window. The instantaneous phase is measured at a user-adjustable time following the
rising edge of each pulse.

Pulse-Pulse Freq Difference The difference between the frequency of the current pulse and frequency of the previous
pulse. The instantaneous frequency is measured at a user-adjustable time following the
rising edge of each pulse.

RMS Freq Error The RMS Frequency Error measurement is the RMS average of the Freq Error vs. Time
trace, computed over the Measurement Time.

Max Freq Error The maximum frequency error is the difference between the measured carrier frequency
of the signal and the user-selected center frequency of the analyzer.

RMS Phase Error The RMS Phase Error measurement is the RMS average of the Phase vs Time trace,
computed over the Measurement Time.

Max Phase Error The phase is measured at each point during the pulse’s ON time. The phase error for
each point is the difference between the measured phase value and the calculated ideal
phase value. After the phase error is calculated for all points in the acquisition record,
the largest error in the positive direction and the largest in the negative direction are
determined. Whichever of these two values has the greater absolute value is designated
the Max Phase Error.

Freq Deviation The Frequency Deviation measurement is the difference between the maximum and
minimum measured values of the signal frequency during the Measurement Time.

Phase Deviation The Phase Deviation is the difference between the maximum and minimum Phase values
measured during the ON time of a pulse.

Impulse Response Amplitude The difference in dB between the levels of the main lobe and highest side lobe.
Impulse Response Time The difference in time between the main lobe and highest side lobe.
Time This is the time in seconds relative to the time reference point in the first acquisition

record in the data set.
xxx
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General Signal Viewing Overview

Overview
The displays in the General Signal Viewing folder (Displays > Folders > General Signal Viewing) are:

Amplitude vs Time

Frequency vs Time

Phase vs Time

RF I & Q vs Time

Spectrogram

Spectrum

Time Overview

These displays provide extensive time-correlated multi-domain views that connect problems in time,
frequency, phase and amplitude for enabling you to more quickly understand cause and effect when
troubleshooting.
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General Signal Viewing > Time Overview Time Overview Display

Time Overview Display
The Time Overview display shows the entire acquisition record and shows you how the spectrum time and
analysis time fit within the acquisition record. This enables you to see how you can adjust the spectrum
time and analysis time to measure portions of the data.

You can specify the maximum number of trace points in the Time Overview display. You can set the
maximum number of trace points to 1K, 10K, 100K, 1M points or to Never decimate. If the Acquisition
Length includes more than 10,000 sample points (and Max trace points is not set to Never decimate), the
trace is decimated (using the +Peak method, similar to +Peak detection in a Spectrum display) to 10,000
points. This decimated trace is what is used for marker measurements.

The Time Overview window displays the Spectrum Length and Analysis Length. The Spectrum Length
is the period of time within the acquisition record over which the spectrum is calculated. The Analysis
Length is the period of time within the acquisition record over which all other measurements (such as
Amplitude vs. Time) are made. The Spectrum Length and Analysis Length can be locked together so
that the data used to produce the Spectrum display is also used for measurement displays; however, they
do not have to be tied together. They are by default specified separately and used to analyze different
parts of the acquisition record.

Elements of the Display
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General Signal Viewing > Time Overview Time Overview Display

Item Element Description
1 Analysis Time Control Click a button to select the value to be adjusted. In order, the buttons

represent Analysis Offset, Analysis Length, Spectrum Offset, and Spectrum
Length.

2 Position and Scale Adjusts the vertical scale and position.
3 Amplitude vs. Time graph The trace represents the entire acquisition record (at full horizontal scale).

The graph indicates the Analysis Length or Spectrum Length on the graph
with a darker background.

4 Autoscale button Resets the horizontal scale to display the entire acquisition record and the
vertical scale to show all trace points.

5 Horizontal Offset Adjusts the horizontal offset.
6 Results Timeline This fuchsia line indicates the portion of the record actually used for

calculating the selected result. For example: if a pulse measurement is
selected, it shows the period of the specific pulse. For a constellation display,
it shows the points included in the demodulation.

7 Horizontal Scale Adjusts the span of the graph. By decreasing the scale, the graph essentially
becomes a window that you can move over the acquisition record by adjusting
the offset.

8 Spectrum Length and Offset
Indicator

This red line indicates the Spectrum Length and Offset. The longer the time,
the longer the bar. Adjusting the offset shifts the bar left or right.

9 Actual length display Displays the actual time for the selected value. If the user-adjusted length
extends past the end of the acquisition record, the realizable analysis length
is less than requested.

10 Analysis Length and Offset
Indicator

This blue line indicates the Analysis Length and Offset. The longer the time,
the longer the bar. Adjusting the offset shifts the bar left or right.

11 Setting Adjustment box Click in this box to adjust the value selected by the Analysis Time Control
buttons.

xxx

NOTE. The area with black background (not gray) in the Amplitude vs. Time Graph highlights the control
selected in the Analysis Time Control drop-down list.

Changing the Time Overview Display Settings (see page 25)
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General Signal Viewing > Time Overview Time Overview Settings

Time Overview Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Setup settings for Time Overview are shown in the following table.

Settings tab Description
Scale (see page 56) Adjusts the vertical and horizontal scale and offset of the display.
Trace (see page 25) Allows you to select the types of trace to display and its function.
Prefs (see page 57) Specifies whether or not certain display elements are shown.
xxx

Trace Tab
The Trace Tab allows you to set the display characteristics of displayed traces.

Setting Description
Show Shows / hides the selected trace.
Detection Sets the Detection method used for the trace. Not available for saved traces. Available

detection methods are +Peak, -Peak, +/-Peak, Avg (VRMS), and Sample. Not all
detection methods are available in all displays.

Function Selects the trace processing method. Available settings are: Normal, Average, Max
Hold, and Min Hold.

(Number of Traces) Sets the number of traces averaged to generate the displayed trace. (Present only
when Function is set to Average.)

Freeze Halts updates to the selected trace.
Save Trace As Saves the selected trace to a file for later recall and analysis.
Show Recalled trace Displays a saved trace instead of a live trace.
xxx
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General Signal Viewing > Time Overview Trace Tab

Detection
Trace Detection occurs when the trace is being decimated by the measurement. For example, if the
maximum number of trace points is 100,000, and the selected analysis region is 200,000 samples, the
measurement must decimate the 200,000 resulting trace points by 2 to prevent exceeding the 100,000 trace
point limit. Since only one value can be selected for each trace point, an algorithm must be used to select
(detect) the appropriate value to use.

The IQ samples in a data acquisition can be detected in a variety of ways. The number of IQ samples
available to each trace point varies with both analysis length and trace length. For example, with Spectrum
Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one
IQ sample pair per trace point. In this case, the detection method chosen has very little effect, as the
+Peak, -Peak, Avg (VRMS) and Sample values are all equal. Changing the Spectrum Length causes the
available detection methods to differ in value because they have a larger set of samples for the various
detection methods to process.

The available detection methods (depending on the display) are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

+/-Peak – Selects the highest and lowest values of all the samples contained in two consecutive
acquisition intervals.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Sample – The result is calculated based on the first sample available in the set of IQ samples for
each trace point.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Multiple traces are averaged together to generate the displayed trace. There is one vertical
value for each underlying frequency data point. Once the specified number of traces have been
acquired and averaged to generate the displayed trace, each new trace takes the place of the oldest
trace in the calculation. The Number of Traces setting specifies how many traces averaged.
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Max Hold - Displays the maximum value in the trace record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace
display point is compared to the previous minimum value and the lesser value is retained for display
and subsequent comparisons.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.
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4. Navigate to the desired file and click Open.

5. Check the Show Recalled Trace check box.

6. Verify that the trace’s Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).
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General Signal Viewing > Spectrum Spectrum Display

Spectrum Display
To display a spectrum:

1. Click the Displays button or select Setup > Displays.

2. From the Folders box, select General Signal Viewing.

3. Double-click the Spectrum icon in the Available displays box. This adds the Spectrum icon to the
Selected displays box (and removes it from the Available displays box). Alternatively, you can click
the Spectrum icon and then click the Add button to select Spectrum for display.

4. Click the OK button.

Elements of the Spectrum Display
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General Signal Viewing > Spectrum Spectrum Display

Item Display element Description
1 Vert Offset Sets the top of graph value. This is only a visual control for panning the

graph. The Reference Level is adjusted in the Toolbar. By default, Vert Offset
= Ref Level.

2 dB/div Sets the vertical scale value. The maximum value is 20.00 dB/division.
3 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its

value is italicized.
4 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab

(see page 54).
5 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on

screen.
6 Position Default function is CF - center frequency (equivalent to the Freq setting).

If Horizontal scaling has been manually adjusted in Settings > Scale, then
Offset will replace CF as the setting at the bottom-left corner of the screen.

7 Span / Scale Default function is Span - frequency difference between the left edge of
the display and the right edge. If Horizontal scaling has been manually
adjusted in Settings > Scale, then Scale will replace Span as the setting at
the bottom-right corner of the screen.

8 Clear Restarts multi-trace functions (Avg, Hold).
9 Function Readout of the Detection and Function selections for the selected trace.
10 Show Controls whether the selected Trace is visible or not. When trace is Off, the

box is not checked.
11 Trace Selects a trace. Touching here pops up a context menu listing the available

traces, whether they are enabled or not. If user selects a trace that is not
currently enabled, it will be made enabled.

xxx

Touchscreen Actions on Markers in the Graph Area

Action Description
Mouse click within 1/2 div. of
a marker

Selects the marker and updates the marker display to show the selected marker’s values.

Touch marker to select and
then use knob, or arrow keys

Adjust the setting associated with the Marker.

Touch and drag a marker Changes marker position to the "drop point".
xxx

Changing the Spectrum Display Settings (see page 31)
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General Signal Viewing > Spectrum Spectrum Settings

Spectrum Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Setup settings for the Spectrum display are visible when Spectrum is the selected display.

Settings tab Description
Freq & Span (see page 50) Sets frequency and span parameters for the Spectrum Analysis display.
BW (see page 54) Sets Resolution Bandwidth and windowing parameters.
Traces (see page 50) Sets Trace display parameters.
Traces (Math) (see page 54) Sets the traces used to create the Math trace.
Scale (see page 32) Sets vertical and horizontal scale and position parameters.
Prefs Tab (see page 57) Specifies whether or not certain display elements are shown.
xxx
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Scale Tab
The Scale tab allows you to change the vertical scale settings. Changing the scale settings changes how
the trace appears on the display but does not change control settings such as Measurement Frequency. In
effect, these controls operate like pan and zoom controls.

Setting Description
Vertical

Scale Changes the vertical scale.
Position Vertical Offset adjusts the reference level away from top of the graph.
Autoscale Resets the Offset so that the trace appears below the top of the graph.

Horizontal
Scale Allows you to change the range of frequencies shown in the graph without changing the

span or measurement frequency.
Position Allows you pan the graph.
Autoscale Resets Scale to the Span setting.

Reset Scale Resets all settings to their default values.
Log scale Resets the display to show the frequency axis in a logarithmic scale.
xxx
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Spectrogram Display
The Spectrogram is a display with the vertical axis (time) composed of successive spectral displays, each
having the amplitude represented by color or intensity. The horizontal axis represents frequency. The most
recently acquired spectrum results are added to the bottom of the spectrogram. The addition of a new
spectrum can occur at the fastest rate that new spectra can be plotted, or, if you choose, new spectra can be
added at a timed rate. The spectrogram view is well-suited to displaying long-term trends of spectral data.
The maximum number of lines that can be displayed in a spectrogram is 125,000.

NOTE. Spectrogram data is shared with the Spectrum display.

To display a Spectrogram:

1. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.

2. From the Folders box, select General Signal Viewing.

3. Double-click the Spectrogram icon in the Available Displays box. This adds the Spectrogram icon
to the Selected displays box.

4. Click the OK button. This displays the spectrogram view.

Elements of the Spectrogram Display
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Item Display element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Spectrogram display is the optimized display.
2 Scale Sets the vertical scale factor, increasing or decreasing the amount of time

in each line.
3 Total time This value represents the total time displayed in the Spectrogram.
4 RBW Sets the resolution bandwidth. Note that when the RBW is set to Auto, its

value is italicized.
5 VBW Enables the VBW (Video Bandwidth) filter. See Setup > Settings > BW Tab

(see page 54).
6 Selected records indicators These indicators show positions of the start and stop records selected on the

Select data records tab. Drag the indicators to select which records will be
played by Replay All.

7 Pos Position indicates the bottom line visible in graph.
8 Autoscale Resets Vertical and Horizontal scale and Pos to default values.
9 T Trigger indicator. This icon indicates the trigger point within the current

acquisition.
10 CF Sets the Center Frequency.
11 Span Sets the span of the spectrogram display.
12 Current data record indicator This blue line indicates the current data record. When the analysis length is

short, the blue line appears as a thin line much like the selected indicator
line. When the analysis length is relatively long, the blue line is much taller
than shown in the illustration.

13 Selected indicator This line indicates the line that will appear in the Spectrum display (if the
Spectrogram trace is enabled in the Spectrum display). This line is attached
to the selected marker.

14 Overlap Shows what portions of its time period a given line shares with previous or
later lines.

xxx

The Spectrogram can show results from one or multiple acquisitions and it can show one or multiple
lines for each acquisition.

Changing the Spectrogram Display Settings (see page 35)
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Spectrogram Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Setup settings for the Spectrogram display are visible when Spectrogram is the selected display.

Settings tab Description
Freq & Span (see page 50) Sets frequency and span parameters for the Spectrogram display.
BW (see page 54) Sets Resolution Bandwidth and windowing parameters.
Trace (see page 35) Sets Trace display parameters.
Scale (see page 39) Sets vertical scale parameters.
Prefs (see page 57) Specifies whether or not certain display elements are shown.
xxx

Trace Tab
The Traces Tab allows you to set the display characteristics of displayed traces.
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Setting Description
Selected Line Displays the time at the Selected Line. If Markers are enabled, the selected line is

positioned by the selected marker. If no markers are enabled, the selected line is the first
line in the current analysis period.

Detection Sets the Detector method used for the trace. Not available for saved traces. Available
detection methods are +Peak, -Peak, +/-Peak, Avg (VRMS), Sample, and CISPR Pk.
Not all detection methods are available in all displays.

Function Selects the trace processing method. Available settings are: Normal, Average, Max
Hold, and Min Hold.

Time (Minutes) Sets the period of time the spectrum trace is averaged to generate each line of the
displayed spectrogram.

Freeze Halts updates to the selected trace.
Save Trace As Saves the selected trace to a file for later recall and analysis.
Show Recalled trace Displays a saved trace instead of a live trace.
xxx

Detection
Trace Detection occurs when the trace is being decimated by the measurement. For example, if the
maximum number of trace points is 100,000, and the selected analysis region is 200,000 samples, the
measurement must decimate the 200,000 resulting trace points by 2 to prevent exceeding the 100,000 trace
point limit. Since only one value can be selected for each trace point, an algorithm must be used to select
(detect) the appropriate value to use.

The IQ samples in a data acquisition can be detected in a variety of ways. The number of IQ samples
available to each trace point varies with both analysis length and trace length. For example, with Spectrum
Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one
IQ sample pair per trace point. In this case, the detection method chosen has very little effect, as the
+Peak, -Peak, Avg (VRMS) and Sample values are all equal. Changing the Spectrum Length causes the
available detection methods to differ in value because they have a larger set of samples for the various
detection methods to process.

The available detection methods are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

CISPR Pk [CISPR Peak] – The trace value is calculated by the methods described for peak detectors
in the CISPR documents.
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Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Multiple traces are averaged together to generate the displayed trace. There is one vertical
value for each underlying frequency data point. Once the specified number of traces have been
acquired and averaged to generate the displayed trace, each new trace takes the place of the oldest
trace in the calculation. The Number of Traces setting specifies how many traces averaged.

Max Hold - Displays the maximum value in the trace record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace
display point is compared to the previous minimum value and the lesser value is retained for display
and subsequent comparisons.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Type a name for the saved trace and click Save.

Recalling Trace
You can recall a previously saved trace for analysis. First, specify a trace for recall and second, enable
Show Recalled Trace.

To recall a previously saved trace:

SignalVu™ Vector Signal Analysis Software Printable Online Help 37



General Signal Viewing > Spectrogram Trace Tab

1. Click the ... button to display the Open dialog box.

2. Navigate to the location of the saved spectrogram trace.

3. Select the desired trace and click Open.

4. Check the Show Recalled Trace check box.
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Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings and set the color scheme
used for the spectrogram trace.

Setting Description
Vertical (Time)

Scale Changes the vertical scale or the length of time shown in the graph. The most recent
acquisition appears at the bottom of the graph.

Offset Offset adjusts which of the lines is placed at the bottom position in the graph.
Autoscale Resets the scale of the vertical axis to contain the complete trace for one acquisition.
Allow Overlap Allows the use of overlapped frequency transforms.

Horizontal (Frequency)
Scale Allows you to change the range of frequencies shown in the graph without changing the

span or measurement frequency.
Offset Allows you pan the graph.
Autoscale Resets Scale to the Span setting.

Color (Power)
Color Displays a drop-down list that allows you to set the color scheme used for the

spectrogram trace.
Max Sets the maximum power level represented by the top of the color scale.
Min Sets the minimum power level represented by the bottom of the color scale.

xxx

Vertical Scale
The Spectrogram display allows you to zoom in and out in the time scale. Positive values zoom in (expand
the scale) and negative values zoom out (compress the scale). If the Scale control does not allow positive
values, either the Analysis Length (Setup > Analysis > Analysis Time) provides only enough time for a
single spectrogram line (manually increase the Analysis Length as needed) or Allow Overlap is disabled.
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Amplitude vs Time Display
The Amplitude vs. Time display plots the signal amplitude against time. The amplitude appears on the
vertical axis while time is plotted along the horizontal axis.

Note that the trace(s) in the Amplitude vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To show Amplitude vs. Time display:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select General Signal Viewing in the Folders box.

3. In the Available displays box, double-click the Amplitude vs. Time icon or select the icon and click
Add. The Amplitude vs. Time icon will appear in the Selected displays box and will no longer
appear under Available displays.

4. Click OK.

Elements of the Display
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Item Display element Description
1 Vert Offset Adjusts the vertical display offset.
2 Vertical scale adjustment Adjusts the vertical scaling.
3 Span Adjust the bandwidth of the data to be analyzed. (Not the period of time

shown in the display.)
4 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
5 Offset Adjust the horizontal offset.
6 Max and Min readouts Displays the maximum and minimum amplitudes, as well as when those

values occur.
7 Scale Sets the time spanned by the graph.
8 Clear button Restarts multi-trace functions (Avg, Hold).
9 Trace function Displays the current trace function setting (Settings > Trace tab > Function).
xxx

Reference. Changing Amplitude vs Time Display Settings (see page 41)

Amplitude vs Time Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The settings for the Amplitude vs. Time display are shown in the following table.

Settings tab Description
BW (see page 42) Sets the Bandwidth Method used for setting the measurement bandwidth.
Traces (see page 50) Allows you to select the type of trace to display and their functions.
Traces (Math) (see page 54) Sets the traces used to create the Math trace.
Scale (see page 56) Sets the vertical and horizontal scale parameters.
Prefs (see page 57) Specifies whether certain display elements are visible.
xxx
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BW Tab
The BW (Bandwidth) tab allows you to specify the Bandwidth Method used for setting measurement
bandwidth. This determines what Acq BW the measurement will request.

Settings Description
Span The frequency span used for analysis in the Amplitude vs. Time display. If the spectrum

display is open, the span is automatically set to the analyzer bandwidth.
Time-domain Bandwidth Time-domain Bandwidth is a filter used to process the input signal before the acquisition

system analyzes the signal.
xxx
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Frequency vs Time Display
The Frequency vs. Time Display shows how the signal frequency varies with time.

Note that the trace(s) in the Frequency vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To display the Frequency vs. Time Display:

1. Select the Displays button or Setup > Displays.

2. In the Select Displays dialog, select General Signal Viewing in the Folders box.

3. In the Available displays box, double-click the Frequency vs. Time icon or select the icon and click
Add. The Frequency vs. Time icon will appear in the Selected displays box and will no longer
appear under Available displays.

4. Click OK to display the Freq vs. Time display.

Elements of the Display

SignalVu™ Vector Signal Analysis Software Printable Online Help 43



General Signal Viewing > Frequency vs Time Frequency vs Time Settings

Item Display element Description
1 Top of graph adjustment Use the knob to adjust the frequency range displayed on the vertical axis.
2 Offset adjustment Adjusts the frequency shown at the center of the display.
3 Autoscale button Adjusts the offset and range for both vertical and horizontal to provide the

best display.
4 Maximum and Minimum

frequency readouts
Displays the maximum and minimum values, as well as when those values
occur.

5 Horizontal Scale Sets the time spanned by the graph.
6 Clear button Restarts Average trace.
7 Trace function Displays the current trace function setting (Settings > Trace > Function).
xxx

Changing Frequency vs Time Display Settings (see page 44)

Frequency vs Time Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Setup settings for Frequency vs. Time are shown in the following table.

Settings tab Description
Freq & Span (see page 50) Sets the frequency and span parameters.
Trace (see page 50) Sets the trace display parameters.
Scale (see page 56) Sets the Vertical and Horizontal scale and offset parameters.
Prefs (see page 57) Specifies whether certain display elements are visible.
xxx
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Phase vs Time Display
The Phase vs. Time display plots the signal phase against time. The phase appears on the vertical axis
while time is plotted along the horizontal axis.

Note that the trace(s) in the Phase vs. Time display can be set to a maximum of 100,000 points (however,
the actual number of trace points can extend up to 1,000,000 points if Max trace points is set to Never
Decimate). If the Analysis Length includes more than the selected Max trace points value, the trace is
decimated (using the method specified with the Detection control) to be equal to or less than the Max trace
points setting (except when Max trace points is set to Never Decimate). This decimated (or undecimated)
trace is what is used for marker measurements and for results export. You can set the Max trace points
on the Settings > Prefs tab.

To display Phase vs. Time:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select General Signal Viewing in the Folders box.

3. In the Available displays box, double-click the Phase vs. Time icon or select the icon and click
Add. The Phase vs. Time icon will appear in the Selected displays box and will no longer appear
under Available displays.

4. Click OK to show the Phase vs. Time display.

Elements of the Display
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Item Display element Description
1 Top of graph adjustment Adjusts the vertical scale. Use the knob to adjust the value of the top of the

graph.
2 Vertical offset adjustment Adjusts the phase error shown at the vertical center of the display.
3 Autoscale button Adjusts the vertical and horizontal settings so that the entire trace fits in the

view.
4 Horizontal Offset Adjusts the horizontal position of the trace.
5 Max and Min readouts Displays the maximum and minimum value of the phase error within the

analysis times and the times at which they occurred.
6 Horizontal Scale Sets the time spanned by the graph.
7 Clear button Restarts multi-trace functions (Avg, Hold).
8 Trace function Shows the trace function as set on the Settings > Trace tab.
xxx

Changing the Phase vs Time Display Settings (see page 46)

Phase vs Time Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The settings for the Phase vs. Time display are shown in the following table.

Settings tab Description
Freq & Span (see page 50) Sets the frequency and span parameters.
Trace (see page 50) Sets the trace display parameters.
Scale (see page 56) Sets the Vertical and Horizontal scale and offset parameters.
Prefs (see page 57) Specifies whether certain display elements are visible.
xxx
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RF I & Q vs Time Display
This is a plot of the baseband In-Phase (I) and Quadrature (Q) components of a modulated carrier. The plot
is in the time domain, with I and/or Q values the Y-axis.

Note that the trace(s) in the RF I & Q vs. Time display can be set to a maximum of 100,000 points
(however, the actual number of trace points can extend up to 1,000,000 points if Max trace points is set
to Never Decimate). If the Analysis Length includes more than the selected Max trace points value, the
trace is decimated (using the method specified with the Detection control) to be equal to or less than the
Max trace points setting (except when Max trace points is set to Never Decimate). This decimated (or
undecimated) trace is what is used for marker measurements and for results export. You can set the Max
trace points on the Settings > Prefs tab.

To display an RF I & Q vs. Time display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select General Signal Viewing.

3. Double-click the RF I&Q vs. Time icon in the Available Displays box. This adds the RF I & Q vs.
Time icon to the Selected displays box.

4. Click the OK button.

Elements of the Display

SignalVu™ Vector Signal Analysis Software Printable Online Help 47



General Signal Viewing > RF I & Q vs Time RF I & Q vs Time Settings

Item Display element Description
1 Top of Graph adjustment Use the knob to adjust the vertical scaling.
2 Vertical offset adjustment Adjusts the level shown at the center of the display.
3 Autoscale button Adjusts the offset and scale for both vertical and horizontal to provide the

best display.
4 Maximum and Minimum level

readouts
Displays the maximum and minimum values, within the Analysis Time, as well
as the times at which they occurred.

5 Scale Sets the time spanned by the graph.
6 Clear button Restarts multi-trace functions (Avg, Hold).
7 Trace function Displays the current trace function setting (Settings > Trace > Function). If the

traces are averaged, the number of averages is displayed.
8 Trace Control Selects which trace is displayed (using the drop-down list) and which trace is

active (click on the trace name to display a menu).
xxx

Changing the RF I & Q vs Time Display Settings (see page 48)

RF I & Q vs Time Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Setup settings for RF I&Q vs. Time are shown in the following table.

Settings tab Description
Freq & Span (see page 50) Sets the frequency and span parameters.
Trace (see page 50) Sets the trace display parameters.
Scale (see page 56) Sets the Vertical and Horizontal scale and offset parameters.
Prefs (see page 57) Specifies whether certain display elements are visible.
xxx
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General Signal Viewing > Common Controls for General
Signal Viewing Displays

General Signal Viewing Shared Measurement
Settings

General Signal Viewing Shared Measurement Settings
The control panel tabs in this section are identical or very similar for each of the displays in the General
Signal Viewing folder (Setup > Displays). Some tabs are shared by all the displays, some tabs are shared
by only a couple of displays.

For some tabs, the control values are shared across all the General Signal Viewing displays. For other
control values, each display has unique values for the controls. Details are provided for the specific tabs.

Common controls for general signal viewing displays
Settings tab Description
Freq & Span (see page 50) Sets the frequency and span parameters.
Trace (see page 50) Sets the trace display parameters.
Traces – Math (see page 54) Sets the traces used to create the Math trace.
BW (see page 54) Sets the Bandwidth Method used for setting the measurement bandwidth.
Scale (see page 56) Sets the Vertical and Horizontal scale and offset parameters.
Prefs (see page 57) Specifies whether certain display elements are visible.
xxx
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General Signal Viewing > Common Controls for General
Signal Viewing Displays

Freq & Span Tab

Freq & Span Tab
The Freq & Span tab provides access to settings that control frequency settings for the trace display. The
control values set in this tab are shared by all the General Signal Viewing displays.

Setting Description
Center The frequency at the center of the selected Span.
Start The lowest frequency in the span.
Stop The highest frequency in the span.
Step Size Sets the increment/decrement size for Center, Start and Stop values.
Span The difference between the start and stop frequencies. This is the measurement

bandwidth for the general signal viewing displays.
Max Span Sets the Span to the maximum value.
xxx

Center, Start, Stop, and Span Frequencies Are Correlated
Changing the values for Center frequency, Start frequency, Stop frequency or Span will change the values
for the other settings, depending on which setting you change. For example, if you change the Center
frequency, the Start and Stop frequencies will be adjusted automatically to maintain the same Span.

Note however that if the Start and Stop frequencies are changed so that they are closer than the minimum
span setting, the Start and Stop frequencies will be adjusted to maintain the minimum Span setting.

Setting Changed Manually Settings Changed Automatically As
a Result

Setting Not Automatically Changed

Start Center, Span Stop
Stop Center, Span Start
Center Start, Stop Span
Span Start, Stop Center
xxx

Traces Tab
The Traces Tab allows you to set the display characteristics of displayed traces.
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General Signal Viewing > Common Controls for General
Signal Viewing Displays

Traces Tab

Setting Description
Trace Selects a trace. (This setting is not present for every display.)
Show Shows / hides the selected trace.
Detection Sets the Detection method used for the trace. Not available for saved traces. Available

detection methods are +Peak, -Peak, +/-Peak, Avg (VRMS), Sample, and CISPR Peak.
Not all detection methods are available in all displays.

Function Selects the trace processing method. Available settings are: Normal, Average, Max
Hold, and Min Hold.

Count Sets the number of traces averaged to generate the displayed trace. (Present only when
Function is set to Average, Min Hold, or Max Hold.)

Freeze Halts updates to the selected trace.
Save Trace As Saves the selected trace to a file for later recall and analysis.
Show Recalled trace Displays a saved trace instead of a live trace.
xxx

Trace
Available traces for Spectrum are: Trace 1, Trace 2, Trace 3, Math, and Spectrogram. Other displays
support fewer traces. Traces 1-3 are based on the input signal and enable you to display the input signal
using different processing. For example, you could display Trace 1 with Function set to Normal, Trace 2
with Function set to Max Hold and Trace 3 with Function set to Min Hold.

The Math trace is the result of subtracting one trace from another.

The Spectrogram trace applies only to the Spectrum display and is available only if the Spectrogram
display is shown. The Spectrogram trace shows the trace selected in the Spectrogram as a spectrum trace.

Detection
Trace Detection occurs when the trace is being decimated by the measurement. For example, if the
maximum number of trace points is 100,000, and the selected analysis region is 200,000 samples, the
measurement must decimate the 200,000 resulting trace points by 2 to prevent exceeding the 100,000 trace
point limit. Since only one value can be selected for each trace point, an algorithm must be used to select
(detect) the appropriate value to use.

The IQ samples in a data acquisition can be detected in a variety of ways. The number of IQ samples
available to each trace point varies with both analysis length and trace length. For example, with Spectrum
Length set to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one
IQ sample pair per trace point. In this case, the detection method chosen has very little effect, as the
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General Signal Viewing > Common Controls for General
Signal Viewing Displays

Traces Tab

+Peak, -Peak, Avg (VRMS) and Sample values are all equal. Changing the Spectrum Length causes the
available detection methods to differ in value because they have a larger set of samples for the various
detection methods to process.

The available detection methods (depending on the display) are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

+/-Peak – Selects the highest and lowest values of all the samples contained in two consecutive
acquisition intervals.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Sample – The result is calculated based on the first sample available in the set of IQ samples for
each trace point.

CISPR Peak – The trace value is calculated by the methods described for peak detectors in the
CISPR documents.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Multiple traces are averaged together to generate the displayed trace. There is one vertical
value for each underlying frequency data point. Once the specified number of traces have been
acquired and averaged to generate the displayed trace, each new trace takes the place of the oldest
trace in the calculation. The Number of Traces setting specifies how many traces averaged.

Max Hold - Displays the maximum value in the trace record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.

Min Hold - Displays the minimum value in the trace record for each display point. Each new trace
display point is compared to the previous minimum value and the lesser value is retained for display
and subsequent comparisons.

Saving Traces
To save a trace for later analysis:

1. Select the Save TraceAs button. This displays the Save As dialog box.
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2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.

4. Navigate to the desired file and click Open.

5. Check the Show Recalled Trace check box.

6. Verify that the trace’s Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).
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Traces Tab – Math Trace
This tab is not a distinct tab, it is just how the Traces tab appears when Math is selected in the Traces
drop-down list.

Trace 4 is a mathematically-derived trace defined as Trace A minus Trace B. You can select Trace 1, 2, or
3 to serve as either Trace A or Trace B.

Setting Description
Trace When set to Trace 4 (Math), this tab is displayed.
Show Shows / hides the selected trace.
Freeze Halts updates to the selected trace.
Save Trace As... Saves the selected trace to a file for later recall and analysis.
Trace minus Trace Selects which traces serve as Trace A and Trace B.
xxx

BW Tab
The BW (bandwidth) tab allows you to change Resolution Bandwidth and Video Bandwidth settings, set
the windowing method used by the transform process by selecting a filter shape, and specify how gain
and bandwidth are optimized.
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Setting Description
RBW Sets the Resolution Bandwidth value to be used in the spectrum analysis view. The

value is italicized when Auto is selected.
Auto When Auto is checked, the RBW is calculated as a percentage of the Span. Kaiser is

selected as the windowing method. When Auto is unchecked, the RBW is set by the user.
Selecting any Window other than Kaiser changes the RBW setting to manual.

Span/RBW ratio If Auto is checked, this value is used to calculate the RBW. If Auto is unchecked, this
setting is not selectable.

Filter Shape Specifies the windowing method used for the transform (when Auto is unchecked).
(Spectrum and Spectrogram displays only.)

VBW Adjusts the VBW (Video Bandwidth) value. (Spectrum and Spectrogram displays only.)
xxx

Filter Shape Settings
In the analyzer, computationally efficient discrete Fourier transform algorithms such as FFT (Fast Fourier
Transform) or CZT (Chirp-Z Transform) are generally employed to transform time-domain signals into
frequency-domain spectra. There is an assumption inherent in the mathematics of Discrete Fourier
Transforms that the data to be processed is a single period of a periodically repeating signal. The
discontinuities between successive frames will generally occur when the periodic extension is made to the
signal. These artificial discontinuities generate spurious responses not present in the original signal, which
can make it impossible to detect small signals in the presence of nearby large ones. This phenomenon is
called spectral leakage.

Applying a filter, such as Kaiser, to the signal to be transformed is an effective method to combat the
spectral leakage problem. Generally the filter has a bell shape. Multiplying the transform frame by the
filter function eliminates or reduces the discontinuities at the ends of the frame, however, at the expense of
increased RBW.

Filter Shape Characteristics
The choice of filter shape depends on its frequency response characteristics such as side-lobe level,
equivalent noise bandwidth and maximum amplitude error. Use the following guidelines to select the
best filter shape.

Filter Shape Characteristics
Kaiser (RBW) Best side-lobe level, shape factor closest to the traditional Gaussian RBW.
-6dB RBW (MIL) These filters are specified for bandwidth at their -6 dB point, as required by military

EMI regulations.
CISPR These filters comply with the requirements specified in the P-CISPR 16 -1-1 document

for EMI measurements.
Blackman-Harris 4B Good side-lobe level.
Uniform (None) Best frequency resolution, poor side-lobe level and amplitude accuracy.
FlatTop Best amplitude accuracy, best representation of brief events captured near the beginning

or end of the time-domain data frame, poor frequency resolution.
Hanning Good frequency resolution, high side-lobe roll-off rate.
xxx
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VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the RBW
setting. VBW is disabled when the Filter shape is set to CISPR.

NOTE. If you are following a procedure that says to "set VBW to three times the RBW value or greater", it
means that the test should be conducted with no VBW effects. In the SignalVu software, this condition
is met by disabling the VBW function.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

The Scale tab values are unique to each display. Also, note that each display uses horizontal and vertical
units that are appropriate for the display. For example, for the Spectrum display uses power (dBm) units
and frequency (Hz) units; the Amplitude vs. Time display uses power (dBm) and time (seconds) units; and
the Phase vs. Time display uses phase (degrees) and time (seconds) units.

Setting Description
Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale.
Offset Vertical Offset adjusts the reference level away from top of the graph.
Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.
Scale Sets the period of time shown in the graph.
Offset Allows you to pan a zoomed trace.
Autoscale Resets the scale of the horizontal axis to contain the complete trace.

Reset Scale Resets all settings to their default values.
xxx
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Prefs Tab
The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display, but include such items as enabling/disabling Marker
Readout, switching the Graticule display on/off, and Marker Noise mode.

Each of the General Signal Viewing displays maintains its own separate values for the controls that appear
on the Prefs tab. Some parameters appear with most displays while others appear with only one display.
For example, the Show Marker readout in graph check box appears in the Prefs tab for every display.
However, the Show Power Trigger level check box only appears on the Amplitude vs Time Prefs tab.

The following table explains the controls that can appear on the Prefs tab.

Setting Description
Show: Selects the horizontal settings that appear below the graph area. You can choose Start,

Stop or Center, Span.
Max trace points Sets the number of trace points used for marker measurements and for results export.
Show trace legend Enables display of a legend in the measurements area that shows the Detection method

and Function setting for displayed traces. The color of the legend text matches the color
of the associated trace.

Show graticule Select to display or hide the graticule.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Show Power Trigger Level Displays or hides a green line in the graph that indicates the level at which the power
trigger is set. The line is not displayed if Trigger is set to Free Run.

Marker Noise mode Select to enable or disable the Marker Noise mode. Use this mode to measure noise on
the trace. See Using Noise Markers in the Spectrum Display (see page 207).

xxx
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Overview
The displays in the Analog Modulation folder (Displays > Folders > Analog Modulation) are:

AM

FM

PM

The Analog Modulation displays provide measurements and time-domain trace displays.

58 SignalVu™ Vector Signal Analysis Software Printable Online Help



Analog Modulation > AM AM Display

AM Display
The Amplitude Modulation Display is a graph of Modulation Factor vs Time. The AM display includes
three numeric readouts.

To show the AM display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select Analog Modulation.

3. Double-click the AM icon in the Available Displays box. This adds the AM icon to the Selected
displays box.

4. Click the OK button. This shows the AM display.

Elements of the Display
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Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the AM display is the optimized display.
2 Top of Graph Sets the %AM indicated at the top of the graph by increasing or decreasing

the vertical scale. Changing the top value affects the bottom of graph readout.
Also, note that the top of graph setting interacts with the internal vertical scale
setting (which is not user settable).

3 Position Specifies the %AM shown at the center of the graph display.
4 Bottom Readout Displays the value of the modulation factor shown at the bottom of graph.
5 Measurement readouts Displays numeric values for the +AM (positive modulation factor), –AM

(negative modulation factor), and Total AM.
6 Position Specifies the horizontal position of the trace on the graph display.
7 Scale Adjusts the horizontal range of the graph. By decreasing the scale (time

across the entire graph), the graph essentially becomes a window that you
can move over the trace by adjusting the position.

8 Clear Erases the trace from the graph.
9 Trace Detection readout Displays the Settings > Trace > Detection setting.
xxx

Changing the AM Settings (see page 60)

AM Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The AM Settings control panel provides access to settings that control parameters of the AM Display.

Setting Description
Parameters (see page 61) Sets the Carrier Amplitude Detection method. You can choose either Average or Median.
Trace (see page 62) Sets Trace display parameters.
Scale (see page 64) Sets vertical and horizontal scale and position parameters.
Prefs (see page 65) Specifies whether or not certain display elements are shown. Specifies the maximum

number of points shown in the display graph.
xxx
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Parameters Tab
The Parameters tab enables you to specify two parameters that control the carrier amplitude detection.

Setting Description
Average Selects the Average method for computing the average baseline for measurements.
Median Selects the Median method for computing the average baseline for measurements.
Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.
xxx

AM Modulation
An amplitude modulated carrier can be described mathematically by:

A, in the above equation, represents the carrier amplitude, a(t) represents the time-varying modulation
and ω0 represents the carrier frequency.

The signal modulation envelope is given by:

There are several ways to express the AM modulation depth, expressed as a percentage.

Peak method

Trough Method

Max-Min Method

In each case, the value of the carrier amplitude, A, needs to be estimated from the input signal.

The instrument represents signals in a sampled form. The sampled envelope can be expressed as a function
of sample index K and sampling period T as:

The instrument allows the choice of two methods for estimating the carrier amplitude:
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Average Method

Median Method

In both cases, the instrument computes the average and the median over the analysis period. It should be
noted that the two methods give the same result for sinusoidal modulation where the sampling frequency
is much higher than the modulation frequency.

Trace Tab
The Trace Tab allows you to set the display characteristics of a trace.

Setting Description
Show Shows/hides the trace. If the instrument continues to run, the measurement results below

the graph display continue to update even if the trace is hidden.
Detection Sets the Detection method used for the trace. Available detection methods are +Peak,

-Peak, and Avg (VRMS). Not available for saved traces.
Function Selects the trace processing method. The only available setting is Normal.
Freeze Halts updates to the trace.
Save Trace As Saves the trace to a file for later recall and analysis.
Show recalled trace Displays a saved trace instead of a live trace.
xxx

Detection
Detection refers to the method of processing the data acquisition points when creating a trace. The IQ
samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:
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+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Trace Processing
Traces can be processed to display in different ways. The Detection setting controls trace decimation,
when needed. When the trace points each cover more than one sample data point, the vertical results
values for multiple data points are combined into each trace point. Each trace point ends up with a single
vertical value.

Average - Each trace point is computed by averaging together the multiple results points it represents.

+Peak - Each trace point represents the highest vertical value among the results it includes.

–Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.
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Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.

4. Verify that the Show check box is selected.

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description
Vertical

Scale Changes the range shown between the top and bottom of the graph.
Position Adjusts the level shown at the center of the graph.
Autoscale Resets the Position so that the entire trace is in the graph.

Horizontal
Scale Changes the range shown between the left and right sides of the graph.
Position Adjusts the position of the acquisition record shown at the left edge of the graph.
Autoscale Resets the Scale and Position settings to provide the optimum display.

xxx
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Prefs Tab
The Prefs tab enables you to change appearance characteristics of the AM display.

Setting Description
Show graticule Shows or hides the graticule.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the AM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.

xxx
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FM Display
The Frequency Modulation Display shows Frequency Deviation vs. Time. The vertical axis units are
Hertz and the horizontal axis units are seconds. When taking measurements, only the first burst in the
Analysis period is analyzed. No trace points are shown for data outside the first detected burst, nor are
measurements made on data outside the first detected burst.

To show the FM display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select Analog Modulation.

3. Double-click the FM icon in the Available Displays box. This adds the FM icon to the Selected
displays box.

4. Click the OK button. This shows the FM display.

Elements of the Display
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Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the FM display is the optimized display.
2 Top of Graph Sets the frequency indicated at the top of the graph. Changing the top value

affects the bottom of graph readout. Also, note that the top of graph setting
interacts with the internal vertical scale setting (which is not user settable).

3 Position Specifies the frequency shown at the center of the graph display. Changing
this value adjusts the top of graph setting and the bottom readout display.

4 Bottom Readout Displays the frequency value indicated by the bottom of the graph.
5 Measurement readouts Displays numeric values for the +Pk (positive frequency deviation), –Pk

(negative frequency deviation), RMS (RMS value of the deviation), Pk-Pk
(peak-to-peak frequency deviation), and Pk-Pk/2 (peak-to-peak frequency
deviation divided by two).

6 Position Specifies the horizontal position of the trace on the graph display.
7 Scale Adjusts the range of the graph. By decreasing the scale (time per division),

the graph essentially becomes a window that you can move over the
acquisition record by adjusting the position.

8 Clear Clears the trace and numeric measurement results.
9 Trace Detection readout Displays the Settings > Trace > Detection setting.
10 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq

Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal’s carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Parameters
tab. If Freq Error is displayed, it also indicates that the Carrier frequency
detection setting is Auto. If Freq Offset is displayed, it indicates that the
Carrier frequency detection setting is manual.

xxx

Changing the FM Settings (see page 68)
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FM Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The FM Settings control panel provides access to settings that control parameters of the FM Display.

Setting Description
Parameters (see page 69) Sets the burst detection threshold, measurement bandwidth, and carrier frequency

detection method.
Trace (see page 70) Sets Trace display parameters.
Scale (see page 72) Sets vertical and horizontal scale and position parameters.
Prefs (see page 73) Specifies whether or not certain display elements are shown. Specifies the maximum

number of points shown in the display graph.
xxx
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Parameters Tab
The Parameters tab enables you to specify parameters for carrier detection.

Setting Description
Burst detect threshold This parameter specifies the power level used to determine whether a burst is present.

A valid burst is required to take measurements. The burst detected first is used for
the analysis. The units for burst detect threshold are dBc, relative to the maximum
acquisition sample data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.
Frequency offset Displays the offset from the center frequency at which measurements are made. Auto is

used to select the method for determining the carrier frequency. When Auto is selected,
the instrument determines the carrier frequency by analyzing the signal. When Auto is
deselected, you can set the carrier frequency using Frequency Offset.

Load from Marker Pressing this button sets the frequency offset to the frequency offset of the selected
marker. (Pressing this button automatically deselects Auto.)

xxx

Frequency Offset
In Auto (Auto is selected), the instrument scans the measurement bandwidth about the measurement
frequency and looks for the highest-powered signal. This is defined as the carrier frequency. In Manual
(Auto is deselected), the carrier frequency is specified by adding/subtracting the specified Frequency offset
from the measurement frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement BW*1.1)/2. If
the Load Δ from marker button is pressed, the frequency offset is determined from the phase difference
between the two markers on screen compared to the time between the two markers. This function is useful
for removing frequency slope from the phase modulated signal.

Load from Marker
When the Auto check box is selected, the instrument scans the measurement bandwidth about the center
frequency and looks for the highest-powered signal. This is defined as the carrier frequency. When
the Auto check box is deselected, the carrier frequency is specified by adding/subtracting the specified
Frequency offset from the center frequency. Pressing the Load from marker button loads the marker
frequency into the Frequency offset box.

SignalVu™ Vector Signal Analysis Software Printable Online Help 69



Analog Modulation > FM Trace Tab

Trace Tab
The Trace Tab allows you to set the display characteristics of displayed trace.

Setting Description
Show Shows / hides the trace. If the instrument continues to run, the measurement results

below the graph display continue to update even if the trace is hidden.
Detection Sets the Detection method used for the trace. Available detection methods are +Peak,

-Peak, and Avg (VRMS). Not available for saved traces.
Function Selects the trace processing method. The only available setting is Normal.
Freeze Halts updates to the trace.
Save Trace As Saves the trace to a file for later recall and analysis.
Show Recalled trace Displays a saved trace instead of a live trace.
xxx

Detection
Detection refers to the method of processing the data acquisition points when creating a trace. The IQ
samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.
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Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.

Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Each trace point is computed by averaging together the multiple results points it represents.

+Peak - Each trace point represents the highest vertical value among the results it includes.

–Peak - Each trace point represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.

4. Verify that the Show check box is selected.
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Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description
Vertical

Scale Changes the range shown between the top and bottom of the graph.
Position Adjusts the frequency shown at the center of the graph.
Autoscale Resets the Position so that the entire trace fits within the graph.

Horizontal
Scale Changes the range shown between the left and right sides of the graph.
Position Adjusts the position of the acquisition record shown at the left edge of the graph.
Autoscale Resets the Scale and Position settings to provide the optimum display.

xxx
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Prefs Tab
The Prefs tab enables you to change appearance characteristics of the FM display.

Setting Description
Show graticule Shows or hides the graticule.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the FM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.

xxx
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PM Display
The Phase Modulation Display shows Phase vs. Time. The vertical axis units are degrees and the
horizontal axis units are seconds. When taking measurements, only the first burst in the Analysis period is
analyzed. No trace points are shown for data outside the first detected burst, nor are measurements made
on data outside the first detected burst.

Elements of the Display
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Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the PM display is the optimized display.
2 Top of Graph Sets the phase value indicated at the top of the graph. Changing the top value

affects the bottom of graph readout. Also, note that the top of graph setting
interacts with the internal vertical scale setting (which is not user settable).

3 Position Specifies the phase shown at the center of the graph display. Changing this
value adjusts the top of graph setting and the bottom readout display.

4 Bottom Readout Displays the phase value indicated by the bottom of the graph.
5 Measurement readouts Displays numeric values for the +Pk (positive phase deviation), –Pk (negative

phase deviation), Pk-Pk (peak-to-peak phase deviation), and RMS (RMS
value of the phase deviation).

6 Position Specifies the horizontal position of the trace on the graph display.
7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the

graph essentially becomes a window that you can move over the acquisition
record by adjusting the offset.

8 Clear Clears the measurement results.
9 Trace Detection readout Displays the Trace Detection setting (see Settings > Trace > Detection).
10 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq

Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal’s carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Parameters
tab. If Freq Error is displayed, it also indicates that the Carrier frequency
detection setting is Auto. If Freq Offset is displayed, it indicates that the
Carrier frequency detection setting is manual.

xxx

Changing the PM Settings (see page 76)
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PM Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The PM Settings control panel provides access to settings that control parameters of the PM Display.

Setting Description
Parameters (see page 76) Sets the Carrier Frequency Detection method. You can choose either Automatic or

Manual. Sets burst threshold and phase detection method.
Trace (see page 77) Sets Trace display parameters.
Scale (see page 80) Sets vertical and horizontal scale and position parameters.
Prefs (see page 81) Specifies whether or not certain display elements are shown. Specifies the maximum

number of points shown in the display graph.
xxx

Parameters Tab
The Parameters tab enables you to specify parameters that control the carrier frequency and phase detection.
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Setting Description
Burst detect threshold Specifies the power level used to determine whether a burst is present. A valid burst is

required to take measurements. The burst detected first is used for the analysis. The
units for burst detect threshold are dBc, relative to the maximum acquisition sample
data points level.

Measurement BW Specifies the bandwidth about the center frequency at which measurements are made.
Frequency offset Displays the offset from the center frequency at which measurements are made. Auto is

used to select the method for determining the carrier frequency. When Auto is selected,
the instrument determines the carrier frequency by analyzing the signal. When Auto is
deselected, you can set the carrier frequency using Frequency Offset.

Load Δ from Marker Pressing this button disables the Auto Frequency Offset function and sets the Frequency
offset to the frequency of the two selected markers.

Phase offset Displays the phase offset. When Auto is selected, the instrument determines the phase
offset. When Auto is deselected, the instrument sets the phase offset using phase
offset setting.

Load from marker Pressing this button sets the phase offset to the phase offset of the selected marker.
(Pressing this button automatically deselects Auto.)

xxx

Frequency Offset
In Auto (Auto is selected), the instrument scans the measurement bandwidth about the center frequency
and looks for the highest-powered signal. This is defined as the carrier frequency. In Manual (Auto is
deselected), the carrier frequency is specified by adding/subtracting the specified Frequency offset from the
center frequency. Range: -(Measurement BW*1.1)/2 to +(Measurement BW*1.1)/2. If the Load Δ from
marker button is pressed, the frequency offset is determined from the phase difference between the two
markers on screen compared to the time between the two markers. This function is useful for removing
frequency slope from the phase modulated signal.

Phase Offset
In Auto (Auto is selected), the instrument sets the phase offset to fit the waveform to the screen centering
0° phase on the vertical axis. The actual phase offset is indicated on the Phase Offset readout. In Manual
(Auto is deselected), the instrument sets the phase offset using the value specified in Phase offset. For
example, when Phase offset is set to 10°, the waveform shifts upward by 10° on screen. Selecting Load
from marker sets the phase offset to the value of the selected markers. Range: –180 to +180°.

Trace Tab
The Traces Tab allows you to set the display characteristics of displayed trace.
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Setting Description
Show Shows / hides the trace. If the instrument continues to run, the measurement results

below the graph display continue to update even if the trace is hidden.
Detection Sets the Detection method used for the trace. Available detection methods are +Peak,

-Peak, and Avg (VRMS). Not available for saved traces.
Function Selects the trace processing method. The only available setting is Normal.
Freeze Halts updates to the trace.
Save Trace As Saves the trace to a file for later recall and analysis.
Show Recalled trace Displays a saved trace instead of a live trace.
xxx

Detection
Detection refers to the method of processing the data acquisition points when creating a trace. The IQ
samples in a data acquisition can be detected in a variety of ways. The number of IQ samples available to
each trace point varies with both analysis length and trace length. For example, with Spectrum Length set
to ‘Auto’ in the Analysis menu, the instrument analyzes just enough samples to produce one IQ sample
pair per trace point. In this case, the detection method chosen has very little effect, as the +Peak, -Peak,
and Avg (VRMS) are all equal. Changing the Spectrum Length causes the available detection methods to
differ in value because they have a larger set of samples for the various detection methods to process.

The available detection methods are:

+Peak – Each point on the trace is the result of detecting the positive peak value present in the set of
IQ samples available to that trace point.

-Peak – Each point on the trace is the result of detecting the negative peak value present in the set of
IQ samples available to that trace point.

Avg (VRMS) [Average VRMS] – Each point on the trace is the result of determining the RMS Voltage
value for all of the IQ samples available to the trace point. When displayed in either linear (Volts,
Watts) or Log (dB, dBm), the correct RMS value results. When the averaging function is applied to a
trace, the averaging is performed on the linear (Voltage) values, resulting in the correct average
for RMS values.

Trace Processing
Traces can be processed to display in different ways. The Function setting controls trace processing.
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Normal - Each new trace is displayed and then replaced by the next trace. Each data point contains a
single vertical value.

Average - Each trace point is computed by averaging together the multiple results points it represents.

+Peak - Each trace point is represents the highest vertical value among the results it includes.

–Peak - Each trace point is represents the lowest vertical value among the results it includes.

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Click the ... button to display the Open dialog box.

2. Navigate to the desired file and click Open.

3. Check the Show Recalled Trace check box.

4. Verify that the Show check box is selected.
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Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description
Vertical

Scale Changes the range shown between the top and bottom of the graph.
Position Adjusts the phase shown at the center of the graph.
Autoscale Resets the Position so that the entire trace in the graph.

Horizontal
Scale Changes the range shown between the left and right sides of the graph.
Position Adjusts the phase shown at the left edge of the graph.
Autoscale Resets the Scale and Position settings to show the entire trace within the graph.

xxx
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Prefs Tab
The Prefs tab enables you to change appearance characteristics of the PM display.

Setting Description
Show graticule Shows or hides the graticule.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Max trace points The trace in the PM display can be set to a maximum of 100,000 points (however, the
actual number of trace points can extend up to 500,000 points if Max trace points is
set to Never Decimate). If the Analysis Length includes more than the selected Max
trace points value, the trace is decimated (using the method specified with the Detection
control) to be equal to or less than the Max trace points setting (except when Max trace
points is set to Never Decimate). This decimated (or undecimated) trace is what is used
for marker measurements and for results export.

xxx
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Overview
The displays in the RF Measurements folder (Displays > Folders > RF Measurements) are:

CCDF

Channel Power and ACPR

MCPR

Occupied Bandwidth

Spurious

The RF Measurements power measurements and signal statistics help you characterize components
and systems.

Power Measurements

Measurement Description
Channel Power The total RF power in the selected channel (located in the ACPR display).
Adjacent Channel Power Ratio Measure of the signal power leaking from the main channel into adjacent channels.
Multi-Carrier Power Ratio The ratio of the signal power in the reference channel or group of channels to the power

in adjacent channels.
Peak/Avg Ratio Ratio of the peak power in the transmitted signal to the average power in the transmitted

signal (located in the CCDF display).
CCDF The Complementary Cumulative Distribution Function (CCDF). CCDF shows how much

time a signal spends at or above a given power level relative to the average power of
a measured signal.

xxx
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Power Ratio) Display

Channel Power and ACPR (Adjacent Channel Power Ratio) Display
Use the Channel Power and ACPR measurement to measure channel power by itself, or adjacent channel
leakage ratio with one main channel.

Measuring Adjacent Channel Power Ratio
1. Select the Displays button.

2. Select RF Measurements from the Folders box.

3. Double-click Chan Power and ACPR in the Available displays box. Click OK to complete your
selection.

4. Press the front-panel Freq button and use the front panel keypad or knob to adjust the frequency to
that of your main channel.

5. Press the Settings button. This displays the control panel for Chan Power and ACPR (the tab displayed
will be the tab displayed the last time the Settings panel was opened).
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6. To set the number of adjacent channels, select the Channels tab. Enter the number of channels in
the Number of adjacent pairs value box. If zero is entered for the number of adjacent pairs, the
resultant measurement will be channel power only.

NOTE. As you add adjacent channels, the span of the display is adjusted so that all the channels can be
seen. Use the horizontal scale and offset to zoom the display in on any portion of the trace.

7. To set the spacing between channel centers, enter the required value in theChannel Spacing value box.

8. To set the channel bandwidth, enter the required value in the Channel Bandwidth value box.

9. After you have configured the channel settings, click the close button ( ) in the Settings panel or
press the Settings button again to remove the settings panel.

10. Press the Run button to take the measurements.

Viewing Results
Measurement results are displayed in a table below the graph and within the graph itself (which can be
enabled/disabled in the Settings > Prefs tab). To see all measurements, you might need to scroll the
table. The size of the results table can be changed by dragging the horizontal divider bar between the
graph and table areas.

Heading Description
Channel Identifies the displayed channels. A1 means the first adjacent channel. A2 means

second adjacent channel. Adjacent channels are numbered according to their offset from
the Main channel. The closest channel is numbered 1. The next closest channel is
numbered 2; and so forth.

Lower The power measured for the lower adjacent channel. Adjacent channel power
measurements are displayed in dB relative to the Main channel.

Upper The power measured for the upper adjacent channel. Adjacent channels power
measurements are displayed in dB relative to the Main channel.

Avg Channel Power (Main) The power measured for the Main channel. The detection type used for measuring
channel power and adjacent channel powers is Average. This means that the average of
the linear (pre-log) samples is used to determine the power. The Main channel power is
displayed in dBm.

xxx
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Setting Channel Power and ACPR Settings Parameters (see page 86)

RF Channel Power Measurement
The RF channel power gives an indication of the total average (and other measures ) RF power in
a given channel.

For some communications systems, there is an “out-of-service” total power measurement defined in the
specifications that calls for a specified constant modulation. In this case, the output power should be
relatively constant. For many measurements, this may not be the case, and the Power Measurement
results will vary as the signal varies.

Average power is the square root of the sum of the squares of the voltage samples over the measurement
time.

The defined “channel” width for the Power Measurement defines the bandwidth and shape of the filter
used to remove any RF power on frequencies outside of the channel bandwidth.

Channel Power
The total RF power in the selected frequency band. The detection type used for measuring channel power
is Average. This means that the average of the linear (pre-log) samples is used to determine the channel
power. To measure channel power, use the ACLR measurement, and set the number of adjacent channels
to zero. This results in only the channel power being measured.

Average Channel Power
The total RF power in the selected channel (located in the ACPR display).

Adjacent Channel Leakage Power Ratio
Adjacent Channel Leakage power Ratio (ACLR) is the ratio of the mean power centered on the
assigned channel frequency to the mean power centered on an adjacent channel frequency. In the 3GPP
specification, both the main channel and adjacent channels are required to be filtered with RRC (Root
Raised Cosine) filters.
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Adjacent Channel Power
Measure of the signal power leaking into nearby channels.

Channel Power and ACPR Settings
Menu Bar: Setup > Settings

The settings for the Channel Power and ACPR display are shown in the following table.

Settings tab Description
Freq & RBW (see page 93) Specify the frequency and resolution bandwidth used for the ACPR measurement.
Measurement Params (see
page 94)

Specify several parameters that control the measurement, such as channel filter, chip
rate, averaging, and correcting for noise floor.

Channels (ACPR) (see
page 86)

This tab specifies the BW and offset parameters of the Channels for the selected ACPR
measurement.

Scale (see page 122) Specifies the vertical and horizontal scale settings.
Prefs (see page 123) Specifies whether certain display elements are visible.
xxx

Restore Defaults. Sets parameters for a 1-channel WCDMA measurement.

Channels Tab for ACPR
The Channels tab is where you specify parameters for the channels measured in the ACPR display.

86 SignalVu™ Vector Signal Analysis Software Printable Online Help



RF Measurements > Channel Power and ACPR Channels Tab for ACPR

Setting Description
Number of adjacent pairs Specifies the number of adjacent channel pairs. Range: 1 - 50; Resolution 1.
Channel Bandwidth Specifies the frequency width of each channel (all channels share the same value).
Channel Spacing Specifies the difference in frequency between the centers of each channel.
xxx

The following figure illustrates the settings controlled from the Channels tab.

Changing the Number of Adjacent Pairs
1. Select Number of adjacent pairs number entry box.

2. Enter a value for the number of adjacent pairs using the knob or the keypad.

NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the spectrum
display to identify the adjacent channels.

3. Select the Close box when you have finished making changes.

Changing the Channel Bandwidth
1. Select the Channel Bandwidth number entry box.

2. Enter a value for the number of adjacent pairs using the knob or the keypad.
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NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the display to
indicate the channel bandwidth

3. Select the Close box when you have finished making changes.

Channel Spacing
1. Select Channel Spacing number entry box.

2. Enter a value for the difference in center frequency between channels using the knob or the keypad.

NOTE. As you change the value for the number of adjacent pairs, the analyzer will update the display to
indicate the channel bandwidth

3. Select Close when you have finished making changes.
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MCPR (Multiple Carrier Power Ratio) Display
Use the MCPR measurement to measure adjacent channel power ratio for multiple main channels or
when adjacent channel pairs have different offsets and/or bandwidths. The MCPR display show the
Reference Power and the ratio of each adjacent channel to the Reference Power. You can select whether
the Reference Power is the total of all active channels or a single channel.

Measuring Multiple Carrier Power Ratio
1. Press the front-panel Displays button.

2. From the Select Displays window, select RF Measurements from the Folders box.

3. Double-click theMCPR icon in the Available displays box. Click OK to complete your selection.

4. Press the front-panel Freq button and use the front panel keypad or knob to adjust the frequency to
that of the main channel. SelectMeas. Freq to set the measurement frequency. Use the front panel
knob to adjust the frequency.

5. Press the Settings button. This displays the control panel for MCPR (the tab displayed will be the tab
displayed the last time the Settings panel was opened).

6. Click on the Channels tab. To set the number of Main channels, enter the number of Main channels in
the Number text entry box underMain Channels.

NOTE. As you add channels, the span of the display will be adjusted so that all the channels can be seen.

7. To set the bandwidth of all main channels, enter a value in the BW value box.

8. To set the spacing between the main channels, enter a value in the Spacing value box.

9. To prevent a main channel power level from being included in the Power Reference (Total) calculation,
select the channel to be excluded in the Inactive box.

10. To add adjacent channels, click the Add... button under Adj Chans.
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11. To edit Frequency Offset or Bandwidth, click within the value box and use the front-panel knob or
your keyboard to set the value. Click Close to save your changes.

NOTE. Frequency Offset is the difference between the center frequency of the selected channel and
the Measurement Frequency. All channels (Main or Adjacent) are specified by their offset from the
Measurement Frequency.

12. After you have configured the Main and Adjacent channels, click the close button ( ) in the
Settings panel or the Settings button to remove the settings panel.

13. Click the Run button ( ) to take the measurements.

Viewing Results
MCPR measurement results are displayed both in the spectrum graph and in a table below the spectrum
display. Individual Main channel power measurements appear in the graph under their channel identifiers.
Individual adjacent channel power ratios also appear in the graph under the adjacent channel identifier.
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The following table details the entries in the results table.

Heading Description
Ch Identifies the adjacent channels. Adjacent channels are numbered according to their

offset from the Main channel. The closest channel is numbered 1. The next closet
channel is numbered 2; and so forth. The prefix “L” means lower; “U” means upper.

Offset The offset is the difference in frequency between the Measurement Frequency and the
center frequency of the channel.

Lower Displays the ratio of the lower adjacent channel power to the Power Reference.
Upper Displays the ratio of the upper adjacent channel power to the Power Reference.
Power Reference Depending on the selected Power Ref, this readout displays either the power of the

selected main channel or the total power in the active main channels.
xxx

Depending on the number of adjacent channels, to see all the measurements, you might need to drag
the divider bar between the main display and the results table at the bottom of the window to change
the height of the results table.

Setting MCPR Measurement Parameters (see page 94)
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Multiple Carrier Power Ratio
The ratio of the signal power in an adjacent channel to the power in one or more main channels.

MCPR Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Setup control panel tabs for MCPR (Multiple Carrier Power Ratio) are:

Settings tab Description
Freq & RBW (see page 93) Specify the frequency and resolution bandwidth used for the MCPR measurements.
Measurement Params (see
page 94)

Specifies parameters controlling how the MCPR measurement is made.

Channels (see page 95) Specifies the parameters of the channels to be measured.
Scale (see page 122) Specifies the vertical and horizontal scale and offset values.
Prefs (see page 123) Specifies whether or not certain display elements are shown.
xxx

Restore Defaults. Sets parameters for a 4-carrier WCDMA measurement.
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Freq & RBW Tab for ACPR and MCPR Displays
The Freq & RBW tab specifies frequency parameters for the Channel Power & ACPR measurements and
MCPR measurement.

Setting Description
Center Freq Specifies the center/measurement frequency.
Step The Step control sets the increment/decrement size for the adjustment of the center

frequency. If Auto is enabled, the analyzer will adjust the Step size as required.
RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is

Independent of the Spectrum view’s RBW setting.
VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum = current RBW value. VBW

Minimum = 1/10,000 RBW setting.
xxx

NOTE. While the center frequency and step settings on this control tab are shared between ACPR, MCPR
and Occupied Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the
RBW setting.

NOTE. If you are following a procedure that says to "set VBW to three times the RBW value or greater", it
means that the test should be conducted with no VBW effects. In the SignalVu software, this condition
is met by disabling the VBW function.
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Measurement Params for ACPR and MCPR Displays
TheMeasurement Params tab is where you set parameters that control the ACPR andMCPRmeasurements.

Measurement Description
Average Enables/disables measurement averaging. Averaging can be enabled in either the

Frequency Domain or Time Domain.
Number When Averaging is set to Frequency Domain, this value specifies the number of

acquisitions to be averaged. When Averaging is set to Time Domain, this value is the
number of successive capture records that are averaged.

Correct for Noise Floor Enables/disables the Noise Floor Correction function.
Optimization This parameter is not used by the SignalVu application.
Power Reference Specifies power against which the results are compared. Choices available are each of

the existing main channels and “Total power in main channels”.
Only present when MCPR is the selected display.

Channel Filter Specify the channel filter used. Select between None (default) and Root-raised Cosine.
Filter Parameter Value entry box for the Root-raised Cosine filter Adjacent Channel Filter.

Present only when the Channel Filter is set to RRC.
Chip Rate Value entry box for the RRC chip rate.

Present only when the Channel Filter is set to RRC.
xxx

Correct for Noise Floor
When this setting is enabled, the instrument applies a correction to the ACPR or MCPR measurement to
reduce the effect of instrument noise on the results. It generates this correction by taking a preliminary
acquisition to measure the instrument noise floor. Once this is done, the measurement proceeds, applying
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the correction to each result. When any relevant settings (reference level, attenuator, frequency, or span)
are changed, the instrument performs a new noise measurement and correction.

Channels Tab for MCPR
Path: Setup > Settings > Channels

Application Toolbar / Front Panel: Settings

The Channels tab is where you specify the parameters for the channels measured in the MCPR display.

Setting Description
Main Channels
Number Sets the number of Main channels.
BW Sets the bandwidth of the Main channels.
Spacing Sets the frequency difference between the centers of the Main channels.
Inactive Selected channels are ignored by the measurement routine.
Adj Chans
Add... Opens the Edit Channel Parameters dialog, which you use to specify the parameters of a

new pair of adjacent channels. You can add up to 50 adjacent channel pairs.
Edit... Opens the Edit Channel Parameters dialog box. (You must first select a channel to

enable the Edit button.)
Delete Deletes the selected main channel or adjacent channel pair.
Add Adj. Add a new pair of adjacent channels at the bottom. Their parameters are copied from

the channels just above them.
Channel Definition table A table of the parameters for every channel. Offset is the frequency difference between

the Center Frequency and center of the selected channel. Nothing in the table is editable
directly.

xxx

The following figure illustrates the settings controlled from the Channels tab.
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Editing Channel Parameters
To edit the offset or bandwidth of a Main channel:

1. Select the value in the BW or Spacing number entry boxes.

2. Adjust the value as required. All the Main channels share the same BW and Spacing.

3. Select the appropriate check box to make a channel Inactive, as appropriate.

4. Select the Close box when you have finished making changes.

To edit the offset or bandwidth of an Adjacent channel:

1. Select the channel to be edited in the channel definition table.

2. Select Edit. This displays the Edit Channel Parameters dialog box.

3. Adjust the values for the Frequency Offset or Bandwidth as required.

4. Select the Close box when you have finished making changes.

Adding Channels
To add a main channel:

1. Select the Number entry box.

2. Use the knob to enter a value for the desired number of Main channels.

3. Select the Close box when you have finished making changes.

To add an adjacent channel pair:
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1. Select Add.... This displays the Edit Channel Parameters dialog box.

2. Use the knob to enter values for the Frequency Offset and Bandwidth as required. The Frequency
Offset is measured from the Center frequency of the Main channels.

3. Select the Close box when you have finished making changes.

Deleting Channels
To delete a main channel:

1. Select the Number entry box.

2. Use the knob to reduce the number of channels or enter a new value using the front-panel keypad.

3. Select the Close box when you have finished making changes.

To delete an adjacent channel:

1. Select the channel to be deleted in the channel definition table.

2. Select Delete. This removes the selected channel from the channel table.

3. Select the Close box when you have finished making changes.
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Occupied BW & x dB BW Display
The Occupied BW display shows the bandwidth within which 99% (a user-defined value, the default is
99%) of the power transmitted within the measurement bandwidth falls.

To show the Occupied BW display:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select RF Measurements in the Folders box.

3. In the Available displays box, double-click the Occupied Bandwidth icon or select the icon and
click Add. The Occupied Bandwidth icon will appear in the Selected displays box and will no
longer appear under Available displays.

4. Click OK to display the Occupied Bandwidth.

Elements of the Display
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Item Display element Description
1 Check mark indicator The check mark indicator denotes the display for which the acquisition

hardware is optimized. This indictor appears only when the display is the
selected display.

2 Averaging readout Appears when averaging is enabled (Settings > Parameters tab > Average
results). Displays "Avg: n of m" while averaging the results and "Avg: m"
once the requested number of results have been averaged.

3 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the
graph.

4 Trace function readout Displays either Normal or MaxHold to indicate trace function.
5 Clear Resets count for Average and MaxHold functions. Enabled only when

Averaging or MaxHold is enabled. Pressing Clear will clear the trace and, if
acquisition is running, restart the averaging or hold process.

6 Graph Displays the input signal. Shaded areas indicate the measurement bandwidth
(Settings > Parameters tab > Measurement BW).

7 Blue lines The blue lines indicate where the selected results (selected in the Main
results area) are being measured on the trace.

8 Grid divider Determines the portion of the display allocated to the graph and detailed
results area. You can move the grid divider all the way to the top or bottom
and any position in between.

9 Detailed results area Displays additional measurements results.
10 Position and dB/div Position sets the top of graph value. The dB/div setting is the vertical scale

value.
11 Main results area Displays results for Occupied Bandwidth (OBW) and x dB bandwidth. Use

the two radio buttons to select which of the two results are illustrated in the
graph with the blue lines and arrows. There are also controls for adjusting
OBW % Power, x dB BW, and RBW.

12 VBW Enables the VBW (Video Bandwidth) filter. Displays current VBW filter setting.
See Setup > Settings > Freq & RBW tab (see page 93).

xxx

Detailed Results Readouts

Measurement Description
Freq Error The frequency difference between the measured carrier frequency of the signal and the

user-selected center frequency of the analyzer.
OBW Level left The signal level at the left edge of the occupied bandwidth.
OBW Level right The signal level at the right edge of the occupied bandwidth.
OBW Ref Power The total power measured within the measurement bandwidth.
x dB BW Ref Power The peak power measured within the measurement bandwidth.
xxx

Changing the Occupied Bandwidth Settings (see page 100)
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Occupied Bandwidth
Bandwidth within which some defined percentage of the power transmitted on a single channel lies.

Occupied BW & x dB BW Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The control panel tabs for the Occupied Bandwidth display are shown in the following table.

Settings tab Description
Freq & RBW (see page 119) Allows you to specify the Center Frequency, Step size and RBW.
Parameters (see page 101) Allows you to specify the Occupied BW % Power, x dB level, Measurement BW, enable

averaging and the Max Hold function.
Scale (see page 122) Allows you to set the vertical and horizontal scale parameters.
Prefs (see page 123) The Prefs tab enables you to set characteristics of the measurement display.
xxx
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Parameters Tab
The Parameters tab enables you to specify parameters that control the Occupied BW measurement.

Setting Description
Occupied BW % Power Specifies the proportion of power within the occupied bandwidth (referenced against the

total power in the measurement bandwidth).
x dB level x dB level defines the x dB BW level search threshold.
Measurement BW Specifies the frequency range used by the measurement.
Max Hold spectral data Enables the Max Hold function.
Average results Enables/disables results averaging. Note that this is not an averaging of the trace, but an

averaging of the results.
Count Specifies the number of results averaged to calculate the Occupied BW. Range: 2 to

10,000.
xxx

x dB Level
The x dB level determines the x dB BW. The instrument analyzes the spectrum trace to locate the
frequencies at which the level is x dB down from the peak level calculated over the measurement
bandwidth. The frequency difference between the upper and lower crossing thresholds is the x dB BW.

Range: -80.0 to -1.0 dB; Resolution: 0.1%; Inc/dec small: 0.1%, large: 1%; Default: -26 dB

Max Hold Spectral Data
Max Hold displays the maximum value in the acquisition record for each display point. Each new trace
display point is compared to the previous maximum value and the greater value is retained for display
and subsequent comparisons.
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Spurious Display
To show the Spurious display:

1. Click the Displays button or select Setup > Displays.

2. From the Folders box, select RF Measurements.

3. Double-click the Spurious icon in the Available displays box. This adds the Spurious icon to the
Selected displays box (and removes it from the Available displays box). Alternatively, you can click
the Spurious icon and then click the Add button to select Spectrum for display.

4. Click the OK button.

Elements of the Spurious Display
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Item Display element Description
1 dB/ div Sets the vertical scale value. The maximum value is 20.00 dB/division.
2 Vert Position Sets the top of graph value. This is only a visual control for panning the graph.

The Reference Level is adjusted in the Toolbar and the Ampl control panel.
By default, Vert Position = Ref Level.

3 Check Mark Indicator Indicates the display for which the acquisition hardware is optimized.
4 Pass / Fail readout Indicates whether one or more spurs have exceeded a limit specified on

the Settings > Limits tab.
5 Ref: If enabled, displays the power reference level.
6 Trace function Indicates the trace processing method. If Average or Max Hold is selected,

this readout displays the number of traces being processed (averaged or
compared for the Max Hold value).

7 Clear Restarts multi-trace functions (Average, Max Hold).
8 Stop Adjusts the graph stop frequency. This setting affects only visual scaling, not

measurement parameters.
9 Green bar Indicates the range that is selected on the Settings > Ranges and Settings >

Limits tabs.
10 Spur table Displays spur measurements. See the following table for details.
11 Start Adjusts the graph start frequency. This setting affects only visual scaling, not

measurement parameters.
12 Autoscale Adjusts the Vertical and Horizontal scaling to display the entire trace on

screen. Selects Multi-range display mode.
13 Bottom-of-graph readout Indicates the amplitude at the bottom of the graph. This value changes with

the dB/div and Vertical Position settings.
xxx

Elements of the Spurious Graph Display
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Item Display element Description
1 The green line or shading indicates an Abs (absolute) limit. The absolute limit

is enabled when the mask is set to Abs, Abs & Rel, or Abs OR Rel. Note that
absolute and relative amplitude masks can overlap.

2 The gray-shaded area indicates a portion of the spectrum where no
measurements are being taken.

3 The cyan line or shading indicates a Relative limit. The relative limit is
enabled when the mask is set to Rel, Abs & Rel, or Abs OR Rel. Note that
absolute and relative amplitude masks can overlap.

4 abs rel Reminder that green-shaded areas highlight absolute limits and cyan-shaded
areas highlight relative limits.

5 This indicates the selected spur, when it is in violation of the limits. In Run
mode, this is the peak spur violation. The selected marker is highlighted in
the Spur table below the graph with a blue background.

6 A spur marker. Indicates a spur that does not exceed the mask settings. See
the Settings > Limits tab (see page 112).

7 A violation marker. Indicates a spur that exceeds the mask settings. See the
Settings > Limits tab (see page 112).

--- Indicates the selected spur when it is not in violation of the limits. The
selected marker is highlighted in the Spur table below the graph with a blue
background.

8 1, 2, 3... A Spur number. The number indicates the row in the spur table that
corresponds to the spur. The instrument can display up to 999 spurs.

9 A, B, C, D... Identifies the enabled ranges.
10 Green bar Indicates the range selected on the Settings > Limits (see page 112) and

Settings > Ranges (see page 110) tabs.
11 Ref Indicates the location of the power reference. See Settings > Reference

(see page 107).
xxx

Elements of the Spur Table
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Column Description
Spur A number that identifies a spur in the graph area. The instrument can display a maximum

of 999 spurs.
Range The letter representing the frequency range where the spur is located.
Freq Abs The absolute frequency at which the spur occurs.
Freq Rel The relative frequency at which the spur occurs. The relative frequency is the difference

between the absolute frequency (absolute) and the carrier frequency.
Ampl Abs The absolute amplitude of the spur.
Ampl Rel The relative amplitude at which the spur occurs. The relative amplitude is the difference

between the absolute amplitude and the carrier amplitude. See the Settings > Limits tab.
Lim Abs The value of the absolute amplitude limit at the spur frequency. This value can vary even

with small spur frequency changes if the start and stop limit values are different. See
the Settings > Limits tab (see page 112).

Lim Rel The relative amplitude limit at which the spur occurs. This value can vary even with small
spur frequency changes if the start and stop relative amplitude limit values are different.
See the Settings > Limits tab (see page 112).

Blue background The cell in the Spur column with a blue background identifies the selected spur.
Red background Cells in the Spur column with a red background identify violations.

Cells in the results area with a red background identify the measurement that exceeded a
limit.

xxx

Rearranging the Columns in the Spur Table
You can rearrange the order of the columns in the Spur Table. To move a column, click on the column
heading and drag it to the desired position.

Sorting the Rows in the Spur Table
You can sort the rows in the Spur table by clicking on the column heading. For example, if you click on
the Freq Abs heading, the results in the Spur table will be sorted by frequency. If you click on Range, the
rows will be sorted by range. Clicking a second time on the same heading reverses the order.

Changing the Spurious Display Settings (see page 106)
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Spurious Display Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The control panel tabs for the Spurious display are shown in the following table.

Settings tab Description
Parameters (see page 107) Specifies whether the graph displays one range or multiple ranges. Specifies whether all

spurs are shown or only spurs over specified limits. Enables the use of CISPR filters
and detectors.

Reference (see page 107) Specifies the Power Reference level.
Ranges (see page 110) Specifies start and stop frequencies of ranges and which ranges to take measurements in.

Sets parameters that define a spur. Review, save and load the Range table from this tab.
Limits (see page 112) Specifies Pass/Fail limit parameters.
Trace (see page 120) Specifies the trace Function.
Scale (see page 122) Specifies the vertical and horizontal scale settings.
Prefs (see page 123) Specifies the appearance features of the graph area.
xxx

Restore Defaults. Sets the Spurious parameters to their default values.
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Parameters Tab
The Parameters tab enables you to specify settings that control the Spurious measurement.

Setting Description
Frequency Ranges
Multi Enables the instrument to display all enabled ranges in the graph.
Single Limits the graph to the display of only one range. The displayed range is set to the range

that contains the selected spur.
List Spurs
All spurs Displays any spur that exceeds the Threshold and Excursion values set on the Ranges

tab.
Over Limit Displays only spurs that exceed both the Threshold and Excursion values set on the

Ranges tab and the limits specified on the Limits tab.
xxx

Reference Tab
The Reference tab enables you to specify the Power Reference parameter. The Power reference parameter
is used to calculate relative values in the Spur table and to calculate relative amplitude limits.
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Setting Description
Power Reference Specifies the power reference level used for relative values and limits.
No reference Power level readings are calculated only for absolute values, no relative values are

calculated.
Manual level The reference level for relative measurements is specified by the Reference power

level setting.
Carrier The reference level for relative measurements is based on the power level calculated at

the specified carrier frequency.
xxx

Setting the Power Reference Level to No Reference

To set the power reference to No Reference:

Select No reference from the Power reference drop-down list.

Setting the Power Reference Level to Manual Level

To set the power reference to manual level:

1. SelectManual level from the Power reference drop-down list. This displays the Reference power
level entry box.

2. Specify the desired power level in the Reference power level entry box.
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Setting the Power Reference Level to Carrier

To set the power reference to Carrier:

1. Select Carrier from the Power reference drop-down list. This displays several parameters.

2. To set the Carrier frequency, click Edit. This displays the Edit Range and Carrier frequencies
dialog box.

3. Specify the necessary values in the Frequency and Channel width entry boxes under Carrier.
Click OK.

4. Specify the Threshold level.

5. Specify the Integration BW. The Integration BW is the bandwidth over which the carrier is measured.

6. Although Auto is the recommended setting, you can specify the Resolution Bandwidth by changing
the value in the Res BW entry box.

7. Set the Detection method. Select either +Peak or Average.

NOTE. If the power level measured over the Integration BW about the carrier frequency is below the
threshold level, the instrument concludes that no carrier is present and no relative measurements will be
taken. Absolute measurements will still be taken.
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Ranges Tab
Use the Ranges tab to specify the parameters that control the Spurious measurement. From the Ranges tab,
you specify the start and stop frequencies for ranges, whether or not a range is enabled, the parameters
that specify what constitutes a spur, measurement filter shape and bandwidth, and the detection method
used for processing signals.

Setting Description
Range Selects the frequency range to which the settings on this tab are applied.

Start Readout of the start frequency for the selected range.
Stop Readout of the stop frequency for the selected range.
Edit Click this button to edit the Spurious Frequency Plan, which defines the range frequency

values and whether or not a signal is measured in a range (enabled/disabled).
Enabled Specifies whether or not measurements are taken in the specified range.

Filter shape Specifies the filter shape used for the Spurious measurement.
BW Specifies the bandwidth used for the selected filter shape.

Auto Sets the BW automatically. If CISPR is selected for Filter shape, this control is disabled.
Detection Sets the processing method used for compressing excess intermediate data into the

desired number of trace points.
Threshold Specifies the level that must be exceeded for a signal peak to be recognized as a spur. A

signal peak must also exceed the Excursion setting to be considered a spur.
Excursion Specifies the peak to peak magnitude that must be exceeded for a signal peak to be

recognized as a spur. A signal transition must also exceed the Threshold setting to be
considered a spur.

VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW
Minimum: 1/10,000 RBW setting. Disabled when Filter shape is set to CISPR.

Review table Click to display the Ranges table. The Ranges Table shows the enabled ranges, and all
the settings specified on the Ranges and Limits tabs associated with the enabled ranges.

Save table Click to save the current Range table to a file.
Load table Click to load a saved Range table from a file.
xxx
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Changing the Range Start and Stop Frequencies

To change the range start and stop frequencies, edit the Spurious Frequency Plan:

1. Click the Edit button on the Settings > Range tab.

2. Click the Enabled box for a range to take measurements in the range.

3. Click on the frequency setting to change it. Type in a number for the frequency and a letter as a
multiplier, then press Enter on the front panel. You can use k, m, or g to set the frequency multiplier.

4. Click OK to save your changes.

You can enable a range on the Ranges control panel tab by selecting the range from the Range drop-down
list and clicking the Enabled check box. If you need to change the frequency of a range, you must edit
the spurious frequency plan using the Edit button.

Specifying Spur Requirements
A spur is a signal peak that exceeds both the Threshold and Excursion settings on the Ranges tab. The
Threshold and Excursion settings are absolute values; they are not calculated relative to a reference. The
Threshold and Excursion settings are specific to the selected range. If you want to use different settings for
spurs in different ranges, you have to set the values separately for each range. The Excursion control is
used to avoid interpreting a single spur as multiple narrower spurs by requiring the amplitude to drop by
the Excursion amount between spurs. Raising the Threshold value means that fewer, larger signals will
be identified as spurs.

To specify the spur requirements for a range:

1. Select the Range for which you want to specify the spur requirements.

2. Set the Threshold value.

3. Set the Excursion value.
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Limits Tab
Use the Limits tab to specify the pass/fail parameters for the Spurious measurement. When the Mask
setting is set to any value except off, the instrument identifies any signal peak that exceeds the specified
limits as a violation and displays Fail on the screen. If no signal peak exceeds the limits, the instrument
displays Pass on the screen.
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Setting Description
Range Selects the frequency range to which the settings on this tab are applied.

Start Readout of the start frequency for the selected range.
Stop Readout of the stop frequency for the selected range.
Edit Click this button to edit the Spurious Frequency Plan, which defines the range frequency

and whether or not measurements are taken in a range (enabled/disabled).
Enabled Specifies whether or not measurements are taken in the specified range.

Mask Selects the type of limits used for Pass/Fail testing. Spurs that exceed the mask settings
are considered violations.

Abs Spurs that exceed the Absolute limits settings are identified as violations.
Rel Spurs that exceed the Relative limits settings are identified as violations.
Abs & Rel Spurs that exceed both the Absolute and Relative limits settings are identified as

violations.
Abs OR Rel Spurs that exceed either the Absolute or Relative limits settings are identified as

violations.
Off Turns off limit testing for the selecting range. Measurements are still taken in the range,

but violations are not flagged. Signal peaks that exceed the Threshold and Excursions
values will still be identified as spurs.

Absolute ampl Absolute amplitude limits are not based on the measured carrier amplitude or manual
reference. Start and stop values can be different.

Start Specifies the limit at the start frequency of the range.
Stop Specifies the limit at the stop frequency of the range.
Same Sets the limit at the start and stop frequencies to the value set for the start frequency.

Relative ampl Relative amplitude limits are calculated from the Power Reference. If the Power
Reference is set to the Carrier level, the relative amplitude limits will change with the
carrier level. Start and stop values can be different.

Start Specifies the limit at the start frequency of the range.
Stop Specifies the limit at the stop frequency of the range.
Same Sets the limit at the stop frequency to the value set for the start frequency.

Review table Click to display the Ranges table. The Ranges Table shows the enabled ranges, and all
the settings specified on the Ranges and Limits tabs associated with the enabled ranges.

Save table Click to save the current Range table to a file.
Load table Click to load a saved Range table from a file.
xxx

Performing Pass/Fail Limit Testing
To set limits:

1. Press Settings to display the Spurious Settings panel.

2. Press Limits to display the Limits tab.

3. Press Edit to display the Range and Carrier Frequencies dialog box.

4. Adjust the start and stop frequencies as required for each range you want to test.
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5. For ranges that you wish to test, verify that the Enabled box is checked. Click OK.

6. Select a range you want to test from the Range drop-down list.

7. Select the desiredMask type from the drop-down list.

8. Set the limits as desired in the Absolute ampl and Relative ampl boxes. The values you can edit
depend on the mask type you select.

9. Repeat steps 5, 6 and 7 for each range you want to test.

10. Verify that the Threshold and Excursion values on the Ranges (see page 110) tab are set as required.
These are the values that define a spur.

11. Press the close box to remove the Settings panel.

12. Click Run to begin testing.
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CCDF Display
The CCDF (Complementary Cumulative Distribution Function) is a statistical characterization that plots
power level on the x-axis and probability on the y-axis of a graph. Each point on the CCDF curve shows
what percentage of time a signal spends at or above a given power level. The power level is expressed in
dB relative to the average signal power level. The CCDF Display also shows the Average power level
and the Peak/Average ratio.

To show the CCDF display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select RF Measurements.

3. Double-click the CCDF icon in the Available Displays box. This adds the CCDF icon to the Selected
displays box.

4. Click the OK button.

Elements of the CCDF Display
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Item Display element Description
1 100% The top of the graph represents the 100% probability that the signal will be at

or above the average signal level.
2 Power level select Adjust to display the value of the CCDF curve at a specific power level. The

selected power level is indicated by a small triangle on the CCDF curve.
3 CCDF value Readout of the value of the CCDF curve at the selected power level.
4 Avg Readout of the Average power level and the CCDF value at the Average

power level.
5 Readout Table Readout of the CCDF curve at six points.
6 Pk / Avg Readout of the Peak to Average power ratio.
7 Measurement time Readout of the length of time used for the measurement. Displays --- s when

the Measurement time is set to continuous.
xxx

Changing the CCDF Display Settings (see page 116)

CCDF Settings
Menu Bar: Setup > Settings

The control panel tabs for the CCDF Display are shown in the following table.

Settings tab Description
Parameters (see page 117) Specifies the time to be measured.
Traces (see page 120) Select the trace to be measured and select reference trace for display.
Prefs (see page 123) Specifies whether on not certain display elements are shown.
xxx

Restore Defaults. Sets the CCDF parameters to their default values.
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Parameters Tab
The Parameters tab enables you to specify several parameters that control signal acquisition for the
CCDF Display.

Setting Description
Single When Single is selected, the CCDF measurement is based on the Analysis Time

parameters set on Analysis control panel (Setup > Analysis > Analysis Time), shared by
all displays. In Single, CCDF is time-correlated with the other open displays.

Total Time When Total Time is selected, you can adjust its value. The value set here does not affect
the Analysis Length value set in the Analysis control panel. If the Total Time value is
longer than the Analysis Length, CCDF uses multiple acquisitions to collect signal data.

Continuous When Continuous is selected, the CCDF measurement combines each new record
(Actual Analysis Length) into the existing result. It does not erase and start over until
user presses STOP or CLEAR.

Span Specifies the range of frequencies used for analysis.
xxx

Single
To have statistically meaningful results, CCDF works best when calculated on at least 1 ms of data.
Depending on the Analysis Time setting, the CCDF display may present error messages:

If the Actual Analysis Time is greater than 1 ms, the CCDF Display will calculate the trace without
any problems.

If the Actual Analysis time is less than 1 ms, the CCDF Display will measure the data as best if
can, but if it receives fewer than 20 samples, the CCDF display will clear the trace and report "Not
enough samples".
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RF Measurements Shared Measurement Settings

RF Measurements Shared Measurement Settings
The control panel tabs in this section are shared by the displays in the RF Measurement folder (Setup >
Displays). With few exceptions, each display maintains separate values for each of the controls on these
tabs. For example, Scale values are independent for each of the displays.

Common controls for RF measurement displays
Settings tab Description
Freq & RBW (see page 119) Allows you to specify the Center Frequency, Step size and RBW.
Traces (see page 120) Specifies trace parameters such as detection method and whether smoothing in enabled.

Traces can also be saved and loaded for reference from this tab.
Scale (see page 122) Specify vertical and horizontal scale settings.
Prefs (see page 123) Specify appearance features of the graph area.
xxx
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Freq & RBW Tab

Freq & RBW Tab
The Freq & RBW tab specifies frequency parameters for the RF Measurements displays.

Setting Description
Center Freq Specifies the center/measurement frequency.
Step The Step control sets the increment/decrement size for the adjustment of the center

frequency. If Auto is enabled, the analyzer will adjust the Step size as required.
RBW Select Auto or Manual. Adjusts the RBW for the entire measurement. This setting is

Independent of the Spectrum view’s RBW setting.
VBW Adjusts the VBW (Video Bandwidth) value. VBW Maximum = current RBW value. VBW

Minimum = 1/10,000 RBW setting.
xxx

NOTE. While the center frequency and step settings on this control tab are shared between ACPR, MCPR
and Occupied Bandwidth, the RBW setting is not shared. The RBW setting is unique for each measurement.

VBW
The VBW setting enables/disables the Video Bandwidth filter. VBW is used in traditional swept analyzers
to reduce the effect of noise on the displayed signal. The VBW algorithm in the analyzer emulates the
VBW filters of traditional swept analyzers.

The maximum VBW value is the current RBW setting. The minimum VBW value is 1/10,000 of the
RBW setting.

NOTE. If you are following a procedure that says to "set VBW to three times the RBW value or greater", it
means that the test should be conducted with no VBW effects. In the SignalVu software, this condition
is met by disabling the VBW function.
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Traces Tab

Traces Tab
The Traces tab enables you to select traces for display. You can choose to display a live trace, a saved
trace, and a reference trace.

NOTE. Not all RF Measurements support multiple traces and/or save and recall of traces.

Setting Description
Trace Selects a trace for display. Choices are Trace 1, 2, and Gaussian (CCDF display only).

Trace 1 and 2 can be saved traces.
Show Shows / hides the selected trace.
Freeze Halts updates to the selected trace.
Save Trace As... Saves the selected trace to a file for later recall and analysis.
Show recalled trace Used to select a saved trace for display.
xxx

Saving Traces
To save a trace for later analysis:

1. Select the Save Trace As button. This displays the Save As dialog box.
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Traces Tab

2. Navigate to the desired folder or use the default.

3. Type a name for the saved trace and click Save.

Recalling Traces
You can recall a previously saved trace for analysis or comparison to a live trace.

To select a trace for recall:

1. Select the trace into which the recalled trace will be loaded, from the Trace drop-down list.

2. Check the Show check box.

3. Click the ... button to display the Open dialog box.

1. Navigate to the desired file and click Open.

2. Check the Show Recalled Trace check box.

3. Verify that the trace’s Show check box is selected (either on this tab or next to the drop-down list
located at the top-left corner of the graph).

Gaussian Trace
The Gaussian trace is a reference trace that you can compare your trace against. Because the Gaussian
trace is for reference, there are no settings for the trace other than whether or not it is shown.
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Scale Tab

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Center Frequency.

Setting Description
Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units. This is only accessible when the vertical units are
set to dBm.

Offset Adjusts the Reference Level away from the top of the trace display.
Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.
Scale Allows you to, in effect, change the span.
Offset Allows you to pan a zoomed trace without changing the Measurement Frequency. Offset

is only enabled when the span, as specified by Freq / div , is less than the acquisition
bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.
Log (Spurious only) Resets the display to show the frequency axis in a logarithmic scale.
xxx
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Prefs Tab

Prefs Tab
The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display, but include such items as enabling/disabling Marker
Readout, switching the Graticule display on/off, and Marker Noise mode. Some parameters appear with
most displays while others appear with only one display.
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Overview
The displays in the Pulsed RF folder (Displays > Folders > Pulsed RF) are:

Pulse Statistics

Pulse Table

Pulse Trace

The Pulse measurements provide deep insight into pulse train behavior.

Pulse Measurements
The analyzer takes the following pulse measurements: Average ON Power, Peak Power, Average
Transmitted Power, Pulse Width, Rise Time, Fall Time, Repetition Interval (Sec), Repetition Rate
(Hz), Duty Factor (%), Duty Factor (Ratio), Ripple, Droop, Pulse-Pulse Phase Difference, Pulse-Pulse
Frequency Difference, RMS Frequency Error, Maximum Frequency Error, RMS Phase Error, Maximum
Phase Error, Frequency Deviation, Phase Deviation, and Time. See Available Measurements (see page 17)
for definitions.
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Pulse Table Display
The Pulse Table lists selected measurements in a spreadsheet format, showing the pulse numbers and all
the results for each measurement on all the detected pulses. Pulses are numbered from one.

Displaying the Pulse Table
1. Press the Displays button or select Setup > Displays.

2. Select PulsedRF in the Folders box.

3. Double-click Pulse Table in theAvailable displays box to add the display to the Selected displays box.

4. Click OK.

Selecting the Measurements to Show
1. With the Pulse Table selected, press the Settings button.

2. In the Pulse Table Settings control panel, select theMeasurements tab.
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3. Select the measurements you wish to take from the list of measurements.

4. Click the close box ( ) to remove the Settings control panel.

Changing the Pulse Table Display Settings (see page 126)

Pulse Table Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Settings control panel tabs for the Pulse Table Display are shown in the following table.

Settings tab Description
Measurements (see page 126) Selects the measurements to be show in the Pulse Table.
Params (see page 132) Specifies several parameters that control how pulses are counted and defined.
Define (see page 133) Specifies parameters that control where measurements are taken on a pulse.
Levels (see page 138) Specifies parameters that control the method and levels used to calculate some pulse

values.
Freq Estimation (see
page 139)

Specifies the reference used for computing frequency errors.

xxx

Restore Defaults. Sets the Pulse Table parameters to their default values.

Measurements Tab
The Measurements tab is used to specify the measurements that appear in the Pulse Table.

Show in Pulse Table
Checked measurements appear in the Pulse Table.
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Pulse Trace Display
The Pulse Trace display shows one measurement result and a trace graph illustrating that measurement
for a selected pulse number. You can also choose to display arrows and lines in the graph that illustrate
where on the pulse the measurement is being taken.

Elements of the Pulse Trace Display
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Item Display element Description
1 Optimized indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Pulse Trace display is the optimized display.
2 Result Use this list to select the measurement to show. The measurement chosen

here selects the same result to be displayed in the Statistics view and
highlighted in the Table view. Selecting a result in any of these views causes
the same result to be selected in all of them.

3 Pulse Selects which pulse result is shown. Like the Result, this selection is shared
with the Statistics and Table views. The maximum number of pulses that
can be measured is limited to 10000.

4 Pulse threshold indicator This green triangle indicates the power threshold used to detect pulses. See
Settings > Params > Power threshold to detect pulses.

5 Autoscale Set the axes to values that show all trace points.
6 Horizontal offset and scale Located along the bottom edge of the trace display, these controls specify the

offset and scale on the horizontal axis.
7 Top of graph adjustment Sets the power level shown at the top of the graph. If the number is greater

than the Ref Level, a white line will appear in the graph to indicate the Ref
Level.

8 Vertical scale Sets the vertical scale value.
xxx

Changing the Pulse Trace Display Settings (see page 128)

Pulse Trace Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Setup settings for the Pulse Trace display are shown in the following table.

Settings tab Description
Params (see page 132) Specifies several parameters that control how pulses are counted and defined.
Define (see page 133) Specifies parameters that control where measurements are taken on a pulse.
Levels (see page 138) Specifies parameters that control the method and levels used to calculate some pulse

values.
Freq Estimation (see
page 139)

Specifies the reference used for computing frequency error.

Scale (see page 140) Specifies the vertical and horizontal scale settings.
Prefs (see page 141) Specifies whether on not certain display elements are shown.
xxx
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Pulsed RF > Pulse Statistics Pulse Statistics Display

Pulse Statistics Display
The Pulse Statistics view displays a plot of a pulse measurement’s values for every pulse in the analysis
period. For example, the Pulse Statistics display will show the rise time measurement for each of 30
pulses, with rise time on the Y axis and pulse number on the X axis. Alternatively, the Statistics Display
can show an FFT trace for the values of a measurement over all the pulses analyzed. Numeric readouts of
Max, Min, and Average in this display summarize results for the selected pulse measurement.

Elements of the Pulse Statistics Display
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Item Display element Description
1 Optimized indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Pulse Statistics display is the optimized display.
2 Result Use this list to select which measurement statistics to display. The

measurement chosen here selects the same result to be displayed in the
Pulse Trace display and the Pulse Table display. Selecting a result in any of
these views causes the same result to be selected in all of them.

3 Pulse Selects which pulse’s result is shown. Like the Result, this selection is shared
with the Statistics and Table views.

4 Statistics summary Display of measurement statistics for the selected Result.
5 Vertical range Located at the top of the left graph edge and at the bottom of the left graph

edge, use these controls to adjust the values at the top of the graph and the
bottom of the graph.

6 Plot Selects from Trend, Time Trend, FFT, and Histogram for the graph.
7 Autoscale Set the axes to values that show all trace points.
8 Horizontal offset Adjusting this value moves the graph right or left.
9 Trigger indicator Indicates the trigger point on the pulse train if the trigger occurred during the

time frame of the pulse measurements.
10 Pulse indicator For Trend and Time Trend plot types, this indicates the pulse selected by the

Pulse setting. For the FFT plot type, this indicator marks the trace point at
the selected frequency. For Histogram plot types, this indicator marks the
selected results bin.

11 Scale Adjusts the horizontal scale.
xxx

Changing the Pulse Statistics Display Settings (see page 131)
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Pulsed RF > Pulse Statistics Pulse Statistics Settings

Pulse Statistics Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The settings for the Pulse Statistics Display are shown in the following table.

Settings tab Description
Params (see page 132) Specifies several parameters that control how pulses are counted and defined.
Define (see page 133) Specifies parameters that control where measurements are taken on a pulse.
Levels (see page 138) Specifies parameters that control the method and levels used to calculate some pulse

values.
Freq Estimation (see
page 139)

Specifies the reference used for computing frequency errors.

Scale (see page 140) Specifies the vertical and horizontal scale settings.
Prefs (see page 141) Specifies whether or not certain elements of the display are shown.
xxx
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Pulsed RF > Common Controls for Pulsed RF Displays Pulsed RF Shared Measurement Settings

Pulsed RF Shared Measurement Settings
The control panel tabs in this section are shared by the displays in the Pulsed RF folder (Setup > Displays).
Changing a setting on one tab changes that setting for all the Pulsed RF displays.

Common controls for pulsed RF displays
Settings tab Description
Params (see page 132) Specifies several parameters that control how pulses are counted and defined.
Define (see page 133) Specifies parameters that control where measurements are taken on a pulse.
Levels (see page 138) Specifies parameters that control the method and levels used to calculate some pulse

values.
Freq Estimation (see
page 139)

Specifies the reference used for computing frequency errors.

Scale (see page 140) Specifies the vertical and horizontal scale settings.
Prefs (see page 141) Specifies whether or not certain elements of the display are shown.
xxx

Params Tab
The Params tab enables you to adjust several measurement parameters for Pulsed RF displays.

Setting Description
Measurement Filter Specify whether a filter is used to limit the bandwidth of the input signal.
Bandwidth Sets the bandwidth of the measurement filter.
Power threshold to detect
pulses

Specifies the level used for locating pulses in the data.

Minimum OFF time between
pulses

Specifies the time the signal must fall below the power threshold for two pulses to be
considered separate pulses.

Max number of pulses Specifies the number of pulses to measure within the analysis time.
xxx
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Measurement Filter
Three choices are available for the measurement filter:

No Filter - Max BW: The widest acquisition bandwidth available is used. The Bandwidth setting is
disabled, but shows the value in use.

No Filter: - This is the default. The Bandwidth control is enabled for you to specify an acquisition
bandwidth.

Gaussian - The Bandwidth control is enabled for you to specify a value. The instrument uses an
acquisition bandwidth two times wider than the entered value.

Power Threshold to Detect Pulses
Specifies the minimum power level the trace must exceed to be detected as a pulse. The range for this
setting is: -3 to -70 dBc. The setting resolution is 1 dB. The default value is -10 dB.

Max Number of Pulses
If the Analysis Time contains fewer pulses than specified, the analyzer will measure all the pulse within
the analysis time. If there are more pulses in the Analysis Time, than the specified number, the analyzer
measures the specified number of pulses and ignores the rest. The range for this setting is: 1 - 10000.
The setting resolution is: 1. If this setting is not checked, the analyzer will measure all pulses within the
Analysis Time, up to a maximum of 10000 pulses.

Define Tab
The Define tab enables you to specify parameters that control where measurements are made on a pulse.
The settings available depend on the measurement selected.

The following paragraphs describe the settings that appear on the Define tab according to the
Measurement(s) selection.
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Freq-Domain Linearity

Setting Description
Time method Specifies how the measurement’s duration is determined. The choices are

Absolute and Relative.
Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L) Length specifies the period of time that is used for pulse measurements The
measurement time begins at the Start point and continues for the amount of time
specified by Length.

Relative time method
Length In the Relative time method, Length specifies the percentage of the top of the pulse

that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.

xxx

Impulse Response
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Setting Description
Apply ampl corrections Enable/disable corrections that remove errors due to the window function and to

the time offset of the side lobe.
Keep-out time (+/-) The Keep-out time specifies a region that is ignored when the trace is analyzed for

side lobes. The setting defines a region to the left and to the right of the center
of the main lobe. Lobes that fall within this time region are not eligible to be the
“highest side lobe”.

Time method Specifies how measurement parameters are determined. The choices are
Absolute and Relative.

Absolute time method
Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point

from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L) Amount of time that should be included in the measurement. The measurement
time begins at the Start point and continues for the amount of time specified by
Length.

Relative time method In the Absolute time method, Length specifies the period of time that is used for
pulse measurements.

Length In the Relative time method, Length specifies the percentage of the top of the pulse
that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.

xxx

Freq Diff, Phase Diff

Setting Description
Measure point Specifies the period in time after the 50% rising edge at which frequency and

phase difference measurements are made.
xxx
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Ripple

Setting Description
Length Length specifies the percentage of the top of the pulse that is used for

measurements. The instrument automatically determines the pulse top. The
measurement length is centered within the pulse ON time. Only the Relative Time
method is available for Ripple.

xxx

Overshoot

136 SignalVu™ Vector Signal Analysis Software Printable Online Help



Pulsed RF > Common Controls for Pulsed RF Displays Define Tab

Setting Description
Time method Specifies how measurement parameters are determined. The choices are

Absolute and Relative.
Absolute time method

Ref (R) Ref specifies the level along the pulse rising edge that is defined as the point
from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start (S) Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length (L) Amount of time that should be included in the measurement. The measurement
time begins at the Start point and continues for the amount of time specified by
Length.

Relative time method
Ref Ref specifies the level along the pulse rising edge that is defined as the point

from which Start time is counted. Choices: 50%, 60%, 70%, 80%, 90% 100%;
Default: 100%

Start Start specifies the time the instrument waits after the rising-edge reference before
starting to measure the pulse. The Start time is measured from the point along the
pulse rising edge specified by the Ref setting. Start Range: ±100 ms; Resolution:
3 digits; inc/dec small: 1 ns, large: 1,2,5,10...; Default: 0

Length In the Relative time method, Length specifies the percentage of the top of the pulse
that is used for measurements. The instrument automatically determines the pulse
top. The measurement length is centered within the pulse ON time.

xxx
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Levels Tab
Use the Levels tab to set parameters that control the method and levels used to calculate some pulse values.

Setting Description
100% Level Specifies the method used to determine the 100% level(s).
50% Level Specifies the method used to determine the 50% level on the pulse.
Rise/Fall Levels Select whether to use the 10% to 90% or 20% to 80% points (based on voltage level)

to define the rise and fall times.
xxx

100% Level
Use the 100% Level settings to select the method used to determine the 100% level(s) used for calculating
pulse parameters, for example, Rise, Fall, and Width.

The Pulse Average Amplitude defines the pulse top as the average of the values of all the points along
the pulse top. This average is used as the 100% level, from which the 10, 20, 50, 80 and 90% levels are
calculated. Pulse measurements are referenced against these various levels. For example, Rise is the time
between the 10 and 90% (or 20 and 80%) levels on the rising edge of the pulse. When the Pulse Average
Amplitude method is selected, the same 100% level is used for both rising and falling edges.

Because some RF pulse types have droop (a height difference between the beginning and ending points of
the pulse top), the 100% percent level on the rising edge may not be equal to the 100% level on the falling
edge. The Independent method of pulse point location is designed for pulses with different 100% levels
at their rising and falling edges. The Independent method calculates the 100% level for the rising edge
separately from the 100% level of the falling edge. As a result, the 10, 20, 50, 80 and 90% levels are also
different for the rising and falling edges, allowing for more accurate measurements on pulses with droop.

50% Level
Select Voltage to use -6 dB as the 50% point. Select Power to use -3 dB as the 50% level.
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Freq Estimation Tab
Use the Freq Estimation tab to specify parameters used for determining frequency offset.

Setting Description
Modulation type Specifies which algorithm to use for estimating frequency error.
Pulse Frequency Reference Specifies the method used to determine the pulse frequency error and if applicable,

the chirp slope.
Auto Selecting Auto causes the instrument to calculate the frequency offset and if applicable,

the chirp slope.
Freq Offset If Auto is not enabled, specify the value for frequency offset here. If Auto is enabled, the

offset is set to zero and this readout displays the calculated frequency error.
Chirp BW If Auto is not enabled, specify the value for Chirp Slope here. If Auto is enabled,

this readout displays the calculated Chirp slope. This setting is used only when the
modulation type is set to Linear Chirp.

xxx

Modulation Type
Frequency estimation is performed by the instrument using selectable methods, depending on signal type.
The selections for modulation type are CW (constant phase), CW (changing phase), Linear Chirp and
Other. Select the method of frequency method based upon a best match to your signal based on the
following descriptions:

CW (constant phase): The signal is not designed to change in either frequency or phase during the
measured pulse train.

CW (changing phase): The signal does not change the carrier phase within each pulse, although it
could change the phase from one pulse to another pulse. The signal is not designed to make frequency
changes.

Linear Chirp: The signal changes frequency in a linear manner during each pulse. The signal has the
same carrier phase at the same time offset from the rising edge of the pulse.

Other: The signal is not one of the listed types. You must manually enter the Frequency Offset value.

The following table maps the appropriate signal type selection with the signal characteristics.
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Phase offset from one pulse to anotherSignature
Zero Any (unknown)

CW CW Constant Phase CW Changing Phase
LFM Linear Chirp N/A
xxx

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency. In effect, these controls operate like pan and zoom controls.

Setting Description
Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale. The units for this setting depend on the statistic selected
from the Result drop-down list in the Pulse Statistics display.

Position Adjusts the Reference Level away from the top of the trace display. The units for this
setting depend on the statistic selected from the Result drop-down list in the Pulse
Statistics display.

Autoscale Resets the scale of the vertical axis to contain the complete trace.
Horizontal Controls the span of the trace display and position of the trace.

Scale Allows you to change the span.
Position Allows you to pan a zoomed trace.
Full Scale (Pulse Trace
display only)

Specifies the Horizontal scale default.

Selected Sets the horizontal scale default to be based on the result value for the currently-select
pulse.

Max Pulse Sets the horizontal scale default to be based on the largest value for the selected pulse
measurement.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.
Plot (Pulse Statistics display
only)

Specifies the FFT, Trend, Time Trend, or Histogram plot.

Reset Scale Restores all settings to their default values.
xxx
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Prefs Tab
The Prefs tab enables you to change parameters of the measurement display. The parameters available on
the Prefs tab vary depending on the selected display.

Settings on the Pulsed RF Displays Prefs Tab
The following table describes the settings that appear on the Prefs tab of the Pulsed RF displays: Pulse
Statistics and Pulse Trace. There is no Prefs tab for the Pulse Table display.

Setting Description
Show graticule Displays or hides the graticule in the trace display.
Show Marker readout in
graph

When a marker is enabled, this setting displays or hides the maker readout, but not the maker
itself, on Time Trend plots.

Histogram readout
(present only when
Histogram is the selected
plot type)

Controls the parameters Histogram readout and Bins. Histogram readout can be set to either
Count or %. Count indicates the number of hits that fell into each bin. % indicates percentage
of the total count (for the acquisition) that fell into each bin.

Bins Specifies how many "bins" or histogram bars the results are distributed into.
xxx
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GP Digital Modulation Overview

Overview
The displays in the General Purpose (GP) Digital Modulation folder (Displays > Folders > GP Digital
Modulation) are:

Constellation

Demod I & Q vs Time

EVM vs Time

Eye Diagram

Frequency Deviation vs Time

Magnitude Error vs Time

Phase Error vs Time

Signal Quality

Symbol Table

Trellis Diagram

The General Purpose Digital Modulation Analysis (Option 21) provides vector signal analyzer
functionality. A wide variety of modulation types are supported, allowing you to view your signals in
Constellation, Eye and Trellis diagrams, measure the quality of the modulation, display time-domain
waveforms for demodulated I & Q signals, EVM, Phase Error, Magnitude Error, and more.

Modulation Measurements

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).
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Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and can be reported in units of percent or dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Magnitude Error The RMS magnitude difference between the measured signal and the ideal reference

signal.
IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates

the magnitude of the carrier feed-through signal.
Gain Imbalance The gain difference between the I and Q channels in the signal generation path.

Constellations with gain imbalance show a pattern with a width that is different from
height.

Rho ρ The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the analyzer.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Constellations with quadrature error will show some leakage of
I into Q and vice versa.

xxx
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Constellation Display
The Constellation Display shows a digitally-modulated signal in constellation form.

To show the Constellation Display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Constellation icon in the Available Displays box. This adds the Constellation icon
to the Selected displays box.

4. Click the OK button. This shows the Constellation display.

Elements of the Constellation Display
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Item Display element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Constellation display is the optimized display.
2 Marker Readout Located to the left of the constellation plot or below it, depending on the size of

the window. If markers are enabled, the marker readout shows the time, mag,
phase, symbol marker and symbol value of the point with the selected marker.

3 EVM Readouts The EVM readouts are located below the Constellation plot. The readout
shows EVM Peak (%) and location, RMS (%).

4 Plot Constellation graph.
xxx

Changing Constellation Settings (see page 145)

Constellation Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings.

The settings for the Constellation view are shown in the following table.

NOTE. You might be able to save time configuring the Constellation display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 175)

Settings tab Description
Modulation Params (see
page 175)

Specifies the type of modulation, symbol rate, and filters to be used in demodulating
the input signal.

Freq & BW (see page 180) Sets values for frequency error/offset, measurement bandwidth, and frequency deviation
(not every control is present for every modulation type).

Advanced Params (see
page 181)

Specifies additional parameters that are less frequently used.

Find (see page 184) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 184) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 186) Allows you to set the trace display characteristics.
Prefs (see page 188) Enables you to set characteristics of the measurement display.
xxx
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GP Digital Modulation > Demod I & Q vs Time Demod I & Q vs Time Display

Demod I & Q vs Time Display
The Demod I & Q vs Time displays demodulated I and Q vs. Time. You can choose to display I only,
Q only, or both.

Elements of the Display
To show the Demod I & Q vs Time display:

1. Select the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Demod I&Q vs Time icon in the Available Displays box. This adds the Demod
I&Q vs Time icon to the Selected displays box.

4. Click the OK button. This shows the Demod I&Q vs Time display.
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Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Demod I & Q vs Time display is the optimized display.
2 Top of Graph Sets the I and Q amplitude value indicated at the top of the graph. Changing

the top value affects the bottom of graph readout. Also, note that the top of
graph setting interacts with the internal vertical scale setting (which is not
user settable) such that the range between the top and bottom of the graph
increases or decreases automatically.

3 Position Specifies the I and Q amplitude value shown at the center of the graph display.
4 Bottom Readout Displays the I and Q amplitude value shown at the bottom of graph.
5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
6 Position Specifies the horizontal position of the trace on the graph display.
7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the

graph essentially becomes a window that you can move over the acquisition
record by adjusting the offset.

8 Freq Error This readout can show Freq Error or Freq Offset. When it displays Freq
Error, it shows the difference between the instrument Frequency setting and
the measured value of the signal’s carrier frequency. When it displays Freq
Offset, it shows the frequency offset specified on the Settings > Freq & BW
(see page 180) tab. If Freq Error is displayed, it also indicates that the Carrier
frequency detection setting is Auto. If Freq Offset is displayed, it indicates
that the Carrier frequency detection setting is manual.

xxx

Changing Demod I&Q Settings. (see page 148)
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GP Digital Modulation > Demod I & Q vs Time Demod I & Q vs Time Settings

Demod I & Q vs Time Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings.

The settings for the Demod I & Q vs Time display are shown in the following table.

NOTE. You might be able to save time configuring the Demod I & Q display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 175)

Settings tab Description
Modulation Params (see
page 175)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 180) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 181)

Specifies additional parameters.

Find (see page 184) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 184) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 186) Allows you to set the trace display characteristics.
Scale (see page 187) Specifies the horizontal and vertical scale settings.
Prefs (see page 188) Enables you to set characteristics of the measurement display.
xxx
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EVM vs Time Display
The EVM vs. Time Display shows the Error Vector Magnitude plotted over Time.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).

To show an EVM vs. Time display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the EVM vs. Time icon in the Available Displays box. This adds the EVM vs. Time
icon to the Selected displays box.

4. Click the OK button. This displays the EVM vs. Time view.

Elements of the EVM vs Time Display
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GP Digital Modulation > EVM vs Time EVM vs Time Settings

Item Display element Description
1 Top of graph adjustment Use the knob to adjust the vertical scale.
2 Position Adjusts the vertical position.
3 Autoscale Adjusts the Horizontal and Vertical scale to show the entire trace.
4 Peak and RMS value readout Shows the maximum result, the time it occurred, and the RMS of the result

over the entire analysis length.
5 Scale Sets the length of time shown in the graph.
xxx

Changing the EVM vs Time Display Settings (see page 150)

EVM vs Time Settings
Menu Bar: Setup > Settings

The settings for the EVM vs. Time display are shown in the following table.

NOTE. You might be able to save time configuring the EVM vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 175)

Settings tab Description
Modulation Params (see
page 175)

Specifies the type of modulation used in the input signal and other parameters that
controls the demodulation of the input signal.

Freq & BW (see page 180) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 181)

Specifies Freq Offset, Magnitude normalization parameters, and enables swapping
I and Q.

Find (see page 184) The Find tab is used to set parameters for finding bursts within the data record.
Analysis Time (see page 184) The Analysis Time tab contains parameters that define how the signal is analyzed in the

general purpose digital modulation displays.
Trace (see page 186) Specifies the display characteristics of the displayed trace.
Scale (see page 187) Specifies the horizontal and vertical scale settings.
Prefs (see page 188) Specifies whether certain display elements are visible.
xxx
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Eye Diagram Display
The Eye Diagram Display shows a digitally modulated signal overlapped on itself to reveal variations in
the signal.

To show an Eye Diagram display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Eye Diagram icon in the Available Displays box. This adds the Eye Diagram icon
to the Selected displays box.

4. Click the OK button. This displays the Eye Diagram view.

Elements of the Display
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Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Frequency Deviation vs Time display is the optimized display.
2 Top of Graph The vertical scale is normalized with no units (except for nFSK and C4FM

modulation types where the vertical units are Hz).
3 Position Specifies the value shown at the center of the graph display.
4 Bottom Readout Displays the value indicated by the bottom of graph.
5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
6 Position Displays the horizontal position of the trace on the graph display.
7 Scale Adjusts the span of the graph in symbols.
8 Freq Error Displays the difference between the maximum and minimum measured

values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).

xxx

Changing Eye Diagram Settings (see page 153)
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GP Digital Modulation > Eye Diagram Eye Diagram Settings

Eye Diagram Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings.

The settings for the Eye Diagram display are shown in the following table.

NOTE. You might be able to save time configuring the Eye Diagram display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 175)

Settings tab Description
Modulation Params (see
page 175)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 180) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 181)

Specifies additional parameters.

Find (see page 184) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 184) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 186) Allows you to set the trace display characteristics.
Scale (see page 187) Specifies the horizontal and vertical scale settings.
Prefs (see page 188) Enables you to set characteristics of the measurement display.
xxx
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GP Digital Modulation > Frequency Deviation vs Time Frequency Deviation vs Time Display

Frequency Deviation vs Time Display
The Frequency Deviation vs Time display

To show a Frequency Deviation vs Time display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select Frequency Deviation vs Time.

3. Double-click the Frequency Deviation vs Time icon in the Available Displays box. This adds the
Frequency Deviation vs Time icon to the Selected displays box.

4. Click the OK button. This displays the Frequency Deviation vs Time view.

Elements of the Display
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Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Frequency Deviation vs Time display is the optimized display.
2 Top of Graph Sets the frequency deviation value indicated at the top of the graph. Changing

the top value affects the bottom of graph readout. Also, note that the top of
graph setting interacts with the internal vertical scale setting (which is not
user settable) such that the range between the top and bottom of the graph
increases or decreases automatically.

3 Position Specifies the frequency deviation value shown at the center of the graph
display.

4 Bottom Readout Displays the value of the frequency deviation value shown at the bottom
of graph.

5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
6 Position Specifies the horizontal position of the trace on the graph display.
7 Scale Adjusts the span of the graph. By decreasing the scale (time per division), the

graph essentially becomes a window that you can move over the acquisition
record by adjusting the offset.

8 Freq Error Displays the difference between the maximum and minimum measured
values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).

xxx

Changing Frequency Deviation vs Time Settings (see page 156)
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GP Digital Modulation > Frequency Deviation vs Time Frequency Deviation vs Time Settings

Frequency Deviation vs Time Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Setup settings for Frequency Deviation vs. Time are shown in the following table.

NOTE. You might be able to save time configuring the Frequency vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 175)

Settings tab Description
Modulation Params (see
page 175)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 180) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 181)

Specifies additional parameters.

Find (see page 184) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 184) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 186) Allows you to set the trace display characteristics.
Scale (see page 187) Specifies the horizontal and vertical scale settings.
Prefs (see page 188) Enables you to set characteristics of the measurement display.
xxx
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Magnitude Error vs Time Display
The Magnitude Error displays the magnitude of the symbol error. The amplitude appears on the vertical
axis while time is plotted along the horizontal axis.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).

To display Magnitude Error vs. Time:

1. Select the Displays button or Setup > Displays. This displays the Select Displays dialog box.

2. Select GP Digital Modulation in the Folders box.

3. Double-click theMag Error vs. Time icon or select the icon and click Add. The icon will appear in
the Selected displays box and will no longer appear under Available displays.

4. Click OK.

Elements of the Display
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Item Display element Description
1 Top of graph adjustment Use the knob to adjust the value of the vertical scale.
2 Position Adjusts the level shown at the bottom of the display.
3 Autoscale button Adjusts the vertical and horizontal settings to provide the best display.
4 Horizontal Position Adjusts the horizontal position of the signal. Units can be either Symbols or

Seconds (Settings > Analysis Time tab > Units).
5 Peak and RMS value readout Displays the Peak value of the magnitude error, the RMS value of the

magnitude error, and the time at which it occurs within the acquisition. Units
can be either Symbols or Seconds (Settings > Analysis Time tab > Units).

6 Horizontal Scale Sets the time spanned by the graph. Units can be either Symbols or Seconds
(Settings > Analysis Time tab > Units).

7 Freq Error Freq Error is the difference between the Center Frequency and the measured
frequency of the signal being tested. This readout will be Freq Offset if the
Freq Offset parameter on the Settings > Advanced Params (see page 181)
tab is set to Manual.

xxx

Changing Magnitude Error vs Time Display Settings (see page 159)
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Magnitude Error vs Time Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Setup settings for Magnitude Errors vs. Time are shown in the following table.

NOTE. You might be able to save time configuring the Magnitude vs. Time display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 175)

Settings tab Description
Modulation Params (see
page 175)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 180) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 181)

Specifies additional parameters.

Find (see page 184) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 184) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 186) Allows you to set the trace display characteristics.
Scale (see page 187) Specifies the horizontal and vertical scale settings.
Prefs (see page 188) Enables you to set characteristics of the measurement display.
xxx
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Phase Error vs Time Display
The Phase Error vs. Time display shows the phase angle of the symbol error over time. The phase is
plotted along the vertical axis while time is plotted along the horizontal axis.

NOTE. A maximum of approximately 80,000 samples can be analyzed by the General Purpose Digital
Modulation measurements (the actual value varies with modulation type).

To show the Phase Error display:

1. Press the Displays button or select Setup > Displays.

2. In the Select Displays dialog, select GP Digital Modulation in the Folders box.

3. In the Available displays box, double-click the Phase Error icon or select the icon and click Add.
The Phase Error icon will appear in the Selected displays box and will no longer appear under
Available displays.

4. Click OK to display the Phase Error.

Elements of the Phase Error vs Time Display
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Item Display element Description
1 Freq Error Freq Error is the difference between the Center Frequency and the measured

frequency of the signal being tested. This readout will be Freq Offset if the
Freq Offset parameter on the Settings > Advanced Params (see page 181)
tab is set to Manual.

2 Top of graph adjustment Adjusts the phase angle shown at the top of the graph.
3 Position Adjusts the vertical offset.
4 Autoscale Adjusts the vertical and horizontal settings so that the entire trace fits in the

graph.
5 Offset Adjusts the horizontal offset.
6 Peak and RMS readouts Displays the Peak value of the phase error and the time at which it occurred.

Also displays the RMS value over the analysis length.
7 Scale Sets the time spanned by the graph.
xxx

Changing the Phase Error vs Time Display Settings (see page 162)

SignalVu™ Vector Signal Analysis Software Printable Online Help 161



GP Digital Modulation > Phase Error vs Time Phase Error vs. Time Settings

Phase Error vs. Time Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The settings for the Phase Error vs. Time display are shown in the following table.

NOTE. You might be able to save time configuring the Phase Error vs. Time display by pressing the
Standard Settings button from the Settings control panel. This allows you to select a preset optimized for a
standard from the Select Standard dialog box. See Standard Settings Button. (see page 175)

Settings tab Description
Modulation Params (see
page 175)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 180) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 181)

Specifies additional parameters.

Find (see page 184) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 184) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 186) Allows you to set the trace display characteristics.
Scale (see page 187) Specifies the horizontal and vertical scale settings.
Prefs (see page 188) Enables you to set characteristics of the measurement display.
xxx

162 SignalVu™ Vector Signal Analysis Software Printable Online Help



GP Digital Modulation > Signal Quality Signal Quality Display

Signal Quality Display
The Signal Quality display shows several measurements of signal quality. The measurements displayed
depend on the modulation type. There is a set of measurements displayed for all modulation types except
nFSK and C4FM. There is a second set of measurements displayed for nFSK and C4FM modulation types.

Signal Quality display for all modulation types except nFSK, C4FM, OQPSK, and SOQPSK

Signal Quality display for OQPSK and SOQPSK modulation types
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Signal Quality display for nFSK modulation type

Signal Quality display for C4FM modulation type
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Elements of the Display

Measurements for all modulation types except nFSK, C4FM, OQPSK and SOQPSK
Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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Measurements for OQPSK and SOQPSK modulation types
Measurement Description
EVM The normalized RMS value of the error vector between the measured signal and the ideal

reference signal over the analysis length. The EVM is generally measured on symbol or
chip instants and is reported in units of percent and dB. EVM is usually measured after
best-fit estimates of the frequency error and a fixed phase offset have been removed.
These estimates are made over the analysis length. Displays RMS and Peak values with
location of Peak value.

Offset EVM Offset EVM is like EVM except for a difference in the time alignment of the I and Q
samples. For EVM, I and Q samples are collected at the same time, for every symbol
decision point (twice the symbol rate for offset modulations). For Offset EVM, the I and Q
symbol decision points are time-aligned before collecting the I and Q samples. In this
case, one I and one Q sample is collected for each symbol (half as many samples as the
same number of symbols for (non-offset) EVM.

Phase Error The RMS phase difference between the measured signal and the ideal reference signal.
Displays RMS and Peak values with location of Peak value.

Mag Error The RMS magnitude difference between the measured signal and the reference signal
magnitude. Displays RMS and Peak values with location of Peak value.

MER (RMS) The MER is defined as the ratio of I/Q signal power to I/Q noise power; the result is
indicated in dB.

IQ Origin Offset The magnitude of the DC offset of the signal measured at the symbol times. It indicates
the magnitude of the carrier feed-through signal.

Frequency Error The frequency difference between the measured carrier frequency of the signal and the
user-selected center frequency of the instrument.

Gain Imbalance The gain difference between the I and Q channels in the signal generation path.
Constellations with gain imbalance show a pattern with a width that is different form
height.

Quadrature Error The orthogonal error between the I and Q channels. The error shows the phase
difference between I and Q channels away from the ideal 90 degrees expected from the
perfect I/Q modulation. Not valid for BPSK modulation type.

Rho The normalized correlated power of the measured signal and the ideal reference signal.
Like EVM, Rho is a measure of modulation quality. The value of Rho is less than 1 in all
practical cases and is equal to 1 for a perfect signal measured in a perfect receiver.

xxx
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Measurements for nFSK modulation types
Measurement Description
Peak FSK err Peak value of the frequency deviation error at the symbol point.
RMS FSK Err RMS value of the frequency deviation error at the symbol point.
Peak Mag Err The Peak magnitude difference between the measured signal and the reference signal

magnitude.
RMS Mag Err The RMS magnitude difference between the measured signal and the reference signal

magnitude.
Freq Error The frequency difference between the measured carrier frequency of the signal and the

user-selected center frequency of the instrument.
Freq Deviation Frequency distance from the center frequency at the symbol point.
Symbol Rate Error This compares the user-entered symbol rate to the instrument calculated symbol rate of

the analyzed signal.
Symbol Rate When in Auto-symbol rate, the instrument calculates the symbol rate of the signal and

the instrument calculates the error between the user entered value and the instrument
calculated value.

xxx

Measurements for C4FM modulation type
Measurement Description
RMS Error Magnitude RMS value of the frequency deviation error at the symbol point.
Carrier Frequency Error Frequency difference between averaged signal frequency and the center frequency.
Deviation Frequency distance from the center frequency at the symbol point.
Length Number of symbols in the analysis area.
xxx

Changing the Signal Quality Display Settings (see page 168)
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Signal Quality Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Setup settings for Signal Quality are accessible only when the Signal Quality display is selected.

NOTE. You might be able to save time configuring the Signal Quality display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 175)

Settings tab Description
Modulation Params (see
page 175)

The Modulation tab specifies the type of modulation used for the input signal and other
parameters.

Freq & BW (see page 180) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 181)

The Advanced Params tab specifies frequency offset, magnitude normalization method
and allows you to swap the I and Q signals.

Find (see page 184) Find tab is used to set parameters for finding bursts within the data record.
Analysis Time (see page 184) The Analysis Time tab contains parameters that define the portion of the acquisition

record that is used for analysis.
Prefs (see page 188) The Prefs tab enables you to set characteristics of the measurement display.
xxx
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Symbol Table Display
The Symbol Table Display is like the Constellation Display except that a text table is used to display data
bits at a symbol rather than a graph. The Synch Word characters, if used, are in bold font.

To display the Symbol Table:

1. Select the Displays button or select Setup > Displays. This displays the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Symbol Table icon in the Available Displays box. This adds the Symbol Table icon
to the Selected displays box.

4. Click the OK button. This displays the Symbol Table view.

Using Markers
Markers are indicators in the display that you can position on a trace to measure values such as frequency,
power, and time. A Marker always displays its position and, if the Delta readout is enabled, will display
the difference between its position and that of the Marker Reference. Within the Symbol Table, colored
cells indicate the location of markers. The selected Marker is highlighted with a light green background.
All other markers are highlighted with a light gray background. In the Symbol Table, the marker readout
below the table shows the marker location in time, symbol numbers and symbol value.

Changing the Symbol Table Display Settings (see page 170)
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Symbol Table Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings

The Setup settings for the Symbol Table view are shown in the following table.

NOTE. You might be able to save time configuring the Symbol Table display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 175)

Settings tab Description
Modulation Params (see
page 175)

The Modulation tab specifies the type of modulation used for the input signal and other
parameters.

Freq & BW (see page 180) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 181)

The Advanced Params tab specifies additional parameters.

Find (see page 184) Find tab is used to set parameters for finding bursts within the data record.
Analysis Time (see page 184) The Analysis Time tab contains parameters that define the portion of the acquisition

record that is used for analysis.
Prefs (see page 188) The Prefs tab enables you to set characteristics of the measurement display.
xxx
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Trellis Diagram Display
The Trellis Diagram display

To show an Trellis Diagram display:

1. Press the Displays button or select Setup > Displays. This shows the Select Displays dialog box.

2. From the Folders box, select GP Digital Modulation.

3. Double-click the Trellis Diagram icon in the Available Displays box. This adds the Trellis Diagram
icon to the Selected displays box.

4. Click the OK button. This displays the Trellis Diagram view.

Elements of the Display
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Item Element Description
1 Check mark indicator The check mark indicator in the upper, left-hand corner of the display shows

when the Frequency Deviation vs Time display is the optimized display.
2 Top of Graph Sets the phase value indicated at the top of the graph. Changing the top value

affects the bottom of graph readout. Also, note that the top of graph setting
interacts with the internal vertical scale setting (which is not user settable)
such that the range between the top and bottom of the graph increases or
decreases automatically.

3 Position Specifies the phase value shown at the center of the graph display.
4 Bottom Readout Displays the value of the phase value shown at the bottom of graph.
5 Autoscale Adjusts the vertical and horizontal settings to provide the best display.
6 Position Displays the horizontal position of the trace on the graph display.
7 Scale Adjusts the span of the graph in symbols.
8 Freq Error Displays the difference between the maximum and minimum measured

values of the signal frequency during the Measurement Time. The displayed
frequency error is followed by either Auto or Manual. This indicates the
selected carrier frequency detection method (see Settings > Freq & BW).

xxx

Changing the Trellis Diagram Settings (see page 173)
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Trellis Diagram Settings
Menu Bar: Setup > Settings

Application Toolbar: Settings.

The settings for the Trellis Diagram display are shown in the following table.

NOTE. You might be able to save time configuring the Trellis Diagram display by pressing the Standard
Settings button from the Settings control panel. This allows you to select a preset optimized for a standard
from the Select Standard dialog box. See Standard Settings Button. (see page 175)

Settings tab Description
Modulation Params (see
page 175)

Specifies the type of modulation used for the input signal and other parameters.

Freq & BW (see page 180) Specifies settings for frequency error, measurement BW and Frequency Deviation. Each
of these settings is set internally when set to Auto. Alternatively, you can specify values
appropriate for specific measurement needs.

Advanced Params (see
page 181)

Specifies additional parameters.

Find (see page 184) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 184) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 186) Allows you to set the trace display characteristics.
Scale (see page 187) Specifies the horizontal and vertical scale settings.
Prefs (see page 188) Enables you to set characteristics of the measurement display.
xxx
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GP Digital Modulation > Common Controls for GP
Digital Modulation Displays

GP Digital Modulation Shared Measurement
Settings

GP Digital Modulation Shared Measurement Settings
The displays in the GP Digital Modulation folder (Setup > Displays) are each a different format for
presenting the results of a single underlying analysis. For this reason, all controls that affect the analysis
parameters are shared by all the displays in the GP Digital Modulation folder.

Changing a setting on one tab changes that setting for all the GP Digital Modulation displays. For
example, if you change the Modulation Type for the Constellation Display, it also changes the Modulation
type setting for the Signal Quality display. There are some controls that affect only the way an individual
display presents its results, such as graph scaling.

Common Controls for GP Digital Modulation Displays
Settings tab Description
Modulation Params (see
page 175)

Specifies the type of modulation , symbol rate, and filters to be used in demodulating
the input signal.

Freq & BW (see page 180) Sets values for frequency error/offset, measurement bandwidth, and frequency deviation
(not every control is present for every modulation type).

Advanced Params (see
page 181)

Specifies additional parameters that are less frequently used.

Find (see page 184) Used to set parameters for finding a burst within the data record and for entering a
Synch word.

Analysis Time (see page 184) Contains parameters that define the portion of the acquisition record that is used for
analysis. Also allows you to specify the Units (Seconds or Symbols) for the GP Digital
Modulation displays.

Trace (see page 186) Allows you to set the trace display characteristics.
Prefs (see page 188) Enables you to set characteristics of the measurement display.
xxx
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GP Digital Modulation > Common Controls for GP
Digital Modulation Displays

Standard Settings Button

Standard Settings Button
On every GP Digital Modulation control panel there is a button labeled Standard Settings. This button is
used to recall settings optimized for analyzing the selected standard. See the following table for a list of
the standards for which standard settings are available. Choosing a standard from the dialog box changes
only settings for GP Digital Modulation displays.

All of the presets in the Standard Settings Dialog make the following settings:

Analysis Length: Auto

Points per Symbol: 4

Data Differential: No

Burst Mode: Off

Burst Detection Threshold: –10 dBc

Parameter values set by presets in the standard settings dialog
Standard Modula-

tion
Symbol
Rate

Meas.
Filter

Reference
Filter

Filter
Parameter

Other

802.15.4 OQPSK 1e6 None Half sine NA
SBPSK-MIL SBPSK 2.4e3 None SBPSK-

MIL
NA

SOQPSK-MIL SOQPSK 2.4e3 None SOQPSK-
MIL

NA 1

CPM-MIL CPM 19.2e3 None None NA
SOQPSK-ARTM Tier 1 SOQPSK 2.5e6 None SOQPSK-

ARTM
NA 1

Project25 Phase 1 C4FM 4.8e3 C4FM-P25 RC 0.2
CDMA2000–Base QPSK 1.2288e6 IS-95

TXEQ_MEA
IS-95 REF NA

W-CDMA QPSK 3.84e6 RRC RC 0.22
xxx

1 Center Symbol Position, Half Shift Removed

Modulation Params Tab
Menu bar: Setup > Settings > Modulation Params

The Modulation Params tab specifies the type of modulation on the input signal and other parameters
that control the demodulation of the input signal.
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Digital Modulation Displays

Modulation Params Tab

Parameter Description
Modulation type Specifies the type of modulation on the input signal.
Symbol Rate Specifies the symbol rate in Hertz.
Measurement Filter Specifies the filter used for measurements.
Reference Filter Specifies the filter used as a reference.
Filter Parameter Enter a value used for defining the Reference Filter. (Not present for some filter types)
Modulation index (Present only for CPM modulation type)
xxx

Modulation Type
The modulation types that can be demodulated and analyzed are:
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Digital Modulation Displays

Modulation Params Tab

Modulation type Description
QPSK Quadrature Phase Shift Keying
8PSK 8-Phase Shift Keying
D8PSK Differential Eight Phase Shift Keying
PI/2DBPSK Pi/2 Differential Binary Phase Shift Keying
DQPSK Differential Quadrature Phase Shift Keying
PI/4DQPSK Pi/4 Differential Quadrature Phase Shift Keying
BPSK Binary Phase Shift Keying
OQPSK Offset Quadrature Phase Shift Keying
16QAM 16-state Quadrature Amplitude Modulation
32QAM 32-state Quadrature Amplitude Modulation
64QAM 64-state Quadrature Amplitude Modulation
128QAM 128-state Quadrature Amplitude Modulation
256QAM 256-state Quadrature Amplitude Modulation
MSK Minimum Shift Keying
2FSK 2-Frequency Shift Keying
4FSK 4-Frequency Shift Keying
8FSK 8-Frequency Shift Keying
16FSK 16-Frequency Shift Keying
CPM Continuous Phase Modulation
SOQPSK Shaped Offset Quadrature Phase Shift Keying
SBPSK Shaped Binary Phase Shift Keying
C4FM Constant Envelope 4-Level Frequency Modulation
xxx

Symbol Rate
Specifies the symbol rate for demodulating digitally modulated signals. The symbol rate and the bit rate
are related as follows:

(Symbol rate) = (Bit rate)/(Number of bits per symbol)

For example, the number of bits per symbol is 3 for 8PSK.

Measurement and Reference Filters
The available measurement and reference filters depend on the selected modulation type. If a particular
filter is not practical for a selected modulation type, it is not presented as an available filter. To determine
which filters are available, make certain that your desired modulation type is selected. See the following
table.
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Digital Modulation Displays

Modulation Params Tab

Modulation type Measurement filters Reference filters
BPSK
PI/2DBPSK
8PSK
D8PSK
DQPSK
PI/4DQPSK
16QAM
32QAM
64QAM
128QAM
256QAM
QPSK

None
RootRaisedCosine
RaisedCosine
Gaussian
User
Rectangular (freq)
IS-95TX_MEA
IS-95TXEQ_MEA

None
RaisedCosine
Gaussian
User
Rectangular (freq)
IS-95REF

MSK None
Root Raised Cosine
RaisedCosine
Gaussian
User
Rectangular (freq)

None
Gaussian
User

OQPSK None
RootRaisedCosine
User
IS-95TX_MEA
IS-95TXEQ_MEA

None
Half sine
RaisedCosine
User
IS-95REF

SOQPSK None
User

SOQPSK-MIL
SOQPSK-ARTM
User

CPM None
User

None
User

2FSK
4FSK
8FSK
16FSK

None
Gaussian
RootRaisedCosine
RaisedCosine
Rectangular (freq)
User

None
Gaussian
RaisedCosine
User

C4FM C4FM-P25 RaisedCosine
User

SBPSK None
User

SBPSK-MIL
User

xxx
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Modulation Params Tab

The measurement filter is applied before the demodulation bit is detected and the ideal reference is
calculated.

The reference filter is applied to the internally generated ideal reference signal before the EVM is
calculated.

Filter Parameter
The filter parameter specifies the alpha for the Root Raised Cosine or Raised Cosine filter, or the
bandwidth-time product (BT) for the Gaussian filter, when selected as the Reference filter. Some filter
types have a fixed parameter value that is specified by industry standard, while other filter types by
definition have no filter parameter. For filter types with no filter parameter, there is no filter parameter
control present in the control panel.
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Freq & BW Tab

Freq & BW Tab
The Freq & BW tab specifies a group of settings that affect how measurements are made.

Freq & BW tab with nFSK or C4FM modulation type selected and Frequency Error readout enabled (Auto selected)

Freq & BW tab with SOQPSK modulation type selected and Frequency Offset enabled (Auto deselected)

Setting Description
Frequency Error / Frequency
Offset

When Auto is enabled, this readout displays frequency error and the measurement
is made at the calculated frequency. When Auto is disabled, this setting changes to
Frequency Offset. When set to Frequency Offset, this setting is used to demodulate a
signal that is not at the center frequency. The measurement is made at the user-entered
offset. The Measurement Filter (if any, specified on the Modulation Params tab) is applied
about the offset frequency whether set automatically or manually.

Measurement BW This setting allows you to override the automatic bandwidth calculation and directly enter
a bandwidth value. If you enter a value for the measurement bandwidth, be aware that
the actual bandwidth of data provided to the measurement will be at least as wide as
the value you request and may be as much as two times wider than requested. This
override of the selected measurement bandwidth is done so that the instrument uses
sufficient bandwidth relative to the chosen symbol rate to ensure good signal quality
measurements.

Frequency Deviation For nFSK modulation types, this setting specifies the frequency deviation. Select Auto to
make the instrument do this automatically. Deselect Auto to enter a value manually.
This setting is present for only nFSK and C4FM modulation types.

xxx
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Advanced Params Tab

Advanced Params Tab
The Advanced Params tab specifies additional parameters that control the demodulation of the signal.

Advanced Params tab for all modulation types except nFSK and C4FM

Advanced Params tab for modulation type nFSK

Advanced Params tab for modulation type C4FM
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Advanced Params Tab

Parameter Description
Mag Normalize
(not present for nFSK or C4FM
modulation types)

Select RMS Symbol Magnitude or Max Symbol Magnitude. This setting applies to Mag
Error and EVM.

Swap I and Q When enabled, the I and Q data are exchanged before demodulating.
Symbol rate search
(Present only for nFSK
modulation types)

Determines whether to automatically detect or manually set the symbol rate. When
selected, automatically detects the symbol rate to perform analysis. The calculated
symbol rate is displayed in the Signal Quality display. The Symbol Rate Error is also
calculated and displayed when Symbol rate search is enabled.

User Symbol Map (per
Modulation Type)

Enables the use of custom symbol maps. This enables you to specify the location of
symbols in the display. This control can be set independently for each of the modulation
types.

xxx

Mag Normalize
Specifies whether Magnitude Normalization uses the RMS Symbol Magnitude or the Maximum Symbol
Magnitude as the basis for normalization. Use RMS Symbol Magnitude on QPSK modulations (equal
magnitude symbol locations), and use Maximum Symbol Magnitude for signals that have a large difference
in magnitude among the symbol locations (such as 128QAM). It prevents the instrument from using the
very low magnitude center symbols when normalizing the constellation. The outer symbols are a better
normalization reference than the center in this case.

Swap I and Q
Use the Swap I and Q control to correct a signal sourced by a downconverter that inverts the frequency
of the signal under test.

User Symbol Map
A User Symbol Map is a text file that specifies the location of symbols in the display. The symbol map
is unique for each modulation type. The easiest way to create a custom symbol map is to start with
the default symbol map and modify it. The default symbol map file is located at C:\RSA6100A Files.
The default symbol map file is named DefaultSymbolMaps.txt. See Symbol Maps (see page 189) for
illustrations of the default symbol mapping.

To specify a user symbol map:

1. Click the ... button.

2. Navigate to the directory containing the user symbol text file you want to use.

3. Select the desired file in the Open window and click Open.

4. Select User Symbol Map to enable the user symbol map.

Editing the User Symbol Map. The symbol map is a plain text file and can be edited with any plain text
editor.
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Digital Modulation Displays

Advanced Params Tab

CAUTION. Whenever you reinstall the program software, the existing DefaultSymbolMaps.txt file will be
overwritten. To create a custom symbol map, you should make a copy of the default symbol map file, edit
the copy to suit your needs, and save it with a new name. Guidance on how to edit the symbol map file
is contained within the default symbol map file.

The following excerpt from the default symbol map file explains the structure of the file and how to edit it.
## Symbol Mapping Definitions

## Version 1.2

## This file defines the mapping of modulation states to symbol values.

##

## File Format :

## -------------

## 1. Comments begin with ’##’ and may appear after the last field in a line

## 2. A symbol map begins and ends with a line containing the name of the

## modulation type. These names must exactly match the name of one of the

## modulation types in the RSA software

## 3. Empty cells may be included to preserve the constellation shape.

## 4. Blank lines are ignored.

## 5. A modulation type which does not match the name of an existing

## type will be ignored.

##

## Usage :

## -------

## 1. The file is intended to be edited with Notepad or similar text editor

The following text is an example of a symbol map.
## Symbol Map for 32 QAM

## (Resembles the shape of the constellation)

32QAM

00011 00010 00001 00000

01001 01000 00111 00110 00101 00100

01111 01110 01101 01100 01011 01010

10101 10100 10011 10010 10001 10000

11011 11010 11001 11000 10111 10110

11111 11110 11101 11100

32QAM
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Find Tab

Find Tab
The Find tab is used to set parameters for finding bursts within the data record. This is a post-acquisition
operation. Synch Word search controls are also on this tab.

Setting Description
Burst Detection: Mode Select whether to analyze bursts

- Auto: If a burst is found, analyze just that burst period. If a burst is not found, analyze
the whole analysis length.
- On: If a burst is found, analyze just that burst period. If a burst is not found, display
an error message.
- Off: Analyze the whole analysis length.
If the signal isn’t adequate for demodulation, an error message is shown.

Burst Detection: Threshold Sets the level required for the signal to qualify as a burst. Enter a value in dBc down
from top of the signal.

Use Synch Word When enabled, specifies the string of symbols to look for. Enter the search string with
external keyboard or the on-screen keyboard.

Clear Blanks the search string field.
xxx

Analysis Time Tab
The Analysis Time tab contains parameters that define how the signal is analyzed in the general purpose
digital modulation displays.
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Digital Modulation Displays

Analysis Time Tab

The settings values on this tab are the same as those on the main Analysis control panel for the instrument
with the only difference being that Analysis Length can be set in either Seconds or Symbols in this location.

Setting Description
Analysis Offset Specifies the location of the first time sample to use in measurements.
Auto When enabled, causes the instrument to set the Analysis Offset value based on the

requirements of the selected display.
Analysis Length Specifies the length of the analysis period to use in measurements. Length is specified in

either seconds or symbols, depending on the Units setting. For most modulation types,
the Analysis Length set when Auto is enabled is 128 symbols. For some modulation
types, a longer length is used.

Auto When enabled, causes the instrument to set the Analysis Length value based on the
requirements of the selected display.

Time Zero Reference Specifies the zero point for the analysis time.
Actual This is a displayed value, not a setting. It is the Analysis Length (time or symbols)

being used by the analyzer; this value may not match the Analysis Length requested
(in manual mode).

Units Sets the units of the Analysis Length to either Symbols or Seconds.
xxx

Analysis Offset
Use analysis offset to specify where measurements begin. Be aware that you cannot set the Analysis
Offset outside the range of time covered by the current acquisition data. (all time values are relative
to the Time Zero Reference).

You can set the Analysis Length so that the requested analysis period falls partly or entirely outside the
current range of acquisition data settings. When the next acquisition is taken, its Acquisition Length will
be increased to cover the new Analysis Length, as long as the Sampling controls are set to Auto. If the
Sampling parameters are set to manual, or if the instrument is analyzing saved data, the actual analysis
length will be constrained by the available data length, but in most cases, measurements are able to be
made anyway. The instrument will display a notification when measurement results are computed from
less data than requested. Range: 0 to [(end of acquisition) - Analysis Length)]. Resolution: 1 effective
sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed by a measurement. As you adjust
this value, the actual amount of time for Analysis Length, in Symbol or Seconds units, is shown below the
control in the "Actual" readout. This setting is not available when Auto is checked. Range: minimum
value depends on modulation type. Resolution: 1 symbol. A maximum of approximately 80,000 samples
can be analyzed (the actual value varies with modulation type).

Time Zero Reference
All time values are measured from this point (such as marker position or horizontal position (in Y vs Time
displays). Choices are: Acquisition Start or Trigger.
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Trace Tab

Parameter Description
Acquisition Start Offset is measured from the point at which acquisition begins.
Trigger Offset is measured from the trigger point.
xxx

Trace Tab
Menu Bar: Setup > Settings > Trace

Application Toolbar/Front Panel: Settings

The Trace tab allows you to set the trace display characteristics of the selected display.

Example trace tab for constellation display

Note that some settings are not present for all modulation types and some settings are not present for
all displays.

Example trace tab for constellation display set to CPM modulation type

Example trace tab for Demod I&Q display
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Digital Modulation Displays

Scale Tab

Setting Description
Content Selects whether to draw lines (vectors) between constellation points in the display.

Present for the Constellation display only.
Trace Selects the trace that is hidden or displayed based on whether or not Show is selected.
Show Specifies whether the trace selected by Trace is displayed or hidden.
Points per Symbol Select how many points to use between symbols when connecting the dots. Values:

1, 2, 4, 8.
Remove Q offset The I and Q data traces are normally displayed with an offset of half a symbol. When the

modulation type is set to SOQPSK or OQPSK, you can remove this offset by selecting
Remove Q offset. Present for Constellation, Demod I&Q, and Eye Diagram displays only.

Symbol point location Selects whether to evaluate the symbol value at the center or the end of the eye opening.
This control is only present for some of the supported modulation types.

Phase Multiplier Sets the multiplication constant for the phase multiplication display: ×1 (default), ×2, ×4,
×8, ×16, or ×32. The phase multiplication display facilitates observation of noisy CPM
signals by multiplying measurement signal phase by the constant to reduce the number
of phase states and expand the phase difference between adjacent symbols.

xxx

Scale Tab
The Scale tab allows you to change the vertical and horizontal scale settings. Changing the scale settings
changes how the trace appears on the display but does not change control settings such as Measurement
Frequency.
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Prefs Tab

Setting Description
Vertical Controls the vertical position and scale of the trace display.

Scale Changes the vertical scale units.
Position Position adjusts the reference level away from top of the graph.
Autoscale Resets the scale of the vertical axis to contain the complete trace.

Horizontal Controls the span of the trace display and position of the trace.
Scale Allows you to, in effect, change the span.
Position Allows you to pan a zoomed trace without changing the Measurement Frequency.

Position is only enabled when the span, as specified by Freq/div, is less than the
acquisition bandwidth.

Autoscale Resets the scale of the horizontal axis to contain the complete trace.
xxx

A Note About Units
The Units used for the horizontal scale can be either Seconds or Symbols. To set the units for the horizontal
scale, display the Analysis Time tab. On the tab, select the appropriate units from theUnits drop-down list.

Prefs Tab
The Prefs tab enables you to change appearance characteristics of the GP Digital Modulation displays.

Setting Description
Show graticule Shows or hides the graticule.
Show Marker readout in graph
(selected marker)

Shows or hides the readout for the selected marker in the graph area.

Radix Specifies how symbols are displayed in the Symbol Table display and in the Marker
readout in the Constellation display.

xxx
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Symbol Maps
This topic shows the symbol mapping for each digital modulation technique.

D8PSK
Phase shift
(radians)

Symbol value
(binary)

0 000
π/4 001
π/2 011
3π/4 010
π 110
5π/4 111
3π/2 101
7π/4 100
xxx
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Pi/2 DBPSK
Phase shift
(radians)

Symbol value
(binary)

+π/2 0
–π/2 1
xxx

DQPSK
Phase shift
(radians)

Symbol value
(binary)

0 00
π/2 01
π 11
3π/2 10
xxx

Pi/4 DQPSK
Phase shift
(radians)

Symbol value
(binary)

+π/4 00
+3π/4 01
–π/4 10
-3π/4 11
xxx

MSK
Phase shift
direction

Symbol value
(binary)

– 0
+ 1
xxx
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CPM
Phase shift
(h = modulation index)

Symbol value
(binary)

–3h 11
–h 10
+h 01
+3h 00
xxx
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Overview: User Defined Measurement and Reference Filters
The Modulation Parameters control tab for GP Digital Modulation displays enables you to load custom
measurement and reference filters. If the existing filters do not meet your requirements, you can create
your own filters for use in the measurement and reference settings. This section describes the structure of
user filters and provides two examples of customized filters. See User Filter File Format (see page 195).

Loading a User Measurement Filter
To load a your own measurement filter:

1. From the Modulation Params control tab (Settings > Modulation Params), click on the drop-down
list for Measurement Filter.

2. Select one of the filter names that starts with User. This displays theManage user filters window.

3. Enter a name for the filter in one of the Name (editable) boxes. This name will appear in the
drop-down list on the Modulation Params tab, prefaced with User. The maximum number of
characters for the filter name is 20.

4. Click the Browse... button and navigate to the directory containing the filter you want to load. Select
the filter and click Open. If you wish to use a filter that is not in the list, select User other and
locate and open the file you wish to use.

5. Click OK to load the filter and return to the Modulation Params page.

User Filter File Format
The filter file is selected on the Modulation Params control panel tab used by the GP Digital Modulation
displays (Option 21 only). It stores the user-defined measurement or reference filter coefficient data in
CSV format. The following figure shows the file structure.
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User filter file structure

A filter file is a plain text file, in comma-separated-variable format. The file extension must be CSV.

The filter file contains the following variables:

Rate. Specifies the oversampling rate (the number of samples per symbol). The filter coefficient data will
be interpolated by the specified rate.

FilterI,FilterQ. Specifies IQ pairs (1 to 1024) of the filter coefficient in time domain.

Rules for Creating a Filter File
A line beginning with “#” is a comment line.

Enter a positive value for the oversampling rate.

A decimal number can be expressed by fixed point or floating point. For example, 0.01 and 1.0E-2 are
both valid.

“0” (zero) and “,0” (comma zero) can be omitted. For example, “1.5,0”, “1.5,”, and “1.5” are
equivalent.

Lines with only a comma and blank lines are skipped.

Example filters. For your reference, two example filters, Raised Cosine and Gaussian, are shown here.
Both filters contain 65 data points with an oversampling rate of 8.
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Raised Cosine (α = 0.3)
(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)
# Rate 0.0383599,0 0.973215,0 0.0743803,0
8 0,0 0.895591,0 0.0720253,0
# FilterI,FilterQ -0.047715,0 0.774975,0 0.0594205,0
0,0 -0.0984502,0 0.623332,0 0.0405144,0
-0.0062255,0 -0.143898,0 0.455249,0 0.0194761,0
-0.0136498,0 -0.174718,0 0.286147,0 0,0
-0.0209294,0 -0.181776,0 0.130455,0 -0.0151973,0
-0.0263419,0 -0.157502,0 0,0 -0.0246357,0
-0.0280807,0 -0.0971877,0 -0.0971877,0 -0.0280807,0
-0.0246357,0 0,0 -0.157502,0 -0.0263419,0
-0.0151973,0 0.130455,0 -0.181776,0 -0.0209294,0
0,0 0.286147,0 -0.174718,0 -0.0136498,0
0.0194761,0 0.455249,0 -0.143898,0 -0.0062255,0
0.0405144,0 0.623332,0 -0.0984502,0 0,0
0.0594205,0 0.774975,0 -0.047715,0
0.0720253,0 0.895591,0 0,0
0.0743803,0 0.973215,0 0.0383599,0
0.063548,0 1,0 0.063548,0
xxx
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Gaussian (BT = 0.5)
(Row 1 to 18) (Row 19 to 36) (Row 37 to 54) (Row 55 to 68)
# Rate 0.00191127,0 0.978572,0 0.000401796,0
8 0.00390625,0 0.917004,0 0.000172633,0
# FilterI,FilterQ 0.00764509,0 0.822878,0 7.10E--05,0
2.33E-10,0 0.0143282,0 0.707107,0 2.80E-05,0
9.11E-10,0 0.0257149,0 0.581862,0 1.06E-05,0
3.42E-09,0 0.0441942,0 0.458502,0 3.81E-06,0
1.23E--08,0 0.0727328,0 0.345977,0 1.32E-06,0
4.21E-08,0 0.114626,0 0.25,0 4.37E-07,0
1.39E-07,0 0.172989,0 0.172989,0 1.39E-07,0
4.37E-07,0 0.25,0 0.114626,0 4.21E-08,0
1.32E-06,0 0.345977,0 0.0727328,0 1.23E-08,0
3.81E-06,0 0.458502,0 0.0441942,0 3.42E-09,0
1.06E-05,0 0.581862,0 0.0257149,0 9.11E-10,0
2.80E-05,0 0.707107,0 0.0143282,0 2.33E-10,0
7.10E-05,0 0.822878,0 0.00764509,0
0.000172633,0 0.917004,0 0.00390625,0
0.000401796,0 0.978572,0 0.00191127,0
0.000895512,0 1,0 0.000895512,0
xxx
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Using Markers
Markers are indicators in the display that you can position on a trace to measure values for the X and Y
axes, such as frequency, power, and time. A Marker always displays its position and, if enabled, will
display the difference between its position and that of the Marker Reference (MR).

You can display up to five markers including the marker reference. Markers can all be placed on the
same trace or they can be placed on different traces. There are two types of Markers: Reference and
Delta Markers. The Marker Reference (labeled MR in the graph) makes absolute measurements and is
also used for calculating differences when Delta readouts are enabled. The Delta Markers (labeled M1
to M4 in the graph) are used to measure other points on the trace or the difference between the Marker
Reference and the Delta marker.

The following table shows the appearance of the three types of marker readouts.

Marker Reference Readout Absolute Marker Readout Delta Marker Readout

xxx

The following table shows the appearance of the marker indicators as they appear on the trace.

Marker Reference Absolute Marker Delta Marker

xxx

Controlling Markers with the Touchscreen Actions Menu
In addition to controlling the marker actions from the front panel or screen menu items, you can use the
touch screen actions menu to move markers or add and delete markers.
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Menu

To use the Touchscreen Actions menu, touch the display and hold for one second, then remove your finger.
You can also use a mouse to display the Touchscreen Action menu by clicking the right mouse button.

Menu item Description
Marker to peak Moves the selected marker to the highest peak. If no marker is turned on, this control

automatically adds a marker.
Next Peak Moves the selected marker to the next peak. Choices are Next left, Next right, Next

lower (absolute), and Next higher (absolute).
Add marker Defines a new marker located at the horizontal center of the graph.
Delete marker Removes the last added marker.
All markers off Removes all markers.
xxx

Markers Context Menu
The Markers context menu appears when you right-click (or touch and hold) on a marker. The Markers
context menu enables you to assign a marker to a different trace, synchronize markers with oscilloscope
cursors and pan the trace to place the marker at the measurement frequency.
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Menu

Icon Menu Description
- Pan to marker Adjusts horizontal position of the waveform to locate the selected

marker at the measurement frequency.
- Assign to trace Assigns the selected marker to Trace 1, Trace 2, Trace 3 or the

Math trace. A trace must be enabled to assign a marker to it.
- Sync scope C1 Synchronizes the position of oscilloscope Cursor 1 with the

location of the selected marker. Turns on cursors if necessary.
- Sync scope C2 Synchronizes the position of oscilloscope Cursor 2 with the

location of the selected marker. Turns on cursors if necessary.
xxx
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Display

Measuring Frequency and Power in the Spectrum Display
To measure the frequency and power at a point on a Spectrum trace:

1. Select Markers > Define Markers.

2. Select the Marker Properties tab.

3. Click Add. This displays a drop-down list underMR (Marker Reference), found inside the Reference
box. The first marker defined is always designated the Marker Reference. Subsequently defined
markers are designated as Delta Markers (you can also select and adjust markers by clicking on an
existing marker on a trace).

4. From the drop-down list, select the trace to which you want to assign the marker.

5. Click the close control panel button to remove the Define Markers control panel.

6. Click on the marker on the trace to activate that marker.

7. Drag the marker in the graph using the touchscreen or a mouse to move the marker to the desired
location on the trace. You can also click on the marker location text box in the Markers toolbar at the
bottom of the screen and adjust it with your mouse wheel. The Peak button in the Markers toolbar and
the arrow buttons to the right of it control marker peak searching on the trace.

8. Read the frequency and power level of the marker position on the display.

9. Read the signal density, frequency and power level of the marker position on the display.
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Marker Actions

Marker Action Controls

Marker Action Controls
Controls for enabling and moving markers and for initiating marker peak searches are found in several
locations. There are buttons for a few of the most common marker activities on the front panel of
the instrument, used along with the knob for adjusting marker positions. The Markers menu contains
selections for peak searches and the Marker toolbar also has buttons for peak searches. All graphs that
support the markers offer a pop-up menu for marker actions.

Peak
Selecting Peak from the Markers menu moves the selected marker to the highest level peak within the
acquisition record.

Next Peak
Selecting Next Peak displays a submenu that enables you to move the selected marker to the next peak.

Setting Description
Next Left Moves the selected marker to the next peak to the left of the current marker position.
Next Right Moves the selected marker to the next peak to the right of the current marker position.
Next Lower (absolute) Moves the selected marker to the lower level peak (in absolute terms) on the trace.
Next Higher (absolute) Moves the selected marker to the higher level peak (in absolute terms) on the trace.
xxx

Marker to Center Frequency
Changes the center frequency to match the frequency of the selected marker.

Sync Scope C1/C2 to Active Marker
Moves the selected oscilloscope cursor (Cursor 1 or Cursor 2) to the location on the oscilloscope waveform
that matches the location of the active maker on the SignalVu active marker. If the oscilloscope cursors are
off, this command turns them on. These commands are also available from the Markers context menu.
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Markers Control Panel

Enabling Markers and Setting Marker Properties

Enabling Markers and Setting Marker Properties
The Define Markers Control Panel is used to enable markers and set their properties. You can set up to five
markers including the marker reference. Markers are shown in most displays.

Markers have two types of on-screen readouts: Absolute and Delta. When Readouts is set to Absolute,
each readout displays only the marker’s position on the trace. In Frequency displays, this means the
marker readout shows the frequency and power of the trace at the marker position. When Readouts is set
to Delta, each delta marker (M1-M4) readout displays both the marker’s position on the trace and the
difference between its position and the position of the Reference Marker (MR).

Defining Markers

1. SelectMarkers > Define Markers to display the Define Markers control panel.

2. Select Add to turn on the next marker. A drop-down list under the marker label allows you to assign
the marker to a trace.

NOTE. The first marker defined will always be MR. The MR marker is the reference for delta marker
readouts.

3. Select the trace to which the marker should be attached from the drop-down list.

4. Click Add to add additional markers.

5. Click the close button to remove the Define Markers control panel.

Defining Peaks
You can specify two amplitude values that define peaks.
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Markers Control Panel

Enabling Markers and Setting Marker Properties

Amplitude
Peak Threshold Peak Threshold specifies the level that the signal must exceed to be considered a peak.
Minimum Excursion Minimum Excursion specifies how much the signal must decrease and then increase

before another peak can be declared.
xxx

1. SelectMarkers > Define Markers to display the Define Markers control panel.

2. Select the Define Peaks tab.

3. To define the level for Peak Threshold, enter a value in the Peak Threshold number entry box.

4. To define the amount the trace must dip, enter a value in the Peak Excursion number entry box.

5. Click the close button to remove the Define Markers control panel.
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Toolbar

Using the Markers Toolbar

Using the Markers Toolbar
Application toolbar: Markers

Menu bar: View > Marker Toolbar

SelectMarker Toolbar to display or hide the Marker Toolbar in the application window. The Marker
Toolbar enables you to operate existing markers or define new markers.

Enabling a marker or adjusting the position of a marker automatically opens the Markers toolbar.

Icon / Readout Description
Opens the Define Markers control panel.

Selected marker readout. This readout shows which marker is selected. The pop-up
menu allows you to choose the selected marker, add markers, and turn all markers off.
Marker position controls. For frequency displays, this readout shows the marker position
in Hertz. For time displays, this readout shows the marker position in seconds. The
position of the selected marker can be changed by selecting the numeric readout and
using the knob to adjust the value.
Changes the analyzer’s Center Frequency to the frequency of the selected marker.
Not selectable for time markers.
Moves the marker to the highest peak on the signal. On displays that scale about zero
on the vertical axis (for example, Magnitude Error, EVM, and Frequency vs. Time), the
highest peak selected by the Peak button is an "absolute value", therefore, negative
peaks are included in the search for the highest peak.
Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value here refers to
the numeric value of the peak amplitude. Thus, when repeatedly moving the marker, it
can move to the right or left depending on the location of the next lower value.
Moves the selected marker to the next higher peak value. The peak value here refers to
the numeric value of the peak amplitude. Thus, when repeatedly moving the marker, it
can move to the right or left depending on the location of the next higher value.
Displays/hides the marker table from the display.

Removes the Marker Toolbar from the display.

xxx
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Using Noise Markers in the Spectrum Display

Using Noise Markers in the Spectrum Display
In the Spectrum display, you can set Markers to Noise Mode to measure noise on the trace. Markers in
Noise Mode operate just as they do in normal mode, but the readouts for the markers are in dBm/Hz
and dBc/Hz.

dBm/Hz is the power in milliwatts referenced to a 1 Hz bandwidth. To make this measurement, the
analyzer assumes that the measured signal is random noise. It then converts the measured power (made at
any RBW) to the power that would be measured had a 1 Hz filter been applied for the measurement.

dBc/Hz represents dBm/Hz referenced to a carrier. Here, it is assumed that the carrier is a CW signal,
and its signal level does not change when the RBW is changed, so the Reference Marker measurement
on the carrier is unchanged from any other marker measurement. However, the delta marker values
are converted to dBm/Hz, and then a difference value, in dBc/Hz, is calculated between each delta
measurement and the reference.

Measuring Noise
To measure noise on a Spectrum trace:

1. SelectMarkers > Define to display the Markers control panel.

2. Click Add. The first marker defined is always designated the Marker Reference. Subsequently defined
markers are designated as Delta Markers (you can also select and adjust markers by clicking on an
existing marker in the display).

3. Click Add again so that there are at least two markers defined.

4. Check that Readouts is set to Delta.

5. If you have more than one trace defined, use the drop-down list for each marker to set it to the trace
on which you want to measure noise.

6. Select the Settings button to display the Spectrum settings control panel.

7. Click the Prefs tab.

8. Click theMarker Noise Mode check box so it is checked.

9. Click the Traces tab.

10. Verify that Detection is set to Average for the trace you are using for this measurement.

11. Click the Ana (Analysis) button.

12. Select the Units tab.

13. Select dBm for the Amplitude units.

14. Click the Close button to remove the control panel.
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in the Spectrum Display

Using Noise Markers in the Spectrum Display

15. Move the markers to the desired locations on the trace.

16. Read the frequency and power level for the selected marker in the upper corners of the display. To
display the delta measurement in dBc/Hz, select the delta marker (M1, M2, M3 or M4) by clicking on
it or by selecting it in the drop-down marker list in the Markers toolbar.
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The Search Tool (Limits Testing)
The instrument allows you to specify pass/fail conditions for the Spectrum and Spurious displays. When
these conditions are met, the instrument can perform actions such as stopping acquisitions or saving data.

Search (Limits Testing) Settings
Menu Bar: Tools > Search...

Selecting Search displays the Search control panel. These settings define search parameters and specify
actions to be performed when the search condition is met.

Setting Description
Enable Search Select to perform a search.
Define (see page 209) Specifies which trace to search and what to search for.
Actions (see page 213) Specifies the action to take when the search condition is met.
xxx

Define Tab (Search)
The Define tab sets the parameters for a search. From this tab, you specify which trace to search and what
kind of violation to search for.
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Setting Description
Search in Specifies which trace to search.
Search for Specifies what to search for. You can specify a search based on a signal level or a mask.
xxx

Search In
The choices for Searching are: Spectrum Trace 1, Spectrum Trace 2, Spectrum Trace 3, Spectrum Math
Trace, Spectrogram Trace, and Spurious.

NOTE. If you select a trace in the display that is not the selected trace, you will not see the results of the
Search until you select the trace in the spectrum display that is the "Search in" trace.

Search For
The Search for setting has selections that vary based on which display’s results you are testing.

Pass/Fail Searches for Spurious
The Spurious measurement can be set up to compare measured spurs against user-adjustable amplitude
limits and provide a pass/fail result. Search can be configured to look for either a Pass result or a Fail result
from Spurious, then perform your specified Search actions when that result occurs.

Greater Than/Less Than Searches for Spectrum
If you select a greater than/less than search, you also specify the level that defines a violation. When you
select either is greater than or is less than, a text entry box appears to the right of the drop-down list. Use
the text entry box to specify the signal level you wish to search for.

Mask-Based Searches
If you specify a mask-based search, then you need to edit the mask to specify the levels that define a
violation. When you select is outside mask or is inside mask, an Edit limits button is displayed. Select
the Edit limits button to display the Mask Editor.
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To edit a search mask:

1. Click Edit limits... to display the Mask Editor.

2. Click New Table to create a table. This clears the existing points and loads the default table.

3. Select the X axis values setting:

a. Select Absolute to specify mask point locations based on signal frequency.

b. Select Relative to specify mask point locations as offsets from the center frequency.

4. To edit values in the table:

a. To edit an existing value, double-click on the cell you want to edit.

b. To add a new point to the table, click on Add Point. Edit the values as required and click Apply
when you are finished with your changes.

To specify a frequency multiplier, you can type K, M, or G. For the power level, you only need to specify a
numeric value. The unit is set to the current Units setting (Setup > Analysis > Units).

1. To delete a point from the table, select the point to be removed, and click Delete.

2. To close the Mask Editor without saving your changes, click Cancel (if you have already clicked
Apply, this only cancels changes since the last time Apply was clicked).

3. If Search mode is already enabled and the instrument is in Run mode, you can run a Search using your
changed points without closing the Mask Editor, by clicking Apply.

4. To save changes and close the Mask Editor, click OK.

5. To save the mask to a file for later recall, click Save As....

6. From the Save As dialog, name the file and save it in the desired location.
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Masks are saved only in CSV (Comma Separated Value) format.

Performing a Mask-Based Search
To perform a Search using a mask:

1. Select Tools > Search.

2. Click the Enable Search check box.

3. Select the trace that you wish to search from the Searching drop-down list.

4. Verify that the trace you selected to search is the selected trace in the display.

5. Select either is outside mask or is inside mask from the Search for drop-down list.

6. Click the Edit limits button.

7. Edit the table as necessary or click Load to use a previously saved mask.

8. If you load a saved a mask, use the Open dialog box to locate and open the mask file.

9. Click OK.

The following figure shows the results of an is outside mask Search. The vertical red bar highlights
results that match the Search definition.
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Actions Tab
The Actions tab is used to specify an action to be taken when the search condition is met.

Setting Description
During Run or Replay Actions specified here will occur in either Run mode or Replay mode.
Beep The analyzer beeps when the search condition is met. There will be no sound if the

instrument hardware does not support audible output.
Stop The analyzer stops when the search condition is met.
During Run Only Actions specified here are taken only during Run mode (while acquiring live data).
AutoSave acquisition data Saves acquisition data to a file when the search condition is met.
AutoSave trace Saves Trace data to a file when the search condition is met.
AutoSave picture Saves a screen capture to a file when the search condition is met.
xxx

AutoSave File Naming
When one of the AutoSave actions is enabled, the name of the saved file is automatically incremented
even if the Automatically generate filenames option (Tools > Options > Save and Export) is not enabled.
When the file is saved, it will be saved to the last location a file was saved. You can check this location
by selecting File > Save As. The Save dialog will show you the current save location. If you want to
save the file in a different location, save a file (any type) in the desired location. This resets the save
destination to the new location.
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Analysis Settings
Menu Bar: Setup > Analysis

Application Toolbar: Ana

The Analysis control panel provides access to settings that are used by all displays. These settings affect
only post processing and they do not control hardware settings.

Setting Description
Analysis Time (see page 214) Specifies the length of time to use in measurements.
Spectrum Time (see page 216) Specifies whether the Spectrum Analysis display uses the same Analysis Time

parameters as all the other displays or if it uses a different Offset and Length.
Frequency (see page 216) Specifies the measurement frequency (center frequency).
Units (see page 219) Specifies the Power units for all displays.
xxx

Analysis Time Tab
The Analysis Time tab contains parameters that define the portion of the acquisition record that is used
for analysis.

214 SignalVu™ Vector Signal Analysis Software Printable Online Help



Analyzing Data > Analysis Settings Analysis Time Tab

Setting Description
Analysis Offset Specifies the location of the first time sample to use in measurements.
Auto When enabled, causes the instrument to set the Analysis Offset value based on the

requirements of the selected display.
Analysis Length Specifies the length of time to use in measurements.
Auto When enabled, causes the instrument to set the Analysis Length value based on the

requirements of the selected display.
Time Zero Reference Specifies the zero point for the analysis time.
Actual This is a displayed value, not a setting. It is the Analysis Length (time) being used by the

analyzer; this value may not match the Analysis Length requested (in manual mode).
xxx

Analysis Offset
Use analysis offset to specify where measurements begin. Range: 0 to [(end of acquisition) - Analysis
Length)]. Resolution: 1 effective sample (or symbol).

Analysis Length
Use the analysis length to specify how long a period of time is analyzed by a measurement. After you
enter a value, this box changes to show the actual value in use, which is constrained by Acquisition Time.
This setting is not available when Auto is checked. Range: minimum value depends on modulation type
to Acquisition Length. Resolution: 1 effective sample (or symbol).

Time Zero Reference
The analysis offset is measured from this point. Choices are: Acquisition Start or Trigger Point.

Parameter Description
Acquisition Start Offset is measured from the point at which acquisition begins.
Trigger Point Offset is measured from the trigger point.
xxx
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Spectrum Time Tab
This tab controls whether the Spectrum display uses the same Analysis Time parameters as all the other
views or uses a different Offset and Length.

Settings Description
Spectrum Time Mode

Independent Causes the spectrum analysis views to use the settings unique to those displays.
Use Analysis Time settings Causes the spectrum analysis views to use the settings on the Analysis Time tab.

Spectrum Time (only available when Independent is selected)
Spectrum Offset Sets the beginning of Spectrum Time with respect to the selected time reference point

(selectable in the Analysis Time tab as either Acquisition Start or Trigger).
Spectrum Length The amount of data, in terms of time, from which spectrum traces are computed.
Auto When enabled, causes the instrument to set the Spectrum Length value based on the

RBW setting.
Actual This is a displayed value, not a setting. It is the Spectrum Length (time) being used

by the analyzer; this value may not match the Spectrum Length requested (in manual
mode). The actual spectrum length is always an integer multiple of the time needed to
support the RBW value.

xxx

Frequency Tab
The Frequency tab specifies two frequency values: the Measurement Frequency and the Spectrum Center
Frequency. The Measurement Frequency is the frequency at which most displays take measurements. The
Spectrum Center Frequency is the center frequency used by the Spectrum, DPX Spectrum, Spectrogram
and Time Overview displays.
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The following screen capture shows a display with both the Measurement Frequency and the Spectrum
Center Frequency locked together.

Normally, the Measurement Frequency and the Spectrum Center Frequency are locked together so
that both have the same setting. But in some situations, for example, where a signal contains a set of
channels, it is useful to unlock the Measurement Frequency from the Spectrum Center Frequency.
When the Spectrum Center Frequency is unlocked from the Measurement Frequency, you can adjust the
Measurement Frequency so that measurements can be taken at different frequencies without resetting the
center frequency. The following screen capture shows the magenta-colored measurement frequency
indicator still located at the center frequency.
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The following screen capture shows the measurement frequency indicator located at 2.0402 GHz while the
Spectrum Center Frequency is still located at 2.0000 GHz.

You can drag the Measurement Frequency indicator on the screen to set the measurement frequency. Note
the base of the Measurement Frequency indicator. The width of the box indicates the widest measurement
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bandwidth in use among the open displays. You can see how the width of this box changes with the
measurement bandwidth by, in this example, adjusting the Measurement BW setting for the Constellation
display (Settings > Freq & BW tab). As you adjust the setting, you will see how the width of the box at the
base of the Measurement Frequency Indicator changes.

Units Tab
The Units tab specifies the global Amplitude units for all the views in the analysis window.
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Replay Overview
The Replay function enables you to reanalyze data with different settings and even different measurements.
You can replay all the acquisitions in memory, a single acquisition, a single frame within an acquisition (if
Fast Frame is enabled), or any contiguous set of data records from acquisition history.

Displaying the Replay Control Panel
To display the Replay control panel:

Select Replay > Select data records from history....

Replay control panel tabs
Tab Description
Select data records Specifies which data records are replayed when the Replay button is selected.
Acquisition Info Displays information about acquisition settings and sets the number of decimal

places used for displaying the time stamp.
Replay Speed Sets the speed at which data records are replayed.
xxx

Select Data Records Tab

Without FastFrame enabled

With FastFrame enabled

The Select data records tab is used to select which data records to replay. A data record is the smallest unit
that can be replayed. Note that what constitutes a data record can vary. If FastFrame is not enabled, a
data record consists of a single acquisition. If FastFrame is enabled, each acquisition can contain multiple
frames, and a data record consists of a single frame.
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Replay Menu
The Replay menu provides controls that let you choose how to replay acquisitions. The replay function
enables you to, in effect, “rerun” an analysis while applying different measurements to the same set of
acquisition data.

Menu item Description
Play all selected records Replays the sequence of records specified by Start and Stop on the Select data records

tab.
Play current record Replays the currently selected acquisition (or frame).
Play from selected Displays a submenu that you use to specify which records are to be replayed.

First record Replays the first record within the selected set.
Previous Replays the previous record within the selected set.
Next Replays the next record within the selected set.
Last record Replays the last record within the selected set.

Pause Suspends replay of the data records as soon as the current record’s replay action is
completed. Press Pause again to begin replay with the next record in the sequence.

Stop Halts the replay of acquisitions. If replay is started after Stop has been selected, replay
starts from the first acquisition.

Select all Selects all acquisitions for replay.
Select records from history Displays the Select data records tab of the Replay control panel. Use the Select data

records tab to specify which acquisitions and frames you would like to replay.
Replay toolbar Displays or hides the Replay toolbar.
xxx

Play All Selected Records
Use this selection to replay all the selected data records. The set of selected records may comprise a single
record, all records in acquisition history, or a subset of the records in history.

Play Current
Selecting Play current replays the current data record. You can identify the current acquisition record by
looking at the Replay toolbar. The first number to the right of the Select... button identifies the current
data record. For example, if the number is 2:10, it means the current record is the tenth frame of the
second acquisition in history.
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Play from Selected...
Select Play from selected to replay records as selected from the submenu. The records replayed can be
from the acquisition memory (history) or from a saved acquisition data file that has already been recalled
as the current acquisition data.

Pause
Select Pause to suspend playback. Selecting Pause again restarts the replay at the point it was paused.

Stop
Select Stop to halt the replay of data. Selecting any Replay action restarts replay of records from the
beginning.

Select All
Select Select all to select all data records for replay.

Select Records from History
Selecting Select records from history displays the Select data records tab of the Replay control panel.
The Select data records tab allows you to specify which records in the acquisition history will be used
when the Replay button is selected.

Replay Toolbar
Displays or hides the Replay toolbar that appears below the main tool bar.

Replay toolbar
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Icon Description
Replays the first record in the selected set.

Replays the previous record in the selected set.

Replays the current record in the selected set.

Replays the next record in the selected set.

Replays the last record in the selected set.

Replays all records in the selected set.

Pauses replay. Pressing pause suspends replay with the current record. Selecting pause
again starts Replay with the next record.
Stops replay. Starting any replay action after pressing stop starts a new Replay action
rather than continuing from the record at which the previous replay action was stopped.
Pressing Select all selects all records in history for replay. Selecting Select all resets the
Start and Stop values on the Select data records tab of the Replay control panel.
Pressing Select displays the Select data records tab of the Replay control panel. The
Select data records tab allows you to select records from acquisition history for replay.
This readout shows information about the data record being replayed. The information
displayed shows the acquisition and frame number and time stamp for the current data
record.
The Info button display the Acquisition Info tab of the Replay control panel. The
Acquisition Info tab displays information about the acquisition data such as acquisition
bandwidth, sampling rate and acquisition length. All data records in the acquisition
history were acquired with identical parameters. When any of these parameters are
changed, all records in history are deleted as soon as the first record acquired under the
new parameter values is received.

xxx
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Amplitude Settings
Menu Bar: Setup > Amplitude

Application Toolbar: Ampl

The Amplitude control panel provides access to power-related settings that are used by all displays within
the SignalVu application.

Setting Description
External Gain/Loss Correction
(see page 224)

Specifies whether a correction is applied to the signal to compensate for the use of
external equipment.

xxx

External Gain/Loss Correction Tab
The External Gain/Loss Correction tab allows you to apply a correction to a signal to compensate for the
use of external equipment, such as an amplifier or attenuator.

External Gain Value
Use the External Gain Value setting to apply a flat gain/loss correction to the signal. Positive values
represent a gain and negative values represent a loss. The range is –50 to +30 dB. Resolution is 0.1 dB.

NOTE. Selecting Preset clears the check box, but it does not change the value.
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Apply Table Corrections To
Table corrections can be applied only to traces in the Spectrum, Spectrogram, Spurious and Amplitude
vs Time displays.

External Loss Tables
Use an External Loss Table to apply a frequency dependent gain/loss correction to the signal. When an
External Loss Table is selected, the analyzer adjusts the signal according to the values in the table. An
external loss table allows you to compensate the signal level for variations in cable loss, antenna frequency
response or preamp frequency response.

You can create external loss tables from the analyzer application and save them as files. External loss tables
are saved as plain text files in CSV (Comma Separated Value) format. The tables have a CSV file extension.

You can change the title for each table. However, note that the title is only a label. It is not tied to the file
name of any table you may have loaded or saved.

NOTE. If you are using an External Loss Table for antenna corrections, be sure to set the Amplitude units
(Setup > Analysis > Units) to dBuA/m or dBuV/m.

Creating an External Loss Table
You can create an external loss table with the analyzer application. No external application is required.

To create an external loss table:

1. Click Edit.. to display the Table Editor.

2. Click New Table to create a table. This clears all entries in the existing table and loads the default table.
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3. To edit values in the table:

a. To edit an existing value, double-click on the cell you want to edit.

b. To add a new point to the table, click on Add Point. Edit the values as required.

c. Click Apply if you want to test your table without closing the editor (the table must be enabled
with the check box in the control panel and measurements must already be running).

To specify a frequency multiplier, you can type K, M, or G.

4. To delete a point from the table, select the point to be removed, and click Delete.

5. Select the Frequency Interpolation method:

Select Linear when the frequency scale of the spectrum or spurious measurements are linear.

Select Log when the frequency scale of the spectrum is logarithmic.

6. When you have entered all the necessary values, click Save As... (to save the table in a file) or
click OK.

7. From the Save As dialog, name the file and save it in the desired location.

External loss tables are saved in CSV (Comma Separated Value) format.

Loading an External Loss Table
To load an external loss table file:

1. Click Edit... to display the Table Editor.

2. Click Load.... to display the Open dialog box.

3. Navigate to the location of the desired file, select it and click Open.

4. Click OK.
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Continuous versus Single Sequence

Continuous versus Single Sequence
Menu Bar: Run > Single Sequence / Continuous

Selecting Single Sequence sets the acquisition mode so that when you press Run, a single acquisition
sequence is performed and the instrument stops once the acquisition sequence is completed. Selecting
Continuous sets the acquisition mode so that an acquisition sequence is started as soon as you select
Continuous and as one acquisition sequence completes, another begins.

Note that an acquisition sequence can require more than one acquisition. For example, in a spectrum view,
the trace function might be set to Average 100 acquisitions Thus, a complete acquisition sequence would
consist of 100 acquisitions that are averaged together to create the trace that is displayed.

Run
Menu Bar: Run > Run

Application Bar: Run

Selecting Run begins a new acquisition/measurement cycle.

Resume
Menu Bar: Run > Resume

Restarts data acquisition, but does not reset accumulated results, such as Average or MaxHold. This
allows you to stop acquisitions temporarily, then continue. If the accumulation is already complete, for
example, 10 acquisitions or 10 averages have already been completed, each subsequent Resume command
will cause one more acquisition to be taken, and its results added to the accumulation. Not available if
instrument settings have been changed.

Abort
Menu Bar: Run > Abort

Selecting Abort immediately halts the current acquisition/measurement cycle. In-process measurements
and acquisitions are not allowed to complete. Visibility and accuracy of results is unspecified after an abort.
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Acquire

Acquire
Menu Bar: Setup > Acquire

Application Toolbar: Acq

Selecting Acquire displays the Acquire control panel. These settings control the hardware acquisition
parameters for the oscilloscope. Normally, sampling parameters are automatically adjusted for selected
measurements. You can use Acquire to change these parameters if necessary.

Setting Description
Vertical (see page 228) Sets the channel used and reference level.
IQ Sampling Parameters (see
page 230)

Set Sampling parameters.

Scope Settings (see page 231) Sets the SignalVu software to control oscilloscope acquisition parameters or use the
current oscilloscope settings.

Scope Data (see page 232) Displays the sample rate and record length reported by the oscilloscope.
xxx

Run
Run mode specifies whether the analyzer will stop acquiring data after it completes a measurement
sequence.

Continuous - In Continuous mode, once the analyzer completes a measurement sequence, it begins
another.

Single - In Single mode, once the analyzer completes a measurement sequence, it stops.

NOTE. A measurement sequence can require more than one acquisition. If the analyzer is configured to
average 100 traces together, the measurement sequence will not be completed until 100 traces have
been acquired and averaged.

Vertical
Use the Vertical tab to specify which oscilloscope channel is used for analysis by the SignalVu software.
The number of signals analyzed by SignalVu depends on the selected signal input type. The Signal
Input can be set to:

228 SignalVu™ Vector Signal Analysis Software Printable Online Help



Controlling the Acquisition of Data > Acquisition
Controls in the Acquire Control Panel

Vertical

RF

I & Q

Diff I & Q (Differential I & Q)

Vertical tab with signal input set to RF

Vertical tab with signal input set to I&Q

Vertical tab with signal input set to Diff I&Q

Setting Description
Signal Input Specifies the input signal type.
Ref Level Specifies the Reference Level, which determines the oscilloscope’s Vertical Scale

setting. If Vertical settings are not enabled in the Scope Settings tab, or while analyzing a
recalled data file, the Reference Level control only adjusts vertical display position.

Calibrate IQ Offset Removes DC offset that may be applied within the oscilloscope to eliminate offset
between I and Q channels.

Source Specifies the input source. Choices available are: CH1, CH2, CH3, CH4, Math1, Math2,
Math3, Math4, Ref1, Ref2, Ref3, and Ref4.

Coupling Display of the coupling setting on the selected channel.
Bandwidth Display of the oscilloscope bandwidth setting.
Termination Display of the termination setting for the selected channel.
xxx

Offset Frequency
If the Signal Input is set to I&Q or Diff I&Q, the Freq: readout serves as the offset frequency readout.
When the Signal Type is set to I&Q or Diff I&Q, the default measurement frequency is 0 Hz. However, for
signals that have near-zero IFs, the measurement frequency can be changed by entering an offset frequency
value in the measurement frequency entry box (Freq: in the application toolbar).
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IQ Sampling Parameters

IQ Sampling Parameters
The IQ Sampling Parameters tab enables you to set the controls for real-time acquisition. Depending on
the setting chosen for Adjust, two additional parameters can be set. Normally, the best results are achieved
by leaving the Adjust control set to All Auto.

Sampling Control
There are three acquisition parameters that interact with each other: acquisition bandwidth, oscilloscope
acquisition sampling rate, and memory usage. The oscilloscope’s sampling rate is displayed in the status
bar at the bottom of the SignalVu window. This sample rate is decimated by the SignalVu software
to meet the requirements of the current measurement settings (such as the selected span, acquisition
bandwidth or resolution bandwidth of a measurement). The resulting decimated sample rate is shown
in the figure above (391 MSamples/sec). This is the sample rate of the IQ data analyzed and acquisition
data file stored by SignalVu.

Adjust User Sets Analyzer Calculates
All Auto N /A N /A All values based on the

selected measurement
Acq BW / Acq Samples Acq BW Acq Samples Acq Length
Acq BW / Acq Length Acq BW Acquisition Length Acq Samples
xxx

Acquisition Memory Usage
The center portion of the tab shows how the acquisition memory is used.

Readout Description
Samples/s, sec/Sample Readout of the acquisition sample rate and sample period.
Capacity The maximum period of time and number of samples that can be acquired with the

current sampling parameters.
Using The total amount of acquisition memory that will be used based on the current settings.
xxx

FastFrame
FastFrame is a feature that allows you to segment the acquisition record into a series of frames, or data
records. A typical use of FastFrame is to record data samples around signal events of interest, while not
wasting memory on irrelevant data between these events. FastFrame acquisitions are only valid for live
waveforms and is not supported for Math or Reference Waveforms.
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Scope Settings

Setting Description
FastFrame Enables FastFrame acquisition mode.
Max Frames Specifies the maximum number of frames to record in a single acquisition process.
xxx

The Actual readout shows the actual number of frames that will be acquired into the acquisition memory.
This number changes based on the Acq BW, Acq Samples, and Acq Length values. This number will
never be greater than the value set by Max Frames.

Scope Settings
The Scope Settings tab is where you specify which oscilloscope settings are controlled by the SignalVu
software.

Setting
Sample Rate When enabled, SignalVu adjusts the sample rate as required based on

measurement settings in the analysis software. Sample rate determines the
maximum available measurement bandwidth.

Auto When Sample Rate is enabled and Auto is enabled, SignalVu adjusts the sample
rate automatically. When Sample Rate is enabled and Auto is disabled, you can
specify the sample rate using the text entry box. You can set the sample rate to
any of the standard oscilloscope sample rate settings. If you choose an arbitrary
value, SignalVu will adjust the value to the closest standard sample rate.

Other acquisition/horizontal settings When enabled, SignalVu adjusts the oscilloscope horizontal and acquisition
settings of the oscilloscope as needed to provide the best results. For example,
SignalVu sets Sampling Mode to Real Time Only and Horizontal Mode to Manual
when it is allowed to control these parameters. Checking these boxes helps
reduce variability in the SignalVu results.

Vertical settings When enabled, SignalVu adjusts the oscilloscope’s vertical settings. Vertical
settings include Coupling, Bandwidth, Scale and Termination. SignalVu sets these
to values appropriate for RF signals. The Scale value sent to the oscilloscope is
calculated from SignalVu’s Reference Level control value.

Reset all scope settings to default
values

Press this button to change all oscilloscope settings to the oscilloscope’s default
values.

xxx

SignalVu™ Vector Signal Analysis Software Printable Online Help 231



Controlling the Acquisition of Data > Acquisition
Controls in the Acquire Control Panel

Scope Data Tab

Scope Data Tab
Displays the sample rate and record length reported by the oscilloscope.

Transfer Again
The Transfer Again button, selectable only when SignalVu is stopped, causes SignalVu to request the last
acquisition made by the oscilloscope be transferred again and analyzed. This enables you to change
measurement settings and then reanalyze the acquisition data with the revised measurement settings in
effect. If FastFrame is enabled, all frames are replayed when the transfer is completed.

The Transfer Again function is most useful when measurements in SignalVu are set up to require less
acquisition bandwidth than what is available from the oscilloscope (based on the sample rate used by the
oscilloscope to acquire the waveform record). In this case, the data is decimated before being supplied
to SignalVu (because SignalVu doesn’t need the excess bandwidth. If you need a wider bandwidth than
SignalVu was originally set up for and the original scope acquisition supports the new value, you can
change the SignalVu settings, then click Transfer again. This time, the waveform data is sent to SignalVu
with its bandwidth (sample rate) adjusted to match the current measurement settings.
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Saving and Recalling Data, Settings, and Pictures
You can save different types of data for later recall and analysis.

Data type Description Save as type
Setup files Saves all of the setup information for

all displays, except those settings that
are not part of Preset.

Setup

Picture of Selected Display
(PNG/JPG/BMP)

Saves a capture of the screen in the
specified format. This option is useful
for including the graphic in reports or
other applications. Marker readouts
and other information are included.

Picture

Results Export files Saves the trace and numeric data for
the selected display. The trace and
numeric data are saved as CSV files.

Results export

Measurement Settings Saves a list of settings relevant to the
selected measurement to a text file.
This option is useful for including the
measurement settings in reports.

Measurement settings export (TXT)

Trace Saves a trace for later recall into the
display from which it was saved.

Selected trace

Data Saves data for reanalysis later or as
data to use with external software
(either CSV (comma-separated value)
or MAT (MATLAB format).

Acquisition data with setup; or
Acquisition data export (CSV or MAT)

xxx

Saving Files
Saving files follows the same procedure regardless of the type of data being saved. To save setups
(including application presets), pictures, results, or acquisition data:

1. Select Save As. . . from the File menu to open the Save As dialog box.

2. Navigate to the folder where you want to save the setups, or use the default location.

To save setups so that they appear in the Application Presets window, save your setup in the
folder C:\SignalVu Files\Application Presets. The saved setup will appear in the Application
Presets window with the name you give the file.

3. Enter a file name.

4. Select the type of file to save from the Save as type drop-down list.

5. Click Save.
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Recalling Files
You can recall three types of files: Setup files, Selected Trace, and Acquisition data with setup. Recalling
data follows the same procedure regardless of the type of data being recalled.

1. Select Recall. . . from the File menu to open the Open dialog box.

2. Navigate to the folder containing the file you want to recall.

3. Select the type of file to recall from the Files of type drop-down list. This selection determines the
files that appear in the Open dialog box.

4. Select the file to recall.

5. Click Open.

Recalling Oscilloscope Waveform Files in SignalVu
You can recall waveform files stored on the oscilloscope using a two-step process.

1. Recall the waveform file using the TekScope application.

2. From the SignalVu application, select Acq to display the Acquire control panel.

3. Specify the Signal Input as appropriate.

4. Set the Source to specify the reference waveform that contains the waveform file you recalled.

5. Click Replay to analyze the recalled waveform.

Setup Files
You can set up the instrument as desired and then save the settings in a setup file. This enables you to
quickly setup the instrument by recalling previously saved setups.

Exporting Results
Save for further analysis of results in other programs, such as MATLAB or Excel.

Pictures of the Selected Display
You can save pictures of the instrument display for documentation purposes. When saving pictures of
the display, you can select from three file types: BMP, JPG, or PNG.

Measurement Settings
You can save a list of settings relevant to the selected display to a file for documentation purposes. The
exported file uses tab characters to separate values. The settings included in the file depend on the selected
display. The contents of the file are the same as a Results export except it does not include the results.
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Saving Acquisition Data with Setup
Save for later analysis with the analyzer. Saving the data with setup ensures the analysis parameters
are the same when the data is recalled.

Saving Acquisition Data Export in CSV Format
Save for examining results in other programs, such as MATLAB or Excel.

Data, Settings, and Picture File Formats
You can save different types of data for later recall and analysis.

Saved File Types

File type File extension Description
Setup files .setup Setup files enable you to save instrument settings for later recall. Using

these files saves setup time and ensures consistent measurements.
Picture .png/.jpg/.bmp Screen capture of SignalVu application window. They are useful for

documenting results in test reports.
Results Export .csv Results files contain the trace points and numeric values that were

produced by the selected measurement. The header of a Results file
includes key acquisition and analysis settings to aid in the interpretation
of the data. The file is saved as a plain text file, but the contents are
formatted as CSV (comma-separated values). Results files can be
opened from applications such as Microsoft Excel and MATLAB.

Measurement
Settings

.txt Measurement settings files contain a list of settings that describe how
the instrument is set up for the selected measurement. The list contains
measurement settings (for example, Span), trace settings (for example,
whether or not a trace is selected) and global settings (for example,
Frequency and Reference Level). The list of settings contained in the
file varies depending on which display is selected.

Selected Trace varies with display Trace files contain the trace results data in binary format. These
files are only readable by the SignalVu application. Several of the
instrument’s measurements allow you to recall a Trace file for visually
comparing a saved trace to a live trace.

Acquisition Data
with Setup

.tiq These files contain the acquisition data record and complete instrument
setup (in binary format). Use these files to save data for later recall and
analysis. When you save an Acquisition Data file, the current Setup
is always saved with the file. At the time of recall, you will be asked
whether you want to restore only the acquisition data or both data and
setup. If the instrument is already set up for a specific measurement,
you will probably want to recall only the acquisition data. Recalling
both data and setup returns the instrument to the same state it was
in at the time you saved the file.
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File type File extension Description
Acquisition Data .csv These files contain IQ sample data before it has been processed by

a measurement. The acquisition data points are saved as IQ pairs.
Use this format to import the acquisition data into Microsoft Excel for
further analysis.

Acquisition Data .mat These files contain IQ sample data before it has been processed by
a measurement. The acquisition data points are saved as IQ pairs.
Use this format to import the acquisition data into MATLAB for further
analysis.

NOTE. Up to 10 Msamples of an acquisition data record can be
exported to MATLAB format files. A free software tool is available to
export files larger than 10 MB to the MATLAB format. Contact your
Tektronix representative to obtain this software.

Range file .csv These files contain a list of settings that describe how the instrument is
set up for the Spurious measurement. The file contains the number of
ranges enabled, the start and stop frequencies for each enabled range,
the limits for each enabled range, the mask type and more.

xxx

Results Export File Format
The Results Export format contains trace points and/or scalar results produced by the measurement. The
file contains general information about the measurement settings at the top of the file and the results data in
the second part of the file. Groups of settings or results are headed with [text], as described below.

At the top of the file is the measurement name and the date and time data was acquired.

The first group of settings is [Global Parameters]. These settings include the Measurement Frequency,
Acquisition Data, Reference Level and others.

The second group of settings is [Parameters]. These settings are specific parameters which vary depending
on the measurement.

The next group is [Trace Parameters], which may not be present, depending on the measurement. Within
this group, there are parameters specific to a trace. There will be a Trace Parameters group for each
trace shown on the display.

The next group is [Results]. These are scalar results for the measurement.

Next is [Traces]. The Traces group consists of one or more [Trace] groups. There is one Trace group for
each trace. Each [Trace] group contains background information about the trace (units, number of points, x
scaling, and others depending on the measurement) at the top of the group, followed by the trace points.

Acquisition Data with Setup File (.tiq) Format
The file consists of two parts - the header that is in XML and the data that is in binary format.

Header. The header consists entirely of the DataFile element. This element is broken down into
sub-elements.
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1. DataSetsCollection

2. Setup

DataSetsCollection. The DataSetsCollection contains a DataDescription element, a DataSet element,
and a ProductSpecific element.

Binary data. Binary data is a sequence of Int32 values, which are IQ pairs (I,Q,I,Q, ...) in binary Little
Endian format.

To convert these values to volts, multiply the individual values by the Scaling value in the DataDescription.

The binary data starts at an offset into the file == the "offset" attribute in the DataFile element. This
offset number will always start at the 19th character into the file (starting with 1), and will always be 9
characters long.

NOTE. You should not casually modify the XML header, because this will change the offset to the start of
the binary data.

Acquisition Data Files (.csv)
The acquisition data files have two sections. At the top of the file is the following information:

SamplingFrequency - The sampling frequency in Hertz.

NumberSamples - The number of IQ samples in the file.

DateTime - When the data was acquired.

Frequency - The center frequency in Hertz.

AcquisitionBandwidth - The acquisition bandwidth Hz.

Following the AcquisitionBandwidth are the data. The data are IQ pairs, in volts.

Groups of settings or results are headed with [some text].

The first thing in the file is the measurement name and the date/time when the acquisition was taken.

The first group [Parameters] are global parameters. Measurement Bandwidth in this group is the
measurement bandwidth used by the General Signal Viewing measurements (Spectrum, Amplitude vs.
Time, etc). It also includes some source settings, like Acq BW, Dither, Preamp, and RF Attenuation.

The second group [Parameters] are measurement-specific parameters.

Another group which can occur is [Trace Parameters]. Within this group, there will be a set of parameters,
one for each trace that is currently shown.

Another group is [Results]. These are scalar results for the measurement.

Another group is [Traces]. It has [Trace] groups under it, one for each trace. Each [Trace] group has
some background information about the trace (units, number of points, x scaling, etc), and the trace
points themselves.
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Acquisition Data Files (.mat)
The acquisition data files saved in MatLab format contain the following MatLab variables:

InputCenter - The center frequency in Hertz.

XDelta - The sample period in seconds.

Y - A complex array containing IQ pairs.

InputZoom - Always 1, and indicates complex data.

Printing Screen Shots
You can print shots (screen captures) two ways: use File > Print or save a picture file and print the file
using a separate graphics program. Printing a screen capture is the same as printing with any windows
program. For details on the available file formats for saving a screen capture, refer to Data, Settings, and
Picture File Formats (see page 235). For details on saving a picture to a file, see Saving and Recalling
Data, Settings, and Pictures (see page 233).

To print a screen from the instrument:

1. Select File > Print.

2. Select File > Print Preview if you wish to review the screen shot before sending it to the printer.

3. Select File > Print to print the file to a printer.
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Online Help
Menu Bar: Help > User Manual

This menu item displays this online help. The online help is a standard Windows help system. The
Online Help menu item is the only method available to display the online help; there are no other links
to the online help within the software.

About the Vector Signal Analysis Software
This window displays information about the SignalVu software and oscilloscope hardware it is running on.

Version
At the top of the window is a line that displays the version of the vector signal analysis application software.

Installed Options
This text box lists the software options installed. This window does not list the options installed on the
oscilloscope, just those that are installed with the vector signal analysis software.

Hardware Information
This text box lists the serial number of the oscilloscope on which the software is running.
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Copy Info
The Copy Info button copies information about the instrument to the Windows clipboard. This information
may be useful if you need to have your instrument serviced. The following text is an example of the
information copied when you click Copy Info:

Tektronix Vector Signal Analysis Software

V1.3.560

Installed Options:

Essentials (Opt SVE)

Pulse Measurements (Opt SVP)

General Purpose Modulation Analysis (Opt SVM)

Hardware Information:

Serial Number: B000001

240 SignalVu™ Vector Signal Analysis Software Printable Online Help



Reference > Menus Menu Overview

Menu Overview
The main menus are:

Menu Description
File (see page 242) Select measurements, open and save files, print documents, and preset.
View (see page 247) Change display size, display the Marker toolbar and Status bar.
Run (see page 249) Start, stop and abort acquisitions, replay measurements, select single or continuous

acquisition mode.
Markers (see page 252) Define markers and search for signal peaks.
Setup (see page 253) Change settings for acquisition, analysis, and measurements.
Tools (see page 254) Perform searches and configure user preferences.
Window (see page 255) Controls the size and layout of displays within the SignalVu application.
Help (see page 256) Access the online help, display information about the instrument hardware and software.
xxx
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File Menu
Command Description
Recall... (see page 243) The Recall dialog enables you to recall saved data, setups and traces.
Save (see page 243) Saves a file without asking for a file parameters (based on most recent settings).
Save As... (see page 243) Displays the Save dialog enabling you to specify the parameters of the save operation.
Acquisition save options (see
page 15)

Displays the Save and Export tab of the Options control panel which allows you to specify
how much data is saved in acquisition files.

Acquisition data info Displays the Acquisition Info tab of the Replay control panel. The info on this tab
describes such acquisition parameters as acquisition bandwidth, sampling rate, RF
attenuation, and acquisition length.

Measurement Data Info (see
page 245)

Displays the characteristics of the most recently analyzed record in the display.

Print... (see page 245) Prints the selected display.
Print Preview (see page 246) Displays a preview of the print output.
Preset (see page 246) Preset resets the instrument to factory defaults. Acquisition data and settings that have

not been saved will be lost.
Application Presets (see
page 246)

Displays a dialog box where you can recall presets tailored to specific application areas.

Exit Closes the SignalVu application. Exit does not shut down the instrument.
xxx
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Recall
Menu Bar: File > Recall

Use the Recall command to load previously saved acquisition data, setups or trace data.

To Recall Data or Setups
1. Select File > Recall. This displays the Open dialog box.

2. Select the file type to be recalled and click Open.

Save / Save As...
Menu Bar: File > Save / Save As...

Use Save / Save As... to store acquisition data, setups, and traces. Save is also used to export traces, results
and pictures of the display for use in other programs.

Difference Between Save and Save As
Use Save As to specify what kind of data you want to save and where the data should be saved. Use Save
to quickly save the same data as you saved the last time you executed a Save, without having to specify the
data type and location.
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For example, suppose you want to save a picture of a spectrum trace each time you adjust a circuit to
document how the adjustments affect the output of the circuit. The first time you want to save a picture of
the display, you will need to select Save As. From the Save As dialog box, you specify the type of data
you want to save (Picture of Selected Display) and specify the location of the saved file. As long as the
Save and Export option (see page 14) is set to automatically name saved files, the next time you want to
save a picture of the display, you can just press Save on the front panel and a picture of the selected display
will be saved without requiring you to type a file name or the location of the file to be saved.

What Data Types Can Be Saved

Data type Description
Acquisition Data Data collected during acquisition that can be recalled for later analysis. Data is saved

in a format readable only by RSA6100A Series instruments or oscilloscopes running
SignalVu software.

Setup Configuration information detailing instrument settings. Data can be saved in a format
readable only by RSA6100A Series instruments or oscilloscopes running SignalVu
software or in a text file.

Selected Trace Saves the selected trace for later analysis by the analyzer. Data is saved in a format
readable only by RSA6100A Series instruments or oscilloscopes running SignalVu
software.

Exported Traces and Numeric
Results

Save traces and results in a file format that can be used by other programs.

Pictures of the Display Save screen images in graphic image file formats that can be used in other programs.
Exported Acquisition Data Save acquisition data records in a file format that can be used by other programs.

Acquisition data can be saved in either comma-separated-variable format or MATLAB
format.

xxx

Data, Settings, and Picture File Formats (see page 235).

Options for Saving Pictures of the Display

Option Setting Description
PNG Saves exported screen captures in Portable Network Graphics format.
JPG Saves exported screen captures in Joint Photographic Experts Group (JPEG)

format.

Image
Format

BMP Saves exported screen captures in Windows bitmap format.
xxx
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Measurement Data Info
The Measurement Data Info command in the File menu displays a listing of acquisition-related information
about the last data analyzed by the selected measurement. The last data can be from the current acquisition
or it could be from a recalled data file.

Scope Data
The Scope Data tab displays the sample rate and record length of the data received from the oscilloscope
or from a recalled oscilloscope waveform file.

Print
Menu Bar: File > Print

Print displays the Windows Print dialog box for printing a screen capture of the display. To save ink when
printing, use the Colors tab to set the color scheme. See Options Settings (see page 14).
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Print Preview
Menu Bar: File > Print Preview

Print Preview shows how a print out will appear when it is printed.

Preset
Menu Bar: File > Preset

Preset resets settings and clears all acquisition data. Settings and acquisition data that have not been
saved will be lost.

After Preset resets the analyzer settings, it displays the Spectrum view.

Preset does not affect time or date settings; the Windows XP operating system settings, or Tools Menu
items.

Application Presets...
SignalVu includes a set of configuration files that are tailored to specific applications. These configuration
files, referred to as Application Presets, open selected displays and load settings that are optimized to
address specific application requirements. You can add to the default application presets by creating
your own application presets. For detailed information about these presets, see Application Presets (see
page 11). See Creating Application Presets (see page 14). You access the application presets through the
Application Presets menu item.
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View Menu
The View menu enables you to control the display of items in the application window.

Command Description
Full Screen (see page 247) Toggles all views between full-screen size and user-selected size.
Marker Toolbar (see page 206) Shows or hides the Marker toolbar. Enables you to define Markers and perform Peak

searches.
Status Bar (see page 248) Shows or hides the Status bar.
xxx

Full Screen
Menu Bar: View > Full Screen

When unchecked, clicking Full Screen resizes the application window to fill the screen. Full Screen mode
maximizes the application window, and turns off the application title bar.

When checked, clicking Full Screen restores the application window to its previous size. The application
title bar is restored.
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Status Bar
The Status Bar displays information on specific instrument settings. It contains only status information; it
does not display any error information. The Status bar has no controls. It can be hidden.

Elements of the Status Bar

Area within Bar Description
Run Status Displays the running state. For example, some run states are Acquiring, Analyzing,

Ready, or Stopped.
Status message area Displays status messages (for example, Data from ADC Overrange). When there no

status messages to report, displays current acquisition parameters (for example, Acq
Length: 22.320 us).

Acquisition parameters Displays parameters of the acquisition, such as acquisition bandwidth and acquisition
length.

Scope Sample Rate Displays the oscilloscope sample rate, for example, 25.00 GS/s.
xxx

Run Status Indicators

Indicator Description
Acquiring The analyzer is capturing the signal.
Analyzing The analyzer has captured the signal and is processing the signal record.
Replaying The analyzer is analyzing recalled waveform or acquisition records.
Stopped If Stopped is displayed, Signal acquisition has been halted. This can occur because the

Run button has been pressed or because a trigger event has occurred, signal acquisition
has occurred and Run mode was set to Single.

xxx

Showing or Hiding the Status Bar
Select View > Status to toggle the display of the Status bar.
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Run Menu
The Run menu provides access to commands that control the signal acquisition.

Command Description
Run (see page 227) If acquisition mode is Stopped, selecting Run begins a new measurement/acquisition

cycle. If acquisition mode is Run, pressing Run halts the current measurement/acquisition
cycle after it completes.

Resume Restarts data acquisition, but does not reset accumulated results, such as Average
or MaxHold. This allows you to stop acquisitions temporarily, then continue. If the
accumulation is already complete, for example, 10 acquisitions or 10 averages have
already been completed, each subsequent Resume command will cause one more
acquisition to be taken, and its results added to the accumulation. Resume is not
available if instrument settings have been changed.

Abort (see page 227) Immediately halts the current measurement/acquisition cycle.
Single Sequence (see
page 249)

Selects the single-sequence acquisition mode. This is only a mode selector; it does
not initiate an acquisition.

Continuous (see page 250) Selects the continuous acquisition mode. Selecting Continuous does initiate acquisitions.
xxx

Single Sequence Acquisition Mode
Menu Bar: Run > Single

Selecting Single sets the Run mode to Single. In Single mode, as soon as one acquisition sequence
completes, acquisition stops.

Note that a single acquisition sequence can require more than one acquisition. For example, in a spectrum
view, the trace function might be set to Average 100 acquisitions. Thus, a complete acquisition sequence
would consist of 100 acquisitions to produce 100 intermediate traces that are averaged together to create
the final trace that is displayed. Once the 100 acquisitions have been completed, acquisition stops.

This is only a mode selector, it does not initiate an acquisition.
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Continuous Acquisition Mode
Menu bar: Run > Continuous

Selecting Continuous places the analyzer in the Continuous acquisition mode. In Continuous mode, the
analyzer acquires and displays acquisitions repeatedly. The Continuous and Single Sequence acquisition
modes are mutually exclusive.

Selecting Continuous restarts acquisitions.
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Replay Menu
Reruns measurements using the current acquisition data or a saved file. Use this to compute new results for
old data after you change settings. If you are working with a recalled oscilloscope waveform file, you
should recall the file again rather than using Replay.
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Markers Menu
The Markers menu provides to settings that define and control the location of markers.

Setting Description
Peak (see page 203) Moves the selected marker to the highest peak on the trace.
Next Peak > Moves the selected marker to next peak depending on the setting chosen.
Marker to Center Frequency Sets center frequency to the frequency of the selected marker.
Define Markers (see page 204) Displays the Define Marker control panel.
Sync Scope C1 to Active
Marker

Moves oscilloscope Cursor 1 to the location on the oscilloscope waveform that matches
the location of the active maker on the SignalVu active marker. If the oscilloscope cursors
are off, this command turns them on.

Sync Scope C2 to Active
Marker

Moves oscilloscope Cursor 2 to the location on the oscilloscope waveform that matches
the location of the active maker on the SignalVu active marker. If the oscilloscope cursors
are off, this command turns them on.

xxx
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Setup Menu
The Setup menu provides access to control panels that specify parameters for numerous vector signal
analyzer functions.

Command Description
Displays (see page 16) Displays the Displays control panel.
Settings (see page 267) Displays the Settings control panel for the selected display.
Acquire (see page 228) Displays the Acquire control panel.
Analysis (see page 214) Displays the Analysis control panel.
Preset (see page 253) Initiates the Preset.
Application Presets (see
page 246)

Displays the Application Presets window.

xxx

Preset
Menu Bar: Setup > Preset

Preset resets settings and clears all acquisition data. Settings and acquisition data that have not been
saved will be lost.

After Preset resets the analyzer settings, it displays the Spectrum view.

Preset does not affect time or date settings, the Windows XP operating system settings, or Tools Menu
items.
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Tools Menu
Provides access to several utilities for controlling instrument functions.

Command Description
Search... (see page 209) Enables you to locate and highlight specified signal levels in Spectrum displays.
Options (see page 14) Displays the Options control panel.
Restore Scope Moves the SignalVu application to the background and displays the TekScope application

in the foreground.
xxx
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Arranging Displays
Use the Window menu to arrange how windows are displayed. Displays can be set to appear full screen
(one display at a time) or with all (selected) displays visible at once. When all displays are visible at
once, you can rearrange the displays by dragging the title bar of a window (deselect Window > Lock
Windows to move displays around).

Command Description
Close View Closes the selected view.
Cascade Positions windows in a cascade view (not available when Lock Windows is selected).
Tile Horizontally Positions widows in a horizontal orientation (top to bottom).
Tile Vertically Positions widows in a vertical orientation (side by side).
Lock Windows Locks the windows into their current position, preventing them from being moved. If the

windows are locked, the Cascade arrangement is not selectable.
(List of windows) A numbered list of open windows.
xxx
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Help Menu
The Help menu provides access to the online help and version information about the vector signal
analyzer software.

Command Description
Online Help Displays the online help.
Printable Online Help Displays a PDF version of the online help.
Quick Start Displays a PDF version of the SignalVu Reference Manual.
Apps Manual Displays a PDF version of the SignalVu Application Note.
About Tektronix Vector Signal
Analysis Software

Displays information about the vector signal analyzer software and installed options.

xxx
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Error and Information Messages
The following list describes some of the common error and information messages that might appear
during instrument operation. Messages that apply specifically to one or more measurements appear in the
displays. Messages that pertain globally, such as those about hardware status, are shown in the Status Bar
at the bottom of the analyzer application window.

Acq BW too small for current setup

The display needs a wider acquisition bandwidth than what the current data record contains. This can be
due to any of the following reasons:

The sampling parameters are being manually controlled.

In the Acquire control panel > Sampling Parameters tab, set the Adjust control to All Auto to allow the
software to pick the sample rate and record length that it needs.

A display other than the one you intended has been selected. The selected display has requested
a smaller acquisition bandwidth to achieve a better accuracy or dynamic range for its particular
measurement.

Select the display that contains the message. Click Run if the instrument is not already acquiring data.

Acquisitions are not running and the measurement now requests a wider bandwidth than the last
acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

The data is from a recalled TIQ file.

There is no way to increase the acquisition bandwidth for saved IQ data. You must adjust the measurement
settings so that less bandwidth is required.

The data is from a recalled oscilloscope waveform file.

In the Acquire control panel, compare the Samples/s readout on the IQ Sampling Parameters tab to the
Sample Rate readout on the Scope Data tab. If the sample rate for the oscilloscope data is more than
twice the value of the IQ sample rate, it means that the recalled waveform data was decimated for a
previous analysis that didn’t need the full bandwidth of the oscilloscope waveform. Recall the oscilloscope
waveform file again to force the software to perform a new conversion based on your new measurement
settings. Each time you change measurement settings in a way that increases the required acquisition
bandwidth, you will need to recall the oscilloscope waveform file.

The current Frequency setting is different than that of the data record, causing the measurement
bandwidth to fall at least partly outside the bandwidth of the data.

If you are using a recalled oscilloscope waveform file, try recalling it again with the new Frequency
setting. This will force a new conversion from oscilloscope samples to IQ samples.

Analysis failure: <description of error>
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The instrument is unable to complete a measurement due to difficulty in characterizing the signal. For
example, due to either the signal or settings, the instrument may not be able to recognize a pulse so it
can compute the pulse measurements.

Try changing settings to improve analysis. For example, when Pulse Trace is displayed, try changing
the settings on the Settings > Params.

Analysis failure: Carrier detection failed

The instrument was unable to locate a carrier signal. Try adjusting the Carrier Threshold or Integration
BW values, if the measurement has these controls.

Analysis Length was limited

This message appears if the "Results Length", the time over which the measurement computed its results,
is less than the Actual Analysis Length reported in the Analysis Time control panel tab and the Time
Overview display. The Results Length is indicated by the magenta line below the Time Overview graph.
This can occur because the acquisition contained more data samples than a measurement can process (for
example, digital demodulation is limited to 80,000 samples) or the measurement had to use some of the
first and last samples for pre-measurement processes.

Analysis length too small for current setup

Increase the Analysis Length or decrease the RBW (Spectrum, ACPR, MCPR).

Avg Tx not available in Volts units

The Average Transmitted Power measurement is not defined for Volts.

The instrument is unable to create a required cache file. To resolve this issue, use a standard disk
management utility to defragment the hard disk. If this error persists, backup your data (including any
setup files you have saved), any applications and associated files you have installed and perform an OS
restore on the hard disk. After restoring the OS, reinstall the RSA6100A Series product software.

Can’t get acquisition data record

No acquisition record currently exists in memory (run an acquisition or recall a file), or an error has
occurred. Repeat the acquisition.

Can’t replay data from swept acq

The measurement could not produce results because it is a real-time only measurement but was asked to
reanalyze (Replay) an acquisition taken in swept mode.

Can’t replay. Live data needed for swept settings

The measurement could not produce results because it was asked to reanalyze (Replay) the acquisition but
it is in Swept acquisition mode. Swept-mode measurements cannot analyze recalled data.

CISPR accuracy limited by acq memory. Adjust RBW or freq range

The CISPR function was applied, but the available data did not represent a long enough time to satisfy
CISPR requirements. Increasing RBW reduces the amount of time needed for analysis. Reducing
frequency range (for example, by reducing Span), decreases sample rate, allowing the available memory
to cover a longer time period.
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An acquisition was completed even though a hardware failure was detected. This message refers to the
acquisition data currently being analyzed, but not necessarily to the current status of the instrument.

If this data is from a saved file, the error cannot be cleared.

Data acquired during RF ADC overrange

An acquisition was completed but the signal was outside the range of the analog-to-digital converter at the
time this data was acquired. This message refers to the acquisition data currently being analyzed, but not
necessarily to the current status of the instrument.

If this data is from a saved file, this error cannot be cleared.

Data acquired during RF digital gain overflow

This data was acquired when the input signal contained peaks greater than 6 dB above the Reference
Level setting.

If the data is from a file, this error cannot be cleared.

Data from unaligned instrument

The acquisition data was captured when the instrument was not aligned. This message refers to the
acquisition data currently being analyzed, but not necessarily to the current status of the instrument.
Measurements made on this data might not be accurate.

Data from uncalibrated instrument

The acquisition data was captured when the instrument was not calibrated. This message refers to the
acquisition data currently being analyzed, but not necessarily to the current status of the instrument.

If this data is from a file, the error cannot be cleared.

Data acquired with 3 GHz preamp

This is a warning that signals above 3 GHz are likely to be severely attenuated because the Preamp was on
when the data was acquired. The (optional) Preamp is not specified for operation above 3 GHz.

Disabled: data is from swept acquisition

The display needs to run in real-time mode. The display associated with this message cannot run now
because it is not the selected display, and the selected display is performing multiple acquisitions (it is
in swept mode).

Change the settings of the selected display so it is performing real-time acquisitions.

Select the associated display to make it the selected display. When it is selected, it will force the
acquisition parameters to change to meet its own needs.

Needs swept acq or larger AcqBW - Acquire data while display is selected

The display is not running because it needs to perform multiple acquisitions (it must be in swept mode) but
it is not the selected display. Only the selected display can perform multiple acquisitions.

Select the display showing this message to give it control of acquisitions parameters.
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Sometimes, only one display can work and the others will be blank and show errors. This happens when
different displays have conflicting demands on the acquisition data record.

Export failure: file not saved

An error occurred while exporting Results. The file was not created.

Export the results again.

Export failure: unable to open results file for export. File not saved.

The Export Results file could not be opened for writing, so the export of results was not completed.

Verify that there is sufficient free space on hard disk.

Insufficient data for CISPR. Acquire while display is selected

This message appears when a measurement is not the selected measurement and CISPR filters are selected.
Set the measurement to be the selected measurement and reacquire the signal.

IQ Processing Error: 8012

This message occurs in GP Digital Modulation displays. The most likely cause for this message is that
there are not enough symbols to analyze. This can happen if

The Analysis Length is set too short. Increase the Analysis Length on the Analysis Time tab.

The Analysis Offset has pushed the Analysis Time so far out that the actual Analysis Length is too
short, even though the user-requested Analysis Length would have been long enough without the
excessive offset. Decrease the Analysis Offset on the Analysis Time tab.

The input signal is bursted, and the burst does not contain enough symbols.

Needs swept acq or larger Acq BW - Acquire data while display is selected

The display has one of two problems: It is not the selected display, which prevents it from controlling
the hardware acquisition parameters, and setting the acquisition mode to Swept; or its settings require a
wider data bandwidth.

Select the display that you are interested in and it will change the acquisition to meet its own needs.

Increase the acquisition bandwidth manually or by changing the selected display’s settings to cause
the wider bandwidth.

No Math trace: unmatched trace lengths

A math trace could not produced because the traces selected to generate the math trace do not have
the same number of points. This can easily happen if both traces are recalled, but were saved under
different “Points” settings. This can also occur if one of the selected traces is a live trace and the other
trace is a recalled trace.

In a Spectrum display, as long as one trace is live, you can change the “Points” setting (Setup >
Settings > Freq & Span tab) to match the recalled trace.

If you are using two recalled traces to generate the Math trace. You must recreate at least one of
the traces.
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No burst detected

The Burst Detection Mode (see page 184) is On, but no burst was detected in the signal.

Check that the Threshold setting is properly set.

Not enough samples for current setup

The measurement was not able to run because the combination of analysis length, offset, and measurement
bandwidth relative to acquisition bandwidth, were such that not enough samples were available for the
measurement to analyze. This can occur when two or more displays are shown and one display requires
a wide acquisition bandwidth and another display requires a much narrower bandwidth. The display
requiring the much narrower bandwidth must decimate and filter the acquisition record which can result in
too few samples left for the measurement.

Increase the Analysis Length to provide more samples.

Close any displays you don’t currently need.

No FFT (not all pulses have results)

If a pulse cannot be measured (because its shape is too indistinct or it does not meet the parameters that
define a pulse (see page 132)), its results will be “- -" for every measurement on that pulse. The instrument
cannot compute an FFT.

No pulses found

The instrument was unable to find any complete pulses in the signal.

Make sure the analysis length (see page 214) includes at least one complete pulse cycle, from before
one rising edge until after the next rising edge.

Pulse Detection Error

The instrument was unable to detect a pulse.

The pulse Measurement Filter (see page 132) needs to be smaller. Try reducing the bandwidth and/or
selecting the Gaussian filter.

Detection threshold is not set to the proper level for the signal. Adjust the Power threshold to detect
pulses (see page 132).

The pulse interval is too long for the current settings. Try decreasing the filter bandwidth (see
page 132), as this may reduce the number of data points to a manageable quantity.

RBW conflict. Increase Span or Analysis Length

The measurement is not running because the actual RBW used by the measurement is too large for the
current acquisition span. Typically, the analysis length is too short as well.

Either increase the span or increase the Analysis Length.

RBW decreased

The current span or acquisition bandwidth is too small to allow a wider RBW filter.

Increase the span or acquisition bandwidth if the decreased RBW is not acceptable.
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RBW increased

The current Spectrum Length (or Analysis Length if Spectrum Length is not Independent) is too small
to allow the requested RBW.

Increase the Spectrum Length (or Analysis Length) if the increased RBW is not acceptable.

RBW limited by AcqBW to: XX Hz

The requested RBW is too close to the acquisition BW. Increase the frequency range of the measurement
(for example, Span).

RBW too small/large for current Acq BW

If the RBW is set manually, it is possible for the acquisition bandwidth to be incompatible with the
RBW setting.

Change the RBW setting.

Adjust the Acq BW setting, either directly (Setup > Acquire > Sampling Params: select on of the
manual modes) or by adjusting the measurement bandwidth of the selected display (Setup > Acquire >
Sampling Params: All Auto).

Recall error: Setup not completely restored

An error occurred while recalling a Setup file. Thus, the current setup may be a combination of settings
from the Setup file and the previous Setup.

Recall the setup again.

Recall failure: problem with file or file contents

An error occurred while recalling a Setup, Trace or Data file. This can occur because of a problem opening
the file (operating system error) or because of a problem with the contents of the file.

Recall the file again.

Restoring acquisition data...

This is a status message displayed while data is being restored from a file.

Save failure: file not saved

An error occurred while saving a Setup or Data file.

Save the file again.

Saving acquisition data...

This is a status message displayed while data is being saved to a file.

Selected VBW does not use full Spectrum Length

This message can occur when the Spectrum Length is greater than required for the VBW filter. If you
look at the Time Overview display, the Magenta line for Results Length indicates the part of the Spectrum
Length that was actually used. The measurement results are correct, but don’t include some of the data in
the selected Spectrum Length. To clear this message, you can set the Spectrum Length to Auto.
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Setup error: <description of error>

When this message appears, it includes text that explains the problem. For example, the ACPR display
might show: “Setup error: channels can’t overlap”. Setup errors are the result of conflicts in instrument
settings. These types of errors occur when a user makes manual changes to settings. In the example
above, the channel settings in the Channel Power and ACPR display have been set so that the channels
overlap in frequency.

Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.

Setup error: Integration BW exceeds Measurement BW

When this message appears, it includes text that explains the problem. Setup errors are the result of
conflicts in instrument settings. These types of errors occur when a user makes manual changes to settings.

Adjust the instrument settings, or change a setting back to Auto, to eliminate the error.

Setup error: Measurement time for Freq & Phase results

The Measurement time for Freq & Phase results (see page 133) specifies how far across the pulse top the
instrument should wait before measuring the Phase Difference and Frequency Difference for each pulse.
If this value is set too large for any of the pulses in the signal, the measurement point ends up on the
falling edge or during the pulse off time.

Decrease the Measurement time for Freq & Phase results setting (Settings > Define tab).

Unexpected software error. Please cycle power and try again. If the problem persists, contact
your Tektronix Service Center.

An unrecoverable error has occurred, and the instrument application software will shut down.

Switch the instrument off and restart it or relaunch the TekScope and SignalVu applications.

VBW not applied - Acq BW too small

Increase VBW or measurement bandwidth. Make sure Sampling Parameters are set to Auto.

VBW not applied - Spectrum Length too short

This message occurs when the requested VBW can’t be produced because the Spectrum Length is too short.

To clear this problem, set the Spectrum Length to Auto or manually increase the Spectrum Length (see
Setup > Analysis > Spectrum Time tab). If Spectrum Length is coupled to Analysis Length, set Analysis
Length to Auto or manually increase it (see Setup > Analysis > Analysis Time tab).

Displaying the Windows Event Viewer
When the analyzer generates an error message, information about the error is logged to the Windows
Event Viewer.

To display the Windows Event Viewer:
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1. Select Start > Control Panels.

2. Select Administrative Tools. (If your instrument displays control panels in Category View, select
Performance and Maintenance and then select Administrative Tools.)

3. Double-click Event Viewer.

4. From the Event Viewer window, select Application. this displays a list of all errors that have been
reported to the operating system from applications.

Errors reported to the Event Viewer from the analyzer application appear under Source as TekRSA.

5. Double-click the last error reported for TekRSA to see details on the most recently reported error.
Please note that many items reported as “errors” are simply informational and do not mean that your
instrument is impaired. Contact the Tektronix Customer Support Center or Service Center if you
are concerned about an error shown in the Event Viewer. Do not send an instrument out for repair
based solely on these event reports.
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How to Find Out If Instrument Software Upgrades Are Available
Software upgrades might be available from Tektronix. They can either be downloaded from the Tektronix
Web site or they can be ordered from your local Tektronix representative. To see if a software upgrade
is available for your instrument, use your browser to go to www.tektronix.com/software. Search by
the instrument model number.

To add additional software options or features, you will need an option key from Tektronix. When you
receive the software from Tektronix, install it on your instrument. When prompted, enter the option key,
and then follow the online instructions to complete the upgrade.
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Settings
Menu Bar: Setup > Settings

The Settings menu item enables access to control panels that allow you to change settings for the selected
display. The control panel that appears when you select Settings depends on the selected display. The
Settings control panel for the Spectrum display is shown in the following figure.

The control panel for the CCDF display is shown in the following figure.

Settings Control Panels
ACPR Settings (see page 86)

Acquire (see page 228)

AM Settings (see page 60)

Amplitude vs Time Settings (see page 41)

Analysis Settings (see page 214)

CCDF Settings (see page 116)

Channel Power and ACPR Settings (see page 86)

Constellation Settings (see page 145)

EVM vs Time Settings (see page 150)

Eye Diagram Settings (see page 153)
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FM Settings (see page 68)

Frequency Deviation vs Time Settings (see page 156)

Frequency vs Time Settings (see page 44)

Magnitude Error Settings (see page 159)

MCPR Settings (see page 86)

Occupied Bandwidth Settings (see page 100)

Phase Error vs Time Settings (see page 162)

Phase vs Time Settings (see page 46)

PM Settings (see page 76)

Pulse Statistics Settings (see page 131)

Pulse Table Settings (see page 126)

Pulse Trace Settings (see page 128)

RF I Q vs Time Settings (see page 48)

Search (Limits Testing) Settings (see page 209)

Signal Quality Settings (see page 168)

Spectrogram Settings (see page 35)

Spectrum Settings (see page 31)

Spurious Settings (see page 106)

Symbol Table Settings (see page 170)

Time Overview Settings (see page 25)

Trellis Diagram Settings (see page 173)
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Accuracy
The closeness of the indicated value to the true value.

ACLR
Adjacent Channel Leakage power Ratio is the ratio of the RRC (Root Raised Cosine) filtered mean power
centered on the assigned channel frequency to the RRC filtered mean power centered on an adjacent
frequency (defined in 3GPP).

ACPR Measurement
Adjacent Channel Power Ratio (ACPR) is the ratio of the mean power centered on the assigned channel
frequency to the mean power centered on an adjacent channel frequency. In the 3GPP specification, it
is called ACLR (Adjacent Channel Level Ratio) and both the main channel and adjacent channels are
required to be filtered with RRC (Root Raised Cosine) filters.

Acquisition
A series of time-contiguous frames. This is also called a Block.

Analysis Length
The length of time in the Analysis Time.

Analysis Time
The portion of the acquisition record over which one or more measurements are calculated.
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ASK
Acronym for Amplitude Shift Keying. The process, or result of a process, in which the amplitude of the
carrier is varied in accordance with the state of a digital input signal.

Block
An integer number of time-contiguous frames. See also: Acquisition.

Calibrator
A signal generator producing a specified output used for calibration purposes.

Carrier
The RF signal upon which modulation resides.

Carrier Frequency
The frequency of the CW component of the carrier signal.

Carrier Signal
The electrical signal, typically a sine wave, upon which modulation is impressed.

Carrier-to-Noise Ratio (C/N)
The ratio of carrier signal power to average noise power in a given bandwidth surrounding the carrier;
usually expressed in decibels.
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CCDF - Complimentary Cumulative Distribution Function
The Complementary Cumulative Distribution Function (CCDF) represents the probability that the peak
power above average power of a measured signal exceeds a threshold.

CCDF is a plot of the percent of time that a signal’s power value exceeds it average value versus the
amount by which it exceeds the average. The CCDF plot has a log of probability on the Y-axis (100% at
the top) and dB above average amplitude on the X-axis (0 at the left).

CDMA
Acronym for Code Division Multiple Access.

Center Frequency
The frequency corresponding to the center of a frequency span of the analyzer display.

Check Mark Indicator
The check mark indicator in the upper-left corner of the display indicates the display for which the
acquisition hardware is optimized. When you have more than one display open, the display with the
check mark indicator has control over the acquisition hardware. To give a display priority over any
others, click its title bar.

CISPR
International special committee on radio interference. (Comité international spécial des perturbations
radioélectriques)

CW
Acronym for Continuous Wave.
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CW Signal
Continuous wave signal - a sine wave.

DANL
Acronym for Displayed Average Noise Level. See Sensitivity (see page 280).

dBfs
A unit to express power level in decibels referenced to full scale. Depending on the context, this is either
the full scale of the display screen or the full scale of the analog-to-digital converter (ADC).

dBm
A unit of expressed power level in decibels referenced to 1 milliwatt.

dBmV
A unit to express voltage levels in decibels referenced to 1 millivolt.

dBuV
A unit to express voltage levels in decibels referenced to 1 microvolt.

Decibel
Ten times the logarithm of the ratio of one electrical power to another.
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Display Reference Level
A designated vertical position representing a specified input level. The level may be expressed in dBm,
volts, or any other units.

Distortion
Degradation of a signal, often a result of nonlinear operations, resulting in unwanted signal components.
Harmonic and intermodulation distortion are common types.

Dynamic Range
The maximum ratio of the levels of two signals simultaneously present at the input which can be measured
to a specified accuracy.

EVM
Acronym for Error Vector Magnitude.

Export
Save data to a file in a format other than application-native.

FastFrame
FastFrame segments the acquisition record into a series of frames and then captures acquisitions as single
frames. You can then view and measure each frame individually.

FFT
Fast Fourier Transform - a mathematical process to calculate the frequency spectrum of a discrete number
of time domain sample points.
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Filter
A circuit that separates electrical signals or signal components based on their frequencies.

FM
Acronym for Frequency Modulation.

Frame
A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce
a spectrum view of a specified span and RBW.

Frequency
A series of time-contiguous samples, long enough in duration and at a sufficient sample rate to produce
a spectrum view of a specified span and RBW.

Frequency Band
The continuous range of frequencies extending between two limiting frequencies, expressed in hertz.

Frequency Domain View
The representation of the power of the spectral components of a signal as a function frequency; the
spectrum of the signal.

Frequency Drift
Gradual shift or change in displayed frequency over the specified time due to internal changes in the
analyzer, where other conditions remain constant. Expressed in hertz per second.
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Frequency Mask Trigger
A flexible real-time trigger based on specific events that occur in the frequency domain.

Frequency Range
The range of frequencies over which the performance of the instrument is specified.

Frequency Span
A continuous range of frequencies extending between two frequency limits.

GPIB
Acronym for General Purpose Interface Bus, the common name for the communications interface system
defined in IEEE Std. 488.

Graticule
The calibrated grid overlaying the display screen of analyzers, oscilloscopes, and other test instruments.

Grayed Out
An on-screen control is “Grayed Out” if it is not adjustable.

I/Q
Acronym for In-phase / Quadrature.
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IF
Acronym for Intermediate Frequency.

Import
Bring data into the application from a file of some format other than application-native.

Impulse Response
The Impulse Response trace display shows normalized power on the vertical axis and time on the
horizontal axis.

Input Impedance
The impedance at the desired input terminal. Usually expressed in terms of VSWR, return loss, or other
related terms for low impedance devices and resistance-capacitance parameters for high impedance
devices.

LISN
Acronym for Line Impedance Stabilization Network.

Local Oscillator (LO)
An oscillator which produces the internal signal that is mixed with an incoming signal to produce the IF
signal.

Marker
A visually identifiable point on a waveform trace, used to extract a readout of domain and range values
represented by that point.
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Max Hold
Digitally stored display mode which, at each frequency address, compares the incoming signal level to
the stored level and retains the greater level. In this mode, the display indicates the peak level at each
frequency after several successive acquisitions.

MCPR (Multiple Carrier Power Ratio)
The ratio of the signal power in the reference channel or group of channel to the power in adjacent channels.

Min Hold
Digitally stored display mode which, at each frequency address, compares the incoming signal level to
the stored level and retains the lower level. In this mode, the display indicates the minimum level at
each frequency after several successive sweeps.

Modulate
To regulate or vary a characteristic of a signal, typically in order to transmit information.

Modulating Signal
The signal which modulates a carrier. The signal which varies or regulates some characteristic of another
signal.

Modulation
The process of varying some characteristic of a signal with a second signal.

Noise
Unwanted random disturbances superimposed on a signal which tend to obscure it.
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Noise Bandwidth (NBW)
The exact bandwidth of a filter that is used to calculate the absolute power in dBm/Hz.

Noise Floor
The noise intrinsic to a system that represents the minimum limit at which input signals can be observed;
ultimately limited by thermal noise (kTB). The analyzer noise floor appears as a “grassy” baseline in the
display, even when no signal is present.

Open (Recall)
Bring data into the application from a file of application-native format.

OQPSK
Acronym for Offset QPSK (Quadrature Phase Shift Keying).

PM
Acronym for Phase Modulation.

Primary Marker
The marker displayed in the Single Marker mode whose frequency and/or position is changed when
tuning with the general purpose knob.

PSK
Acronym for Phase Shift Keying. The process, or result of a process, in which the carrier phase is varied
discretely in accordance with a digital code.
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QAM
Acronym for Quadrature Amplitude Modulation. The process, or result of a process, in which the amplitude
and phase of the carrier are varied concurrently by synthesizing two orthogonal ASK waves (see ASK).

Real-Time Analysis
Measurement technique based on triggering on an RF signal, seamlessly capturing it into memory, and
analyzing it in the frequency, time, and modulation domains.

Real-Time Bandwidth
The frequency span over which real-time seamless capture can be performed, which is a function of the
digitizer and the IF bandwidth of a Real-Time Spectrum Analyzer.

Real-Time Seamless Capture
The ability to acquire and store an uninterrupted series of time domain samples that represent the behavior
of an RF signal over a long period of time.

Reference Level
The signal level represented by the uppermost graticule line of the analyzer display.

Residual FM (Incidental FM)
Short term displayed frequency instability or jitter due to instability in the analyzer local oscillators. Given
in terms of peak-to-peak frequency deviation and expressed in hertz or percent of the displayed frequency.

Residual Response
A spurious response in the absence of an input signal. (Noise and zero pip are excluded.)
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RBW
The RBW determines how well the analyzer can resolve or separate two or more closely spaced signal
components.

Ripple
The Ripple measurement is calculated as follows:

Ripple = | Positive Maximum Difference | + | Negative Maximum Difference |

where the maximum differences are calculated as shown in the following illustration.

Secondary Marker
The “second” marker displayed only in the Delta Marker mode.

Sensitivity
Measure of a analyzer’s ability to display minimum level signals, usually expressed as displayed average
noise level (DANL (see page 272)).

Shape Factor (Skirt Selectivity)
The ratio of the frequency separation of the two (60 dB/3 dB) down points on the response curve to the
static resolution bandwidth.
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Signal
As used in this online help, the signal refers to the input signal before it is processed. The signal is an input.

Span
Span is the range of frequencies displayed in a spectrum window. Span, start frequency and stop frequency
are related by the following equation: Span = (stop frequency) - (start frequency). The settings for center,
start and stop frequencies are related to the setting for span; when one parameter is changed, the other are
changed automatically.

Span Per Division (Span/Div)
Frequency difference represented by each major horizontal division of the graticule.

Spectrogram
Frequency vs. time vs. amplitude display where the frequency is represented on the x-axis and time on the
y-axis. The power level is indicated by variations in color.

Spectrum
The frequency domain representation of a signal showing the power distribution of its spectral component
versus frequency.

Spectrum Analysis
The technique or process of determining the frequency content of an RF signal.

Spectrum Analyzer
A device for determining the frequency components of a signal.
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Spectrum Time
Analysis Time for spectrum analysis views. Spectrum time can be the same as Analysis Time, but it
can be different.

Spur
A spur is a signal peak that exceeds a user-definable threshold (See Spurious > Settings > Ranges) and
excursion setting. A spur that also exceeds a limit (either Absolute or Relative) specified on the Settings
> Limits tab is considered a violation.

Spurious Response
A response to a analyzer wherein the displayed frequency is not related to the input frequency.

Time Measurement
This is the time in seconds relative to the time reference point in the first acquisition record in the data set.

Time Reference
The point in time during the acquisition record used as the zero point for counting time. The time reference
can be set to either the start of the acquisition record or the trigger point.

Trace
As used in this online help, trace refers to the displayed signal. The displayed signal can be a processed
version of the input signal (for example, it may be averaged.) The trace is a result or output.
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Glossary Vector Signal Analyzer

Vector Signal Analyzer
Like a spectrum analyzer, a device for determining the frequency components of a signal. However, unlike
a standard spectrum analyzer, the vector signal analyzer is optimized for analyzing digitally modulated
RF signals.

Vertical Scale Factor, Vertical Display Factor
The number of dB, volts, etc., represented by one vertical division of a spectrum analyzer display screen.

Violation
A violation is a spur that exceeds either an Absolute or Relative limit (depending on the selected mask)
specified on the Settings > Limits tab. A spur is a signal peak that exceeds a user-definable threshold (See
Spurious > Settings > Ranges) and excursion setting.
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Glossary Violation
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Symbols and Numbers
-6dB RBW (MIL) Filter shape

Spectrum display BW tab, 54

A
Abort acquisition, 227
About the RTSA, 239
accuracy, 269
ACLR, 269
ACLR measurement, 85
ACPR measurement, 269
Acquire control panel, 228
acquisition, 269
acquisition data

saving, 233
Acquisition data files, 15
Acquisition Info tab, 220
acquisition memory usage, 230
Actions tab

Search, 213
Adjacent Channel Power

measurement, 86
Advanced Params Tab

GP Digital Modulation
displays, 181

AM display, 59
Amplitude control panel, 224
Amplitude vs. Time display, 40
Amplitude vs. Time display

Settings, 41
Analysis control panel, 214
analysis length, 269
analysis time, 269
Analysis Time tab

GP Digital Modulation
displays, 184

Analysis Time tab (Analysis
control panel), 214

application presets, 11
saving, 233

Apply ampl corrections, 134
arranging windows, 255
ASK, 270

automatically generate
filenames, 14

Automatically increment
filename/number, 15

Average Channel Power
measurement, 85

Average ON Power, 20
Average Transmitted Power, 20

B
Blackman-Harris 4B Filter Shape

Spectrum display BW tab, 54
Blizzard color scheme, 15
block, 270
Blue background (cells), 102
Burst detect threshold, 76
BW Tab

Amplitude vs. Time
display, 42

Spectrum display, 54

C
C4FM modulation type

measurements, 20
C4FM signal quality

measurements, 167
Calibrate IQ Offset, 229
calibrator, 270
carrier, 270
carrier frequency, 270
Carrier frequency detection, 69
Carrier Frequency Error, 20
carrier signal, 270
carrier-to-noise ratio (C/N), 270
CCDF - Complimentary

Cumulative Distribution
Function, 271

CCDF display, 115
CDMA, 271
center frequency, 271
Channel

Acquire control panel, 5
Vertical tab, 228

Channel Power and ACPR
(Adjacent Channel Power
Ratio) display, 83

Channel Power and ACPR
Settings control panel, 86

Channel Power measurement, 85
Channels tab

Channel Power & ACPR
display, 86

Channels tab (MCPR), 95
check mark indicator, 8
CISPR, 271
CISPR Filter shape

Spectrum display BW tab, 54
Classic color scheme, 15
Colors tab, 15
Constellation display, 144
Constellation display

settings, 145
Continuous Acquisition

Mode, 250
Correct for Noise Floor

Channel Power & ACPR
display, MCPR
display, 94

correction tables, 224
creating application presets, 11
CW, 271
CW signal, 272

D
DANL, 272
Data file formats, 235
Data properties

File menu, 245
dBfs, 272
dBm, 272
dBmV, 272
dBuV, 272
decibel, 272
default settings, restore, 11
Define Markers, 204
Define Peaks tab, 204
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Define tab, 209
Pulsed RF displays, 133

Delta Markers, 204
Demod I&Q vs Time display

settings, 148
description

RSA6100A Series, 2
detect, 120

AM display, 62
FM display, 70
General Signal Viewing

displays, 51
PM display, 78
Time Overview, 26

detection, 36
AM display, 62
FM display, 70
General Signal Viewing

displays, 51
PM display, 78
Time Overview, 26

detector, 120
AM display, 62
FM display, 70
General Signal Viewing

displays, 51
PM display, 78
Time Overview, 26

Deviation, 20
display reference level, 273
Displays

arranging, 16
interactions between, 16
selecting, 16

distortion, 273
documentation, 4
Droop, 21
Droop dB, 21
Duty Factor (%) measurement, 20
Duty Factor (Ratio)

measurement, 20
dynamic range, 273

E
Elements of the display, 8
error message

Windows Event Viewer, 263
Error messages, 257

Event Viewer, 263
EVM, 273
EVM vs. Time display, 149
EVM vs. Time Settings, 150
export, 273
External Gain value, 224
External Gain/Loss Correction

tab, 224
External Loss Tables, 224
Eye Diagram display settings, 153

F
Fall Time, 20
FastFrame, 230
FFT, 273
File formats, 235
File Menu, 242
filter, 274
Filter Parameter

GP Digital Modulation
displays, 175

Filter Shape
Spectrum display BW tab, 54

Find tab
GP Digital Modulation

displays, 184
finding bursts in data

GP Digital Modulation
displays, 184

FlatTop (CW ampl) Filter Shape
Spectrum display BW tab, 54

FM, 274
FM display, 66
FMT (Frequency Mask

Trigger), 275
frame, 274
Freq & BW Tab

GP Digital Modulation
displays, 180

Freq & Span tab
General Signal Viewing

displays, 50
Freq Deviation, 21
Freq Diff, Phase Diff setting, 135
Freq Error, 20
Freq Estimation tab

Pulsed RF displays, 139

Freq, Span & RBW tab
Channel Power & ACPR

display, MCPR
display, 93

RF Measurements
displays, 119

Freq-domain Linearity
setting, 134

frequency, 274
frequency band, 274
Frequency Deviation vs. Time

settings, 156
frequency domain view, 274
frequency drift, 274
Frequency Error, 18

GP Digital Modulation
displays, 180

Frequency Mask Trigger
(FMT), 275

Frequency Offset
GP Digital Modulation

displays, 180
frequency range, 275
frequency span, 275
Frequency tab, 216
Frequency vs. Time display, 43
Frequency vs. Time Settings, 44
Full Screen, 247

G
Gain Imbalance, 165
GPIB, 275
GPIB tab, 14
graticule, 275
Graticule On/Off

RF Measurements
displays, 123

grayed out, 275

H
Hanning Filter Shape

Spectrum display BW tab, 54
Help Menu, 256
Hide sensitive readouts, 14
Hide Sensitive readouts, 14
Histogram readout

Pulsed RF displays, 141
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I
I/Q, 275
IF, 276
import, 276
Impulse Response Amplitude, 21
Impulse Response setting, 134
Impulse Response Time, 21
Information messages, 257
input

selecting, 5
input impedance, 276
Installed options, 3
Internal attenuator (Internal

Settings tab), 224
IQ Origin Offset, 165
IQ Sampling Parameters Tab, 230
IQ vs. time view, 47
is greater than (search), 210
is inside mask, 209
is inside mask (search), 210
is less than (search), 210
is outside mask, 209
is outside mask (search), 210

K
Kaiser (RBW) Filter Shape

Spectrum display BW tab, 54
Keep-out time, 134

L
Length, 20
Levels tab

Pulsed RF displays, 138
Limit lines, 209
Limits tab

Spurious display, 112
LISN, 276
local oscillator (LO), 276
Lock Center Frequency of

Spectrum displays, 216
Log (Horizontal)

Spectrum display, 32

M
Mag Error, 166

Magnitude Error vs. Time
display, 157

Magnitude Error vs. Time
settings, 159

manuals, 4
marker, 276
Marker Noise mode, 207
Marker Properties tab, 204
Marker to Center Frequency, 203
Markers, 206

Marker Toolbar, 206
Using Markers, 199
Using Markers in Noise

Mode, 207
Markers menu, 252
Mask Editor, 209
MATLAB format, 235
Max Freq Error, 21
max hold, 277
Max number of pulses

Pulse Table display, 132
Max Phase Error, 21
Max trace points, 43
MCPR (multiple carrier power

ratio, 277
MCPR display, 89
MCPR settings, 92
Measurement Filter

GP Digital Modulation
displays, 175

Measurement Frequency, 216
Measurement Params tab

Channel Power & ACPR
display, MCPR
display, 94

Measurement point, 135
Measurement settings export, 233
Measurements, 17
Measurements tab, 126
Menus, 241
MER (RMS), 18
min hold, 277
modulate, 277
modulating signal, 277
modulation, 277
modulation measurements, 18

Modulation Params tab
GP Digital Modulation

displays, 175
modulation types supported, 176
moving windows, 255
Multiple Carrier Power Ratio, 92

N
nFSK modulation type

measurements, 20
nFSK signal quality

measurements, 166
noise, 277
noise bandwidth (NBW), 278
noise floor, 278
Noise markers, 207

O
OBW Level Left/Right, 98
OBW Ref Power, 98
Occupied Bandwidth, 100
Occupied Bandwidth

settings, 100
Occupied BW display, 98
Offset EVM, 19
offset frequency

IQ signal types, 229
online help, 239
Open (Recall), 278
Optimization

Channel Power & ACPR
display, MCPR
display, 94

Options
installed, 3

Options control panel, 14
OQPSK, 278
OQPSK and SOQPSK modulation

type measurements, 19
Other acquisition/horizontal

settings
Scope Settings tab, 231

Overshoot, 21
Overshoot dB, 21
Overshoot settings, 136
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P
Parameters tab

AM display, 61
CCDF display, 117
FM display, 69
Occupied BW display, 101
PM display, 76
Spurious display, 107

Params tab
Pulsed RF displays, 132

Pass/Fail searches for
Spurious, 210

Pause
Replay menu, 221

Peak Excursion, 204
Peak FSK err, 20
Peak Mag Err, 20
Peak Power, 20
Peak Threshold, 204
Phase Deviation, 21
Phase Error, 18
Phase Error vs. Time display, 160
Phase Error vs. Time settings, 162
Phase vs. Time display, 45
Phase vs. Time settings, 46
pictures

saving, 233
Play all selected records

Replay menu, 221
Play current record

Replay menu, 221
Play from selected

Replay menu, 221
PM, 278
power measurements, 82
Prefs tab

AM display, 65
FM display, 73
General Signal Viewing

Displays, 57
GP Digital Modulation

displays, 188
PM display, 81
Pulsed RF displays, 141
RF Measurements

displays, 123
Preset (File menu), 246
Preset (Settings menu), 253

presets
application, 11

primary marker, 278
Print, 245
Print Preview, 246
Product Description, 2
PSK, 278
pulse measurements, 20
Pulse Statistics display, 129
Pulse Statistics display

settings, 131
Pulse Table display, 125
Pulse Table settings, 126
Pulse Trace display, 127
Pulse Trace display settings, 128
Pulse Width, 20
Pulse-Pulse Freq Difference, 21
Pulse-Pulse Phase Difference, 21

Q
QAM, 279
Quadrature Error, 165

R
Range file, 235
Ranges Tab

Spurious display, 110
RBW, 280
real-time analysis, 279
real-time bandwidth, 279
real-time seamless capture, 279
Red background (cells), 102
Ref Level

Vertical tab, 228
Ref level (Internal Settings

tab), 224
Reference Filter

GP Digital Modulation
displays, 175

Reference Level, 279
Reference tab

Spurious display, 107
Repeat, 227
Repetition Interval, 20
Repetition Rate, 20
Replay control panel, 220
Replay menu, 221

Replay Speed tab, 220
Replay toolbar, 222

Replay menu, 221
Reset all scope settings to default

values
Scope Settings tab, 231

residual FM (incidental FM), 279
residual response, 279
results

saving, 233
Resume, 227
RF & IF Optimization

Spectrum display BW tab, 54
RF Channel Power

measurement, 85
RF I & Q vs. Time display, 47
RF I & Q vs. Time settings, 48
Rho ρ, 18
Rho &#x3c1;, 165
Ripple, 21
Ripple dB, 21
Ripple measurement

calculation, 280
Ripple settings, 136
Rise Time, 20
RMS

Detection, 36
RMS Error Magnitude, 20
RMS FSK Err, 20
RMS Mag Err, 20
RMS Phase Error, 21
Run, 227
Run menu, 249

S
Sample Rate

Scope Settings tab, 231
Save and Export tab, 14
saved file types, 233
saving

acquisition data, 233
application presets, 11
pictures, 233
results, 233
setups, 233

Saving and Recalling Data, 233
Scale tab

AM display, 64
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FM display, 72
General Signal Viewing

displays, 56
GP Digital Modulation

displays, 187
Phase Noise display, 80
Pulsed RF displays, 140
RF Measurements

displays, 122
Spectrogram display, 39
Spectrum display, 32

Scope Data tab, 232
Scope Settings tab, 231
Search, 209
Search control panel, 213
Search For, 210
Search In, 210
search using a mask, 210
secondary marker, 280
Security tab, 14
Select all

Replay menu, 221
Select data records tab, 220
Select records from history

Replay menu, 221
selecting the input, 5
sensitivity, 280
settings

Constellation display, 145
Demod I&Q vs Time

display, 148
EVM vs. Time display, 150
Eye Diagram display, 153
Frequency Deviation vs.

Time, 156
Frequency vs. Time, 44
Magnitude Error vs.

Time, 159
MCPR, 92
Occupied Bandwidth, 100
Options, 14
Phase Error vs. Time, 162
Phase vs. Time, 46
Pulse Statistics display, 131
Pulse Table display, 126
Pulse Trace display, 128
restoring defaults, 11
RF I & Q vs. Time, 48

Signal Quality, 168
Spectrogram display, 35
Spectrum display, 31
Spurious display, 106
Symbol Table display, 170
Time Overview display, 25
Trellis Diagram display, 173

Settings, 267
AM display, 60
CCDF display, 116
FM display, 68

Setup Menu, 253
setups

saving, 233
shape factor (skirt

selectivity), 280
Show graticule

General Signal Viewing
Displays, 57

Pulsed RF displays, 141
Show Marker Readout in Graph

General Signal Viewing
Displays, 57

Pulsed RF displays, 141
RF Measurements

displays, 123
Show recalled trace, 50

AM display, 62
FM display, 70
PM display, 77
Time Overview display, 25

signal, 281
Signal Input, 228
Signal Quality display, 163
Signal quality measurements, 165
Signal Quality settings, 168
Single, 249
span, 281
span per division, 281
Span/RBW Ratio

Spectrum display BW tab, 54
spectrogram, 281
Spectrogram display, 33
Spectrogram display settings, 35
Spectrogram trace

Time Overview display, 25
spectrum, 281
spectrum analysis, 281

spectrum analyzer, 281
Spectrum Center Frequency, 216
Spectrum display, 29
Spectrum display settings, 31
spectrum time, 282
Spectrum Time tab, 216
spur, 282
Spurious, 102
Spurious display settings, 106
spurious response, 282
Standard Settings button, 175
Status Bar, 248
Stop

Replay menu, 221
symbol maps, 189
Symbol Rate, 20
Symbol Rate Error, 20
Symbol Table display, 169
Symbol Table display

settings, 170
Sync Scope C1/C2 to Active

Marker, 203

T
Thunderstorm color scheme, 15
Time, 21
Time measurement, 282
Time Overview, 23
Time Overview display

settings, 25
time reference, 282
TIQ acquisition data files, 15
TIQ acquisition data files

parameters, 14
Tools Menu, 254
Touch-screen Actions, 5
trace, 282
Trace tab

AM display, 62
FM display, 70
GP Digital Modulation

displays, 186
PM display, 77
Time Overview display, 25

Traces tab
General Signal Viewing

displays, 50
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RF Measurements
display, 120

Spectrogram display, 35
Traces tab – Math Trace

General Signal Viewing
displays, 54

Transfer Again
Scope Data tab, 232

Transform Window
Spectrum display BW tab, 54

Trellis Diagram display
settings, 173

U
Uniform (None) Filter Shape

Spectrum display BW tab, 54
Units tab, 219

User Filters
file format, 195
loading, 195

User Symbol Map, 182

V
VBW, 29

Channel Power & ACPR
display, MCPR
display, 93

RF Measurements
displays, 119

Spectrum display BW tab, 54
vector signal analyzer, 283
vertical scale factor, vertical

display factor, 283

Vertical settings
Scope Settings tab, 231

Vertical tab
Acquire control panel, 228

View Menu, 247
violation, 283

W
Window menu, 255
Windows Event Viewer, 263

X
x dB BW Ref Power, 98
x dB Level, 101
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